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Glossary
A

Administrator
A user with permissions to manage Check Point security products and the network
environment.

API
In computer programming, an application programming interface (API) is a set of
subroutine definitions, protocols, and tools for building application software. In general
terms, it is a set of clearly defined methods of communication between various software
components.

Appliance
A physical computer manufactured and distributed by Check Point.

B

Bond
A virtual interface that contains (enslaves) two or more physical interfaces for
redundancy and load sharing. The physical interfaces share one IP address and one
MAC address. See "Link Aggregation".

Bonding
See "Link Aggregation".

Bridge Mode
A Security Gateway or Virtual System that works as a Layer 2 bridge device for easy
deployment in an existing topology.
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C

CA
Certificate Authority. Issues certificates to gateways, users, or computers, to identify
itself to connecting entities with Distinguished Name, public key, and sometimes IP
address. After certificate validation, entities can send encrypted data using the public
keys in the certificates.

Certificate
An electronic document that uses a digital signature to bind a cryptographic public key
to a specific identity. The identity can be an individual, organization, or software entity.
The certificate is used to authenticate one identity to another.

Cluster
Two or more Security Gateways that work together in a redundant configuration - High
Availability, or Load Sharing.

Cluster Member
A Security Gateway that is part of a cluster.

CoreXL
A performance-enhancing technology for Security Gateways on multi-core processing
platforms. Multiple Check Point Firewall instances are running in parallel on multiple
CPU cores.

CoreXL Firewall Instance
Also CoreXL FW Instance. On a Security Gateway with CoreXL enabled, the Firewall
kernel is copied multiple times. Each replicated copy, or firewall instance, runs on one
processing CPU core. These firewall instances handle traffic at the same time, and
each firewall instance is a complete and independent firewall inspection kernel.
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CoreXL SND
Secure Network Distributer. Part of CoreXL that is responsible for: Processing incoming
traffic from the network interfaces; Securely accelerating authorized packets (if
SecureXL is enabled); Distributing non-accelerated packets between Firewall kernel
instances (SND maintains global dispatching table, which maps connections that were
assigned to CoreXL Firewall instances). Traffic distribution between CoreXL Firewall
instances is statically based on Source IP addresses, Destination IP addresses, and the
IP 'Protocol' type. The CoreXL SND does not really "touch" packets. The decision to
stick to a particular FWK daemon is done at the first packet of connection on a very high
level, before anything else. Depending on the SecureXL settings, and in most of the
cases, the SecureXL can be offloading decryption calculations. However, in some other
cases, such as with Route-Based VPN, it is done by FWK daemon.

CPUSE
Check Point Upgrade Service Engine for Gaia Operating System. With CPUSE, you
can automatically update Check Point products for the Gaia OS, and the Gaia OS itself.
For details, see sk92449.

D

DAIP Gateway
A Dynamically Assigned IP (DAIP) Security Gateway is a Security Gateway where the
IP address of the external interface is assigned dynamically by the ISP.

Data Type
A classification of data. The Firewall classifies incoming and outgoing traffic according
to Data Types, and enforces the Policy accordingly.

Database
The Check Point database includes all objects, including network objects, users,
services, servers, and protection profiles.

Distributed Deployment
The Check Point Security Gateway and Security Management Server products are
deployed on different computers.

Domain
A network or a collection of networks related to an entity, such as a company, business
unit or geographical location.
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Domain Log Server
A Log Server for a specified Domain. It stores and processes logs from Security
Gateways that are managed by the corresponding Domain Management Server.
Acronym: DLS.

Domain Management Server
A virtual Security Management Server that manages Security Gateways for one
Domain, as part of a Multi-Domain Security Management environment. Acronym: DMS.

E

Expert Mode
The name of the full command line shell that gives full system root permissions in the
Check Point Gaia operating system.

External Network
Computers and networks that are outside of the protected network.

External Users
Users defined on external servers. External users are not defined in the Security
Management Server database or on an LDAP server. External user profiles tell the
system how to identify and authenticate externally defined users.

F

Firewall
The software and hardware that protects a computer network by analyzing the incoming
and outgoing network traffic (packets).

G

Gaia
Check Point security operating system that combines the strengths of both
SecurePlatform and IPSO operating systems.
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Gaia Clish
The name of the default command line shell in Check Point Gaia operating system. This
is a restrictive shell (role-based administration controls the number of commands
available in the shell).

Gaia Portal
Web interface for Check Point Gaia operating system.

H

Hotfix
A piece of software installed on top of the current software in order to fix some wrong or
undesired behavior.

I

ICA
Internal Certificate Authority. A component on Check Point Management Server that
issues certificates for authentication.

Internal Network
Computers and resources protected by the Firewall and accessed by authenticated
users.

IPv4
Internet Protocol Version 4 (see RFC 791). A 32-bit number - 4 sets of numbers, each
set can be from 0 - 255. For example, 192.168.2.1.

IPv6
Internet Protocol Version 6 (see RFC 2460 and RFC 3513). 128-bit number - 8 sets of
hexadecimal numbers, each set can be from 0 - ffff. For example,
FEDC:BA98:7654:3210:FEDC:BA98:7654:3210.

J

Jumbo Hotfix Accumulator
Collection of hotfixes combined into a single package. Acronyms: JHA, JHF.
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L

Link Aggregation
Various methods of combining (aggregating) multiple network connections in parallel to
increase throughput beyond what a single connection could sustain, and to provide
redundancy in case one of the links should fail.

Log
A record of an action that is done by a Software Blade.

Log Server
A dedicated Check Point computer that runs Check Point software to store and process
logs in Security Management Server or Multi-Domain Security Management
environment.

M

Management High Availability
Deployment and configuration mode of two Check Point Management Servers, in which
they automatically synchronize the management databases with each other. In this
mode, one Management Server is Active, and the other is Standby. Acronyms:
Management HA, MGMT HA.

Management Interface
Interface on Gaia computer, through which users connect to Portal or CLI. Interface on a
Gaia Security Gateway or Cluster member, through which Management Server
connects to the Security Gateway or Cluster member.

Management Server
A Check Point Security Management Server or a Multi-Domain Server.

Multi-Domain Log Server
A computer that runs Check Point software to store and process logs in Multi-Domain
Security Management environment. The Multi-Domain Log Server consists of Domain
Log Servers that store and process logs from Security Gateways that are managed by
the corresponding Domain Management Servers. Acronym: MDLS.
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Multi-Domain Security Management
A centralized management solution for large-scale, distributed environments with many
different Domain networks.

Multi-Domain Server
A computer that runs Check Point software to host virtual Security Management Servers
called Domain Management Servers. Acronym: MDS.

N

Network Object
Logical representation of every part of corporate topology (physical machine, software
component, IP Address range, service, and so on).

O

Open Server
A physical computer manufactured and distributed by a company, other than Check
Point.

P

Primary Multi-Domain Server
The Multi-Domain Server in Management High Availability that you install as Primary.

R

Rule
A set of traffic parameters and other conditions in a Rule Base that cause specified
actions to be taken for a communication session.

Rule Base
Also Rulebase. All rules configured in a given Security Policy.
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S

Secondary Multi-Domain Server
The Multi-Domain Server in Management High Availability that you install as
Secondary.

SecureXL
Check Point product that accelerates IPv4 and IPv6 traffic. Installed on Security
Gateways for significant performance improvements.

Security Gateway
A computer that runs Check Point software to inspect traffic and enforces Security
Policies for connected network resources.

Security Management Server
A computer that runs Check Point software to manage the objects and policies in Check
Point environment.

Security Policy
A collection of rules that control network traffic and enforce organization guidelines for
data protection and access to resources with packet inspection.

SIC
Secure Internal Communication. The Check Point proprietary mechanism with which
Check Point computers that run Check Point software authenticate each other over
SSL, for secure communication. This authentication is based on the certificates issued
by the ICA on a Check Point Management Server.

Single Sign-On
A property of access control of multiple related, yet independent, software systems. With
this property, a user logs in with a single ID and password to gain access to a
connected system or systems without using different usernames or passwords, or in
some configurations seamlessly sign on at each system. This is typically accomplished
using the Lightweight Directory Access Protocol (LDAP) and stored LDAP databases
on (directory) servers. Acronym: SSO.

SmartConsole
A Check Point GUI application used to manage Security Policies, monitor products and
events, install updates, provision new devices and appliances, and manage a multi-
domain environment and each domain.
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SmartDashboard
A legacy Check Point GUI client used to create and manage the security settings in
R77.30 and lower versions.

Software Blade
A software blade is a security solution based on specific business needs. Each blade is
independent, modular and centrally managed. To extend security, additional blades can
be quickly added.

SSO
See "Single Sign-On".

Standalone
A Check Point computer, on which both the Security Gateway and Security
Management Server products are installed and configured.

T

Traffic
Flow of data between network devices.

U

Users
Personnel authorized to use network resources and applications.

V

VLAN
Virtual Local Area Network. Open servers or appliances connected to a virtual network,
which are not physically connected to the same network.

VLAN Trunk
A connection between two switches that contains multiple VLANs.
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VSX
Virtual System Extension. Check Point virtual networking solution, hosted on a
computer or cluster with virtual abstractions of Check Point Security Gateways and
other network devices. These Virtual Devices provide the same functionality as their
physical counterparts.

VSX Gateway
Physical server that hosts VSX virtual networks, including all Virtual Devices that
provide the functionality of physical network devices. It holds at least one Virtual
System, which is called VS0.



Gaia Overview

Gaia R80.40 Administration Guide      |      22

Gaia Overview
Gaia is the Check Point next generation operating system for security applications. In Greek mythology,
Gaia is the mother of all, which represents closely integrated parts to form one efficient system. The Gaia
Operating System supports the full portfolio of Check Point Software Blades, Gateway and Security
Management products.

Gaia is a unified security Operating System that combines the best of Check Point original operating
systems, and IPSO, the operating system from appliance security products. Gaia is available for all Check
Point Security Appliances and Open Servers.

Designed from the ground up for modern high-end deployments, Gaia includes support for:

n IPv4 and IPv6 - fully integrated into the Operating System.

n High Connection and Virtual Systems Capacity - 64-bit Linux kernel support.

n Load Sharing - ClusterXL and Interface bonding.

n High Availability - ClusterXL, VRRP, Interface bonding.

n Dynamic and Multicast Routing - BGP, OSPF, RIP, and PIM-SM, PIM-DM, IGMP.

n Easy to use Command Line Interface - Commands are structured with the same syntactic rules.
An enhanced help system and auto-completion simplifies user operation.

n Role-Based Administration - Lets Gaia administrators create different roles. Administrators can let
users define access to features in the users' role definitions. Each role can include a combination of
administrative (read/write) access to some features, monitoring (read-only) access to other
features, and no access to other features.

Gaia CPUSE:

n Get updates for licensed Check Point products directly through the operating system.

n Download and install the updates more quickly. Download automatically, manually, or periodically.
Install manually or periodically.

n Get email notifications for newly available updates and for downloads and installations.

n Easy rollback from new update.
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Introduction to the Gaia Portal
This chapter gives a brief overview of the Gaia Portal interface and procedures for using the interface
elements.

Gaia Portal Overview
n The Gaia Portal is an advanced, web-based interface for Gaia platform configuration. You can do

almost all system configuration tasks through this Web-based interface.

n Easy Access - Simply connect to:

https://<IP Address of Gaia Management Interface>

n Browser Support - Microsoft Edge, Microsoft Internet Explorer, Mozilla Firefox, Google Chrome and
Apple Safari.

n Powerful Search Engine - Makes it easy to find features or functionality to configure.

n Easy Operation - Two operating modes:

l Simplified mode, which shows only basic configuration options.

l Advanced mode, which shows all configuration options.

You can easily change these modes.

n Web-Based Access to Command Line - Clientless access to the Gaia Clish directly from your
browser.

The Gaia Portal interface
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Item Description

1 Navigation tree

2 Toolbar

3 Status bar

4 Overview page with widgets that show system information

5 Search tool

Note - The browser Back button is not supported. Do not use it.

Logging in to the Gaia Portal

To log in to the Gaia Portal:

Step Description

1 Enter this URL in your browser:

https://<IP Address of
Gaia Management
Interface>

2 Enter your user name and password.

Important:

n If you enable the Endpoint Policy Management blade on a Security
Management Server, the connection automatically changes:

From the default TCP port 443

https://<IP Address of Gaia Management Interface>

To the TCP port 4434:

https://<IP Address of Gaia Management
Interface>:4434

n If you disable the Endpoint Policy Management blade, the services
connection port automatically changes back to the default TCP port 443.

logging out from the Gaia Portal

Make sure that you always log out from the Gaia Portal (in the top right corner) before you close the web
browser. This is because the configuration lock stays in effect even when you close the web browser or
terminal window. The lock remains in effect until a different user removes the lock, or the defined
inactivity time-out period expires (default is 10 minutes).
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Working with the Configuration Lock
Only one user can have Read/Write access to Gaia configuration settings at a time. All other users can log
in with Read-Only access to see configuration settings, as specified by their assigned roles (see "Roles" on
page 278).

When you log in and no other user has Read/Write access, you get an exclusive configuration lock with
Read/Write access. If a different user already has the configuration lock, you have the option to override
their lock. If you:

n Override the lock. The other user stays logged in with Read-Only access.

n Do not override the lock. You cannot modify the settings.

To override a configuration lock in the Gaia Portal

n Click the Configuration lock (above the toolbar). The pencil icon (Read/Write enabled)
replaces the lock.

n If you use a configuration settings page, click the Click here to obtain lock link. You can see this
link if a different user overrides your configuration lock.

Note - Only users with Read/Write access privileges can override a configuration lock.

Using the Gaia Portal Interface Elements
The Gaia Portal contains many elements that make the task of configuring features and system settings
easier.

Toolbar Accessories
You can use these toolbar icons to do these tasks

Item Description

Read/Write mode enabled.

Configuration locked (Read Only mode).

Opens the Console accessory for CLI commands.

Available in the Read/Write mode only.

Opens the Scratch Pad accessory for writing notes or for quick copy/paste operations.

Available in the Read/Write mode only.
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Search Tool
You can use the search bar to find an applicable configuration page by entering a keyword. The keyword
can be a feature, a configuration parameter or a word that is related to a configuration page.

The search shows a list of pages related to the entered keyword. To go to a page, click a link in the list.

Navigation Tree
The navigation three lets you select a page. Pages are arranged in logical feature groups. You can show
the navigation tree in one of these viewmodes:

Mode Description

Basic Shows some standard pages.

Advanced Shows all pages. This is the default mode.

To change the navigation tree mode, click View Mode and select a mode from the list.

To hide the navigation tree, click the Hide icon.

Status Bar
The status bar, located at the bottom of the window, shows the result of the last configuration operation.

To see a history of the configuration operations during the current session, click the Expand icon.

Configuration Tab
The Configuration tab lets you see and configure parameters for Gaia features and settings groups. The
parameters are organized into functional settings groups in the navigation tree. You must have Read/Write
permissions for a settings group to configure its parameters.

Monitoring Tab
TheMonitoring tab lets you see status and detailed operational statistics, in real time, for some routing
and high availability settings groups. This information is useful for monitoring dynamic routing and VRRP
cluster performance.

To see theMonitoring tab, select a routing or high availability feature settings group and then click the
Monitoring tab. For some settings groups, you can select different types of information from a menu.
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Unsupported Characters and Words
To prevent possible Cross-Site Scripting (XSS) attacks, Gaia Portal does not accept some characters and
words when you enter them in various fields.

Unsupported Characters

Character Description

< Less than

> Greater than

& Ampersand

; Semi-colon

Unsupported Words

n after

n apply

n catch

n eval

n subset
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System Information Overview
This chapter shows you how to see system information using the Gaia Portal and some Gaia Clish
commands.

Showing System Overview Information in Gaia
Portal
TheOverview page shows status widgets.

You can add or remove widgets from the page, move them around the page and minimize or expand them.

Widgets

Widget Description

System
Overview

System information, including:

n Installed product (for example: Check Point Security Management,
Check Point Security Gateway)

n Product version number (for example: R80.10)

n Kernel edition (32-bit, or 64-bit)

n Product build number

n System uptime

n hardware platform, on which Gaia is installed

n Computer serial number (on Check Point appliances)

Blades Installed Software Blades.
Those that are enabled in SmartConsole, are colored.
Those that are disabled in SmartConsole, are grayed out.

Network
Configuration

Interfaces, their IP Addresses and Link Status.

CPU Monitor Graphical display of CPU usage.

Memory Monitor Graphical display of memory usage.

Packet Rate Graphical display of the overall traffic packet rate.

Throughput Graphical display of the overall traffic throughput.
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To add a widget to the page

Step Description

1 Scroll down to the bottom of this page.

2 Click Add Widget and select a widget to show.

To move a widget on the page

Step Description

1 Left-click the widget title bar.

2 Hold the left mouse button.

3 Drag the widget to the applicable location.

4 Release the left mouse button.
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Showing System Overview Information in Gaia
Clish
You can use these commands to show system status:

The "show uptime" command

Description

Shows how long the Gaia system is up and running.

Syntax

show uptime
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The "show version" command

Description

Shows the name and versions of the Gaia OS components.

Syntax

n To show the full system version information:

show version all

n To show version information for OS components:

show version os
build
edition
kernel

n To show name of the installed product:

show version product

Parameters

Parameter Description

all Shows all Gaia system information.

os build Shows the Gaia build number.

os edition Shows the Gaia kernel edition.

os kernel Shows the Gaia kernel build number.

product Shows the Gaia version.
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Introduction to the Command Line
Interface
This chapter introduces the Gaia command line interface. The default Gaia shell is called clish.

To use the Gaia Clish:

Step Description

1 Connect to the Gaia platform using one of these options:

n From SmartConsole (see "CentrallyManagingGaia Device Settings" on page 73).

n Using a command-line connection (SSH, or a console).

2 Log in using a user name and password.

Immediately after installation, the default user name and password are admin and admin.

Saving configuration changes:

When you change the OS configuration with in Gaia Clish, changes are applied immediately to the running
system only.
To have the changes survive a reboot, you must run the "save config" command.
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Command Completion
You can automatically complete a command.

This saves time, and can help if you are not sure what to type next.

Press
... To do this ...

<TAB> Complete or fetch the keyword.

Example:

HostName> set in<TAB>
inactivity-timeout - Set inactivity timeout
interface - Displays the interface related
parameters
HostName> set in

<SPAC
E><TA
B>

Show the arguments that the command for that feature accepts.

Example:

HostName> set interface<SPACE><TAB>
eth0 eth1 lo
HostName> set interface

<ESC>
<ESC>

See possible command completions.

Example:

HostName> set inter<ESC><ESC>
set interface VALUE ipv4-address VALUE mask-length VALUE
set interface VALUE ipv4-address VALUE subnet-mask VALUE
set interface VALUE ipv6-address VALUE mask-length VALUE
set interface VALUE { comments VALUE mac-addr VALUE mtu VALUE
state VALUE speed VALUE duplex VALUE auto-negotiation VALUE}
set interface VALUE { ipv6-autoconfig VALUE }
HostName> set inter

? Get help on a feature or keyword.

Example:

HostName> set interface <?>
interface: specifies the interface name
This operation configures an existing interface
HostName>

UP
arrow

DOWN
arrow

Browse the command history.
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Press
... To do this ...

LEFT
arrow

RIGHT
arrow

Edit the command.

Enter Run the command.

The cursor does not have to be at the end of the line.

You can usually abbreviate the command to the smallest number of unambiguous
characters.
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Commands and Features
Gaia Clish commands are organized into groups of related features, with a basic syntax:

<Operation> <Feature> <Parameter>

See "Summary of Gaia Clish Commands" on page 50.

Main operations Description

add Adds or creates a new configuration in the system.

set Sets a value in the system.

show Shows a value or values in the system.

delete Deletes a configuration in the system.

Other
operations Description

save Saves the configuration changes made since the last save operation.

reboot Restart the system.

halt Turns off the computer.

quit Exits from the Gaia Clish.

exit Exits from the shell, in which you work.

start Starts a transaction. Puts the Gaia Clish into transaction mode. All changes made using
commands in transaction mode are either applied at once, or none of the changes is
applied, based on the way transaction mode is terminated.

commit Ends transaction by committing changes.

rollback Ends transaction by discarding changes.

expert Enters the Expert shell. Allows low-level access to the system, including the file system.

ver Shows the version of the active Gaia image.

restore Restores the configuration of the system.

help Shows help on navigating the Gaia Clish and some useful commands.
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n To see the commands, for which you have permissions, run:

show commands

n To see a list of all features, run:

show commands feature<SPACE><TAB>

n To see all commands for a specific feature, run:

show commands feature <FeatureName>

n To see all commands for an operation of a feature, run:

show commands [op <Name>] [feature <Name>]

n To see all operations, run:

show commands op<SPACE><TAB>

At theMore prompt:

To see the next page, press <SPACE>.

To see the next line, press <ENTER>.

To exit from theMore prompt, press Q.
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Command History
You can recall commands you have used before, even in previous sessions.

Command Description

? Recall previous command.

? Recall next command.

history Show the last 100 commands.

!! Run the last command.

!nn Run a specific previous command: the nn command in the commands history
list.

!-nn Run the nnth previous command.

For example, entering !-3 runs the third from last command in the commands
history list.

!str Run the most recent command that starts with str.

!\?str\? Run the most recent command containing str.

You may omit the trailing ?, if a new line follows str immediately.

!!:s/str1/str2 Repeat the last command, replacing str1 with str2.

Command Reuse

You can combine word designators with history commands to refer to specific words used in previous
commands.

Words are numbered from the beginning of the line with the first word being denoted by 0 (digit zero).

Use a colon (:) to separate a history command from a word designator.

For example, you could enter !!:1 to refer to the first argument in the previous command.

In the command "show interfaces", the interfaces is word 1.

Word Designator Meaning

0 The operation word.

n The nth word.

^ The first argument; that is, word 1.

$ The last argument.

% The word matched by the most recent \?str\? search.
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Immediately after word designators, you can add a sequence of one or more of these modifiers, each
preceded by a colon:

Modifier Meaning

p Print the new command, but do not execute.

s/str1/str2 Replace str1 with str2 in the first occurrence of the word, to which you refer.

g Apply changes over the entire command.
Use this modified in conjunction with s, as in gs/str1/str2.
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Command Line Movement and Editing
You can back up in a command you are typing to correct a mistake.

To edit a command, use the left and right arrow keys to move around and the Backspace key to delete
characters.

You can enter commands that span more than one line.

You can use these keystroke combinations:

Keystroke combination Meaning

Alt D Delete next word (to the right of the cursor).

Alt F Go to the next word (to the right of the cursor).

Ctrl Alt H Delete the previous word (to the left of the cursor).

Ctrl Shift - Repeat the previous word (from the left of the cursor).

Ctrl A Move to the beginning of the line.

Ctrl B Move to the previous character (to the right of the cursor).

Ctrl E Move to the end of the line.

Ctrl F Move to the next character (to the right of the cursor).

Ctrl H Delete the previous character (to the left of the cursor).

Ctrl L Clear the screen and show the current line at the top of the screen.

Ctrl N Next history item.

Ctrl P Previous history item.

Ctrl R Redisplay the current line.

Ctrl U Delete the current line.
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Configuration Locks
Only one user can have Read/Write access to Gaia configuration database at a time. All other users can
log in with Read-Only access to see configuration settings, as specified by their assigned roles (see
"Roles" on page 278).

When you log in and no other user has Read/Write access, you get an exclusive configuration lock with
Read/Write access. If a different user already has the configuration lock, you have the option to override
their lock. If you:

n Override the lock. The other user stays logged in with Read-Only access.

n Do not override the lock. You cannot modify the settings.

The "lock database" and "lock database" commands

Description

Use the "lock database override" and "unlock database" commands to get exclusive
read-write access to the Gaia database by taking write privileges away from other administrators
logged into the system.

Syntax

lock database override

unlock database

Comments

n Use these commands with caution.

The administrator, whose write access is revoked, does not receive a notification.

n The "lock database override" command is identical to the "set config-lock on
override" command.

n The "unlock database" command is identical to the "set config-lock off" command.
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The "config-lock" commands

Description

Configures and shows the state of the configuration lock on Gaia configuration database.

Syntax

set config-lock
off
on [timeout <5-900>] override

show
config-lock
config-state

Parameters

Parameter Description

off Turns off the configuration lock.

on Turns on the configuration lock.

The default timeout value is 300 seconds.

timeout <5-900> Optional parameter.

Turns on the configuration lock for the specified interval in seconds.

Comments

n The "set config-lock on override" command is identical to the "lock database
override" command.

n The "set config-lock off" command is identical to the "unlock database" command.
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Environment Commands

Description

Use these commands to set the Gaia Clish environment for a user for a particular session, or permanently.

Syntax

To show the client environment

show clienv
all
config-lock
debug
echo-cmd
on-failure
output
prompt
rows
syntax-check

To configure the client environment

set clienv
config-lock {on | off}
debug {0-6}
echo-cmd {on | off}
on-failure {continue | stop}
output {pretty | structured | xml}
prompt <Prompt String>
rows <Row Number>
syntax-check {on | off}

To save the client environment configuration permanently

save clienv

Parameters

Parameter Description

config-
lock {on |
off}

Default value of the Clish config-lock parameter. If set to on, Gaia Clish will
lock the configuration when invoked, otherwise continue without a configuration
lock. When the configuration is locked by Clish, no configuration changes are
possible in Gaia Portal, until the lock is released.
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Parameter Description

debug {0-
6}

Debug level. Predefined levels are:

n 0 - (Default) Do not debug, display error messages only

n 5 - Show confd daemon requests and responses

n 6 - Show handler invocation parameters and results

echo-cmd
{on | off}

If set to on, echoes all commands before executing them, when the command
execution is done through the load configuration command. The default is
off.

on-failure
{continue
| stop}

Action performed on failure:

n continue - Show error messages, but continue running commands from a
file or a script

n stop - (Default) Stop running commands from a file or a script

output
{pretty |
structured
| xml}

Command line output format.

The default is pretty.

See "Client Environment Output Format" on page 44.

prompt
<Prompt
String>

Command prompt string. A valid prompt string can consist of any printable
characters and a combination of these variables:

n %H - Replaced with the Command number

n %I - Replaced with the User ID

n %M - Replaced with the Hostname

n %P - Replaced with the Product ID

n %U - Replaced with the Username

To set the prompt back to the default, use the keyword default.

rows <Row
Number>

Number of rows to show in your terminal window. If the window size is changed, the
number of rows will also change, unless the value is set to 0 (zero).

syntax-
check {on
| off}

Put the shell into syntax-check mode. Commands you enter are checked
syntactically and are not executed, but values are validated.

The default is off.
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Client Environment Output Format
Gaia Clish supports these output formats:

Pretty

Output is formatted to be clear.

For example, output of the command show user admin in pretty mode would look like this:

gaia> set clienv output pretty

gaia> show user admin
Uid Gid Home Dir. Shell Real Name Privileges
0 0 /home/admin /bin/cli.sh Admin Admin-like shell
gaia>

Structured

Output is delimited by semi-colons.

For example, output of the command show user admin in structured mode would look like this:

gaia> set clienv output structured

gaia> show user admin
Uid;Gid;Home Dir.;Shell;Real Name;Privileges;
0;0;/home/admin;/bin/bash;Admin;Admin-like shell;
gaia>
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XML

Adds XML tags to the output.

For example, output of the command show user admin in XML mode would look like this:

gaia> set clienv output xml

gaia> show user admin
<?xml version="1.0"?>

<CMDRESPONSE>
<CMDTEXT>show user admin</CMDTEXT>
<RESPONSE><System_User>

<Row>
<Uid>0</Uid>
<Gid>0</Gid>
<Home_Dir.>/home/admin</Home_Dir.>
<Shell>/bin/bash</Shell>
<Real_Name>Admin</Real_Name>
<Privileges>Admin-like shell</Privileges>

</Row>
</System_User>

</RESPONSE>
</CMDRESPONSE>

gaia>
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Expert Mode
The default Gaia shell is called clish. Gaia Clish is a restrictive shell (role-based administration controls
the number of commands available in the shell). While the use of Gaia Clish is encouraged for security
reasons, Gaia Clish does not give access to low level system functions. For low-level configuration, use the
more permissive Expert mode shell.

n To enter the Expert shell, run: expert

n To exit from the Expert shell and return to Gaia Clish, run: exit

Note - If a command is supported in Gaia Clish, it is not possible to run it in Expert mode.

For example, you cannot run the ifconfig command in the Expert mode. Use the "set interface"
command in Gaia Clish instead.

Description

The Expert mode password protects the Expert shell against authorized access.

Use these commands to set the Expert password by plain text or MD5 salted hash.

Use the MD5 salted hash option when upgrading or restoring using backup scripts.

Syntax

set expert-password

set expert-password hash <Hash String>

Important - You must run the "save config" command to set the new Expert mode
password permanently.

Parameters

Parameter Description

hash <Hash String> The password as an MD5 salted hash instead of plain text.

Use this option when you upgrade or restore using backup scripts.
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Example

gaia> set expert-password
Enter current expert password: *******
Enter new expert password: *****
Enter new expert password (again): *****
Password is only 5 characters long; it must be at least 6 characters
in length.
Enter new expert password: ******
Enter new expert password (again): ******
Password is not complex enough; try mixing more different kinds of
characters (upper case, lower case, digits, and punctuation).
Enter new expert password: *******
Enter new expert password (again): *******

gaia> save config



User Defined (Extended) Commands

Gaia R80.40 Administration Guide      |      48

User Defined (Extended) Commands

Description

Manage user defined (extended) commands in Gaia Clish. Extended commands include:

1. Built in extended commands. These are mostly for configuration and troubleshooting of Gaia and
Check Point products.

2. User defined commands.

You can do role-based administration (RBA) with extended commands by assigning extended commands
to roles and then assigning the roles to users or user groups.

Syntax

n To show all extended commands:

show extended commands

n To show the path and description of a specified extended command:

show command <Command>

n To add an extended command:

add command <Command> path <Path> description "<Text>"

n To delete an extended command:

delete command <Command>

Parameters

Parameter Description

<Command> Name of the extended command

<Path> Path of the extended command

"<Text>" Description of the extended command (must enclose in double quotes)

See "List of Available Extended Commands in Roles" on page 304.
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Example

To add the free command to the systemDiagnosis role and assign that role to the user john:

Step Description

1 To add the free command:

gaia> add command free path
/usr/bin/free description "Display
amount of free and used memory in
the system"

2 Save the configuration:

gaia> save config

3 Log out of Gaia.

4 Log in to Gaia again.

5 To add the free command to the systemDiagnosis role:

gaia> add rba role systemDiagnosis
domain-type System readwrite-
features ext_free

6 To assign the systemDiagnosis role to the user john:

gaia> add rba user john roles
systemDiagnosis

7 Save the configuration:

gaia> save config
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Summary of Gaia Clish Commands
This section shows the list of commands available in Gaia Clish.

To show the list of all available Gaia Clish commands:

Step Description

1 Connect to the command line on your Gaia system.

2 Log in to Gaia Clish.

3 Press the <TAB> key on the keyboard.

To show the list of available Gaia Clish 'show' commands:

Step Description

1 Connect to the command line on your Gaia system.

2 Log in to Gaia Clish.

3 Type:

show

4 Press the <SPACE> key and then the <TAB> key on the keyboard.

To show the list of available Gaia Clish 'add' commands:

Step Description

1 Connect to the command line on your Gaia system.

2 Log in to Gaia Clish.

3 Type:

add

4 Press the <SPACE> key and then the <TAB> key on the keyboard.
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To show the list of available Gaia Clish 'set' commands:

Step Description

1 Connect to the command line on your Gaia system.

2 Log in to Gaia Clish.

3 Type:

set

4 Press the <SPACE> key and then the <TAB> key on the keyboard.

To show the list of available Gaia Clish 'delete' commands:

Step Description

1 Connect to the command line on your Gaia system.

2 Log in to Gaia Clish.

3 Type:

delete

4 Press the <SPACE> key and then the <TAB> key on the keyboard.
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Configuring Gaia for the First Time
After you install Gaia for the first time, use the First Time Configuration Wizard to configure the system and
the Check Point products on it.

You can run the First Time Configuration Wizard in:

n Gaia Portal

n CLI Expert mode
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Running the First Time Configuration Wizard in
Gaia Portal

To start the Gaia First Time Configuration Wizard:

Step Instructions

1 Connect a computer to the Gaia computer.

You must connect to the interface you configured during the Gaia installation (for example,
eth0).

2 On your connected computer, configure a static IPv4 address in the same subnet as the IPv4
address you configured during the Gaia installation.

3 On your connected computer, in a web browser, connect to the IPv4 address you configured
during the Gaia installation:

https://<IP address of Gaia Management Interface>

4 Enter the default username and password: admin and admin.

5 Click Login.

The Check Point First Time Configuration Wizard opens.

6 Follow the instructions on the First Time Configuration Wizard windows.

See the applicable chapters below for installing specific Check Point products.

Below you can find the description of the First Time Configuration Wizard windows and their fields.
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Deployment Options window

In this window, you select how to deploy Gaia Operating System.

Section Options Description

Setup Continue with R80.40
configuration

Use this option to configure the installed Gaia and
Check Point products.

Install Install from Check Point
Cloud

Install from USB device

Use these options to install a Gaia version.

Recovery Import existing snapshot Use this option to import an existing Gaia snapshot.

If in the Deployment Options window, you selected Install from Check Point Cloud, the First Time
Configuration Wizard asks you to configure the connection to Check Point Cloud. These options appear
(applies only to Check Point appliances that you configured as a Security Gateway):

n Install major version - This option let you choose and install major versions available on Check
Point Cloud. The Gaia CPUSE performs the installation.

n Pull appliance configuration - This option lets you to apply initial deployment configuration
including different OS version on the appliance. You must prepare the initial deployment
configuration with the Zero Touch Cloud Service. For more information, see sk116375.

http://supportcontent.checkpoint.com/solutions?id=sk116375


Running the First Time Configuration Wizard in Gaia Portal

Gaia R80.40 Administration Guide      |      55

Management Connection window

In this window, you select and configure the main Gaia Management Interface. You connect to this IP
address to open the Gaia Portal or CLI session.

Field Description

Interface By default, First Time Configuration Wizard selects the interface you configured during
the Gaia installation (for example, eth0).

Note - After you complete the First Time Configuration Wizard and reboot,
you can select another interface as the main Gaia Management Interface
and configure its IP settings.

Configure
IPv4

Select how the Gaia Management Interface gets its IPv4 address:

n Manually - You configure the IPv4 settings in the next fields.

n Off - None.

IPv4
address

Enter the applicable IPv4 address.

Subnet
mask

Enter the applicable IPv4 subnet mask.

Default
Gateway

Enter the IPv4 address of the applicable default gateway.

Configure
IPv6

Select how the Gaia Management Interface gets its IPv6 address:

n Manually - You configure the IPv6 settings in the next fields.

n Off - None.

IPv6
Address

Enter the applicable IPv6 address.

Mask
Length

Enter the applicable IPv6 mask length.

Default
Gateway

Enter the IPv6 address of the applicable default gateway.
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Internet Connection window

Optional: In this window, you configure the interface that connects the Gaia computer to the Internet.

Interface Select the applicable interface on this computer.

Configure IPv4 Select how the applicable interface gets its IPv4 address:

n Manually - You configure the IPv4 settings in the next fields.

n Off - None.

IPv4 address Enter the applicable IPv4 address.

Subnet mask Enter the applicable IPv4 subnet mask.

Configure IPv6 Optional. Select how the applicable interface gets its IPv6 address:

n Manually - You configure the IPv6 settings in the next fields.

n Off - None.

IPv6 Address Enter the applicable IPv6 address.

Subnet Enter the applicable IPv6 subnet mask.

Device Information window

In this window, you configure the Host name, the DNS servers and the Proxy server on the Gaia
computer.

Field Description

Host Name Enter the applicable distinct host name.

Domain Name Optional: Enter the applicable domain name.

Primary DNS Server Enter the applicable IPv4 address of the primary DNS server.

Secondary DNS
Server

Optional: Enter the applicable IPv4 address of the secondary DNS server.

Tertiary DNS Server Optional: Enter the applicable IPv4 address of the tertiary DNS server.

Use a Proxy server Optional: Select this option to configure the applicable Proxy server.

Address Enter the applicable IPv4 address or resolvable hostname of the Proxy
server.

Port Enter the port number for the Proxy server.
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Date and Time Settings window

In this window, you configure the date and time settings on the Gaia computer.

Field Description

Set the time manually Select this option to configure the date and time settings manually.

Date Select the correct date.

Time Select the correct time.

Time Zone Select the correct time zone.

Use Network Time
Protocol (NTP)

Select this option to configure the date and time settings automatically
with NTP.

Primary NTP server Enter the applicable IPv4 address or resolvable hostname of the
primary NTP server.

Version Select the version of the NTP for the primary NTP server.

Secondary NTP server Optional: Enter the applicable IPv4 address or resolvable hostname of
the secondary NTP server.

Version Select the version of the NTP for the secondary NTP server.

Time Zone Select the correct time zone.
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Installation Type window

In this window, you select which type of Check Point products you wish to install on the Gaia computer.

Field Description

Security Gateway and/or Security
Management

Select this option to install:

n ASingle Security Gateway.

n ACluster Member.

n ASecurity Management Server, including
Management High Availability.

n An Endpoint Security Management Server.

n An Endpoint Policy Server.

n CloudGuard Controller.

n A dedicated single Log Server.

n A dedicated single SmartEvent Server.

n AStandalone.

Multi-Domain Server Select this option to install:

n AMulti-Domain Server, including Management
High Availability.

n A dedicated single Multi-Domain Log Server.

Products window

In this window, you continue to select which type of Check Point products you wish to install on the Gaia
computer.
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n If in the Installation Typewindow, you selected Security Gateway and/or Security
Management, these options appear:

Field Description

Security Gateway Select this option to install:

l A single Security Gateway.

l ACluster Member.

l AStandalone.

Security
Management

Select this option to install:

l ASecurity Management Server, including Management High
Availability.

l An Endpoint Security Management Server.

l An Endpoint Policy Server.

l CloudGuard Controller.

l A dedicated single Log Server.

l A dedicated single SmartEvent Server.

l AStandalone.

Unit is a part of a
cluster

This option is available only if you selected Security Gateway.

Select this option to install a cluster of dedicated Security Gateways,
or a Full High Availability Cluster.

Select the cluster type:

l ClusterXL - For a cluster of dedicated Security Gateways, or
a Full High Availability Cluster.

l VRRP Cluster - For a VRRPCluster on Gaia.

Define Security
Management as

Select Primary to install:

l ASecurity Management Server.

l An Endpoint Security Management Server.

l An Endpoint Policy Server.

l CloudGuard Controller.

Select Secondary to install:

l ASecondary Management Server in Management High
Availability.

Select Log Server / SmartEvent only to install:

l A dedicated single Log Server.

l A dedicated single SmartEvent Server.
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n If in the Installation Typewindow, you selectedMulti-Domain Server, these options appear:

Field Description

Primary Multi-Domain
Server

Select this option to install a Primary Multi-Domain Server in
Management High Availability.

Secondary Multi-
Domain Server

Select this option to install a Secondary Multi-Domain Server in
Management High Availability.

Multi-Domain Log
Server

Select this option to install a dedicated single Multi-Domain Log
Server.

Note - By default, the option Automatically download Blade Contracts and other
important data is enabled. See sk111080.

Dynamically Assigned IP window

In this window, you select if this Security Gateway gets its IP address dynamically (DAIP gateway).

Field Description

Yes Select this option, if this Security Gateway gets its IP address dynamically (DAIP gateway).

No Select this option, if you wish to configure this Security Gateway with a static IP address.

Secure Internal Communication (SIC) window

In this window, you configure a one-time Activation Key. You must enter this key later in SmartConsole
when you create the corresponding object and initialize SIC.

Field Description

Activation Key Enter one-time activation key (between 4 and 127 characters long).

Confirm Activation Key Enter the same one-time activation key again.

Security Management Administrator window

In this window, you configure the main administrator for this Security Management Server.

Use Gaia
administrator: admin

Select this option, if you wish to use the default Gaia administrator
(admin).

Define a new
administrator

Select this option, if you wish to configure an administrator username
and password manually.

http://supportcontent.checkpoint.com/solutions?id=sk111080
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Security Management GUI Clients window

In this window, you configure which computers are allowed to connect with SmartConsole to this
Security Management Server.

Field Description

Any IP Address Select this option to allow all computers to connect.

This machine Select this option to allow only a specific computer to connect.

By default, the First Time Configuration Wizard uses the IPv4 address of
your computer.

You can change it to another IP address.

Network Select this option to allow an entire IPv4 subnet of computers to connect.

Enter the applicable subnet IPv4 address and subnet mask.

Range of IPv4
addresses

Select this option to allow a specific range of IPv4 addresses to connect.

Enter the applicable start and end IPv4 addresses.

Leading VIP Interfaces Configuration window

In this window, you select the main Leading VIP Interface on this Multi-Domain Server.

Field Description

Select leading interface Select the applicable interface.

Multi-Domain Server GUI Clients window

In this window, you configure which computers are allowed to connect with SmartConsole to this Multi-
Domain Server.

Field Description

Any host Select this option to allow all computers to connect.

IP
address

Select this option to allow only a specific computer to connect.

By default, the First Time Configuration Wizard uses the IPv4 address of your
computer.

You can change it to another IP address.
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First Time Configuration Wizard Summary window

In this window, you can see the installation options you selected.

By default, the option Improve product experience by sending data to Check Point is enabled. See
sk111080.

Notes:

n At the end of the First Time Configuration Wizard, the Gaia computer reboots and the
initialization process is performed in the background for several minutes.

n If you installed the Gaia computer as a Security Management Server or Multi-Domain Server,
only read-only access is possible with SmartConsole during this initialization time.

n To verify that the configuration is finished:

1. Connect to the command line on the Gaia computer.

2. Log in to the Expert mode..

3. Check that the bottom section of the /var/log/ftw_install.log file contains one of
these sentences:

l installation succeeded

l FTW: Complete

Run:

cat /var/log/ftw_install.log | egrep --color "installation
succeeded|FTW: Complete"

http://supportcontent.checkpoint.com/solutions?id=sk111080
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Example outputs:

l From a Security Gateway or Cluster Member:

[Expert@GW:0]# cat /var/log/ftw_install.log | egrep --
color "installation succeeded|FTW: Complete"
Dec 06, 19 19:19:51 FTW: Complete
[Expert@GW:0]#

l From a Security Management Server or a Standalone:

[Expert@SA:0]# cat /var/log/ftw_install.log | egrep --
color "installation succeeded|FTW: Complete"
Dec 06, 2019 03:48:38 PM installation succeeded.
06/12/19 15:48:39 FTW: Complete
[Expert@SA:0]#

l From a Multi-Domain Server:

[Expert@MDS:0]# cat /var/log/ftw_install.log | egrep --
color "installation succeeded|FTW: Complete"
Dec 06, 2019 07:43:15 PM installation succeeded.
[Expert@MDS:0]#
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Running the First Time Configuration Wizard in
CLI Expert mode

Description

Use this command in the Expert mode to test and to run the First Time Configuration Wizard on a Gaia
system for the first time after the system installation.

Notes:

n The config_system utility is not an interactive configuration tool. It helps
automate the first time configuration process.

n The config_system utility is only for the first time configuration, and not for
ongoing system configurations.

Syntax

n To list the command options, run one of these:

Form Command

Short form config_system -h

Long form config_system --help

n To run the First Time Configuration Wizard from a specified configuration file, run one of these:

Form Command

Short form config_system -f <Path and Filename>

Long form config_system --config-file <Path and Filename>

n To run the First Time Configuration Wizard from a specified configuration string, run one of these:

Form Command

Short form config_system -s <String>

Long form config_system --config-string <String>

n To create a First Time Configuration Wizard Configuration file template in a specified path, run one
of these:

Form Command

Short form config_system -t <Path>
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Form Command

Long form config_system --create-template <Path>

n To verify that the First Time Configuration file is valid, run:

config_system --dry-run

n To list configurable parameters, run one of these:

Form Command

Short form config_system -l

Long form config_system --list-params

To run the First Time Configuration Wizard from a configuration string:

St
ep Description

1 Run this command in Expert mode:

config_system --config-string <String of Parameters and Values>

A configuration string must consist of parameter=value pairs, separated by the ampersand (&).

You must enclose the whole string between quotation marks.

For example:

"hostname=myhost&domainname=somedomain.com&timezone='America/Ind
iana/Indianapolis'&ftw_sic_key=aaaa&install_security_
gw=true&gateway_daip=false&install_ppak=true&gateway_cluster_
member=true&install_security_managment=false"

For more information on valid parameters and values, run the "config_system -h"
command.

2 Reboot the system.



Running the First Time Configuration Wizard in CLI Expert mode

Gaia R80.40 Administration Guide      |      66

To run the First Time Configuration Wizard from a configuration file:

Step Description

1 Run this command in Expert mode:

config_system -f
<File Name>

2 Reboot the system.

If you do not have a configuration file, you can create a configuration template and fill in the parameter
values as necessary.

Before you run the First Time Configuration Wizard, you can validate the configuration file you created.

To create a configuration file:

Step Description

1 Run this command in Expert mode:

config_system -t <File
Name>

2 Open the file you created in a text editor.

3 Edit all parameter values as necessary.

4 Save the updated configuration file.

To validate a configuration file:

Run this command in Expert mode:

config_system --config-file <File Name> --dry-run

Parameters

A configuration file contains the <parameter>=<value> pairs described in the table below.

Note - The config_system parameters can change from Gaia version to Gaia
version. Run the "config_system --help| command to see the available
parameters.

Parameter Description Valid values

install_
security_gw

Installs Security Gateway, if its value is set to
"true".

n true

n false

Table: The 'config_system' parameters
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Parameter Description Valid values

gateway_
daip

Configures the Security Gateway as Dynamic IP
(DAIP) Security Gateway, if its value is set to
"true".

n true

n false

Note - Must be set to
"false", if ClusterXL
or Security
Management Server
is enabled.

gateway_
cluster_
member

Configures the Security Gateway as member of
ClusterXL, if its value is set to "true".

n true

n false

install_
security_
managment

Installs Security Management Server, if its value
is set to "true".

n true

n false

install_
mgmt_
primary

Makes the installed Security Management
Server the Primary one.

Note - The value of the "install_
security_managment" parameter
must be set to "true".

n true

n false

Note - Can only be set
to "true", if the value
of the "install_
mgmt_secondary"
parameter is set to
"false".

install_
mgmt_
secondary

Makes the installed Security Management
Server a Secondary one.

Note - The value of the "install_
security_managment" parameter
must be set to "true".

n true

n false

Note - Can only be set
to "true", if the value
of the "install_
mgmt_primary"
parameter is set to
"false".

install_
mds_primary

Makes the installed Security Management
Server the Primary Multi-Domain Server.

Note - The value of the "install_
security_managment" parameter
must be set to "true".

n true

n false

Note - Can only be set
to "true", if the value
of the "install_
mds_secondary"
parameter is set to
"false".

Table: The 'config_system' parameters (continued)
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Parameter Description Valid values

install_
mds_
secondary

Makes the installed Security Management
Server a Secondary Multi-Domain Server.

Note - The value of the "install_
security_managment" parameter
must be set to "true".

n true

n false

Note - Can only be set
to "true", if the value
of the "install_
mds_primary"
parameter is set to
"false".

install_mlm Installs Multi-Domain Log Server, if its value is
set to "true".

n true

n false

install_
mds_
interface

Specifies Multi-Domain Server management
interface.

Name of the interface exactly as
it appears in the device
configuration.

Examples: eth0, eth1

download_
info

Downloads Check Point Software Blade
contracts and other important information, if its
value is set to "true".

For more information, see sk94508.

Best Practice - We highly
recommended you enable this
optional parameter.

n true

n false

upload_info Uploads data that helps Check Point provide you
with optimal services, if its value is set to "true".

For more information, see sk94509.

Best Practice - We highly
recommended you enable this
optional parameter.

n true

n false

mgmt_admin_
radio

Configures Management Server administrator.

Note - You must specify this
parameter, if you install a
Management Server.

n Set the value to "gaia_
admin", if you wish to
use the Gaia "admin"
account.

n Set the value to "new_
admin", if you wish to
configure a new
administrator account.

Table: The 'config_system' parameters (continued)

http://supportcontent.checkpoint.com/solutions?id=sk94508
http://supportcontent.checkpoint.com/solutions?id=sk94509
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Parameter Description Valid values

mgmt_admin_
name

Sets management administrator's username.

Note - You must specify this
parameter, if the value of the
"install_security_
managment" parameter is set to
"true".

A string of alphanumeric
characters.

mgmt_admin_
passwd

Sets management administrator's password.

Note - You must specify this
parameter, if the value of the
"install_security_
managment" parameter is set to
"true".

A string of alphanumeric
characters.

mgmt_gui_
clients_
radio

Specifies SmartConsole clients that can connect
to the Security Management Server.

n any

n range

n network

n this

mgmt_gui_
clients_
first_ip_
field

Specifies the first address of the range, if the
value of the "mgmt_gui_clients_radio"
parameter is set to "range".

Single IPv4 address of a host.

Example:
192.168.0.10

mgmt_gui_
clients_
last_ip_
field

Specifies the last address of the range, if the
value of the "mgmt_gui_clients_radio"
parameter is set to "range".

Single IPv4 address of a host.

Example:
192.168.0.20

mgmt_gui_
clients_ip_
field

Specifies the network address, if the value of the
"mgmt_gui_clients_radio" parameter is
set to "network".

IPv4 address of a network.

Example:
192.168.0.0

mgmt_gui_
clients_
subnet_
field

Specifies the netmask, if the value of the "mgmt_
gui_clients_radio" parameter is set to
"network".

A number from 1 to 32.

mgmt_gui_
clients_
hostname

Specifies the netmask, if value of the "mgmt_
gui_clients_radio" parameter is set to
"this".

Single IPv4 address of a host.

Example:
192.168.0.15

ftw_sic_key Sets a secure Internal Community key, if the
value of the "install_security_
managment" parameter is set to "false".

A string of alphanumeric
characters.

Table: The 'config_system' parameters (continued)
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Parameter Description Valid values

admin_hash Sets administrator's password. A string of alphanumeric
characters, enclosed between
single quotation marks.

iface Interface name (optional). Name of the interface exactly as
it appears in the device
configuration.

Examples:
eth0, eth1

ipstat_v4 Turns on static IPv4 configuration, if its value is
set to "manually".

n manually

n off

ipaddr_v4 Sets IPv4 address of the management interface. Single IPv4 address.

masklen_v4 Sets IPv4 mask length for the management
interface.

A number from 0 to 32.

default_gw_
v4

Specifies IPv4 address of the default gateway. Single IPv4 address.

ipstat_v6 Turns static IPv6 configuration on, if its value is
set to "manually".

n manually

n off

ipaddr_v6 Sets IPv6 address of the management interface. Single IPv6 address.

masklen_v6 Sets IPv6 mask length for the management
interface.

A number from 0 to 128.

default_gw_
v6

Specifies IPv6 address of the default gateway. Single IPv6 address.

hostname Sets the name of the local host (optional). A string of alphanumeric
characters.

domainname Sets the domain name (optional). Fully qualified domain name.

Example:
somedomain.com

Table: The 'config_system' parameters (continued)
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Parameter Description Valid values

timezone Sets the Area/Region (optional). The Area/Region must be
enclosed between single
quotation marks.

Examples:
'America/New_York'
'Asia/Tokyo'

Note - To see the
available Areas and
Regions, connect to
any Gaia computer,
log in to Gaia Clish,
and run this
command (names of
Areas and Regions
are case-sensitive):
set timezone
Area
<SPACE><TAB>

ntp_primary Sets the IP address of the primary NTP server
(optional).

IPv4 address.

ntp_
primary_
version

Sets the NTP version of the primary NTP server
(optional).

n 1

n 2

n 3

n 4

ntp_
secondary

Sets the IP address of the secondary NTP server
(optional).

IPv4 address.

ntp_
secondary_
version

Sets the NTP version of the secondary NTP
server (optional).

n 1

n 2

n 3

n 4

primary Sets the IP address of the primary DNS server
(optional).

IPv4 address.

secondary Sets the IP address of the secondary DNS
server (optional).

IPv4 address.

tertiary Sets the IP address of the tertiary DNS server
(optional).

IPv4 address.

proxy_
address

Sets the IP address of the proxy server
(optional).

IPv4 address, or Hostname.

Table: The 'config_system' parameters (continued)
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Parameter Description Valid values

proxy_port Sets the port number of the proxy server
(optional).

A number from 1 to 65535.

reboot_if_
required

Reboots the system after the configuration, if its
value is set to "true" (optional).

n true

n false

Table: The 'config_system' parameters (continued)
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Centrally Managing Gaia Device
Settings
Introduction of Gaia Central Management
SmartConsole lets you:

n Centrally configure network topology:

l IPv4 and IPv6 addresses

l IPv4 and IPv6 static routes

n Centrally configure device settings for these network services:

l DNS

l NTP

l Proxy server

n Do Backup and Restore operation

A compressed .tgz backup file captures the Gaia OS configuration and the Security Gateway
database.

n Do maintenance operations:

l By opening the Gaia Portal or command shell from SmartConsole

l By fetching settings from the device, or by pushing settings to the device

n Examine recent tasks:

The Recent Tasks tab, located in the bottom section of SmartConsole, shows recent Gaia Security
Gateway management tasks done using SmartConsole.

n Run command line scripts on the Security Gateway.

Output from the commands shows in the Recent Tasks window.

Double-click the task to see the complete output.

n Receive notification on local device configuration change

The Status column in theGateways view indicates changes in the device configuration

n Implement configuration changes without a full policy install (Push Settings to Device action)

n Automate the configuration of Cloning Groups and synchronization between the members
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Managing Gaia in SmartConsole
After enabling Central management, Gaia gateways can be more effectively managed through
SmartConsole.

Running Command Scripts

One Time scripts

You can manually enter and run a command line script on the selected Gaia Security Gateways.

This feature is useful for scripts that you do not have to run on a regular basis.

To run a one-time script

Step Description

1 Right-click the Security Gateway.

2 Select Scripts > Run One Time Script.

3 The Run One Time Scriptwindow opens

You can:

n Enter the command in the Script Body text box and specify script
arguments, or

n Load the complete command from a text file

Notes:

l By default, the maximum size of a script is: 8 kilobytes.

l This value can be changed in SmartConsole> Main
application menu > Global properties > Advanced >
Configure > Central Device Management > device_
settings_max_script_length_in_KB.

4 ClickRun.

The output from the script shows in the Tasks tab >Results column.

n Double-clicking the task shows the output in a larger window

n You can also right-click the task, and select View, and then Copy to
Clipboard

Notes:

l The Run One Time Scriptwindow does not support
interactive or continuous scripts. To run interactive or
continuous scripts, open a command shell.

l If the gateways are not part of a Cloning Group, you can
run a script on multiple gateways at the same time.
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To run a Repository script

Step Description

1 Right-click the Security Gateway.

2 Select Scripts > Run Repository Script.

3 The Select Scriptwindow opens.

You can:

n Select a script from the drop-down box, or clickNew to create a new script for the
repository.

n Enter script arguments.

Note - The Select Scriptwindow does not support interactive or continuous
scripts. To run interactive or continuous scripts, open a command shell.

4 ClickRun.

The output from the script shows in the Tasks tab >Results column.

n Placing the mouse in the Details column shows the output in a larger window.

n You can also right-click, and select View, or Copy to Clipboard.

Manage repository scripts

You can create new scripts, edit or delete scripts from the script repository.

To manage scripts

Step Description

1 Right-click the Security Gateway.

2 Select Scripts > Manage Script Repository.

3 TheManage Scripts window opens.

Note - You can also run and manage scripts if you click Scripts in the Gateways view.
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Understanding One-Time Scripts
If you specify a script:

n By default, the maximum size of a script is: 8 kB.

n The output from the script shows in the Tasks tab at the bottom of theGateways & Servers view.

n The Run One Time Scriptwindow does not support interactive or continuous scripts. To run
interactive or continuous scripts, open a command shell.

Running Repository Scripts
You can run a predefined script from the script repository.

To run a script from the repository

Step Description

1 In theGateways & Servers view, right-click the Security Gateways or Security Management
Servers, on which you want to run scripts.

2 Select Scripts >Scripts Repository.

The Scripts Repository window opens.

3 Do one of these steps:

n Select an existing script from the list, clickRun, enter Arguments if needed, and click
Run.

n ClickNew to create a new script for the repository, or load it from a text file. ClickOK.

The output from the script shows in the Tasks tab at the bottom of theGateways & Servers view.

Notes:

n The Scripts Repository window does not support interactive or continuous
scripts. To run interactive or continuous scripts, open a command shell.

n You can run the script on multiple Security Gateways or Security
Management Servers at the same time.

n For a cluster object, the script will run automatically on all cluster members.

Backup and Restore
These options let you:

n Back up the Gaia OS configuration and the firewall database to a compressed file

n Restore the Gaia OS configuration and the firewall database from a compressed file

Best Practice - We recommended using System Backup to back up your system
regularly. Schedule system backups on a regular basis, daily or weekly, to preserve the
Gaia OS configuration and firewall database.
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Backing up the System

Note - After you install the Security Gateway for the first time, you must publish the
SmartConsole session before you perform a system backup operation.

To back up the system

Step Description

1 In theGateways & Servers view, right-click the Security Gateway object you want to back
up.

2 Select Actions >System Backup.

The System Backupwindow opens.

3 Select the backup location. Use one of these options:

n The Backup server defined for this gateway - To define a backup server for this
Security Gateway, double-click the Security Gateway object, and clickNetwork
Management >System Backup

n Enter the details of the backup server

Note - The path to the backup directory must start and end with forward slash (/)
character. For example: /ftroot/backup/, or just / for the root directory of the
server.

The file name must be according to this convention:

backup_<Name of Security Gateway object>_<Date of Backup>.tgz

4 ClickOK.

The status of the backup operation shows in Tasks.

5 When the task is complete, double-click the entry to see the file path and name of the backup
file.

Notes:

n This name is necessary to do a system restore.

n You can do backup on multiple Security Gateways at the same time.

n When you back up a cluster, the system does backup on all members.
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Restoring the System

To restore the system

Step Description

1 In theGateways & Servers view, right-click the Security Gateway object you want to
restore.

2 Select Actions >System Restore.

The System Restorewindow opens.

3 Enter the required information.

Note - If you cannot find the name of the file in Tasks, or did not save the file name
after you completed the backup process:

a. Right-click the Security Gateway object.

b. Select Actions >Open Shell.

c. On the Security Gateway, run the Gaia Clish command:

show backup logs

d. Find the name of the compressed backup file.

The file is named according to this convention:

backup_<Name of Security Gateway object>_<Date of
Backup>.tgz

4 ClickOK.

a. Connectivity to the Security Gateway is lost.

b. The Security Gateway automatically reboots.

5 Install the policy on the Security Gateway object.

The status of the restore operation shows in Tasks tab.
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Opening Gaia Portal and Gaia Clish
From SmartConsole, you can open a Security Gateway's the command line window, or the Gaia Portal.
You can select the command line or the Gaia Portal from the right-click menu of a Security Gateway object,
or from the top toolbar >Actions button.

To open a command line window on the Security Gateway

Step Description

1 In SmartConsole, right-click the Security Gateway object.

2 Select Actions > Open Shell.

n Log in with your Gaia credentials.

n The Open Shell uses public key authentication.

n For a cluster object, select the member, to which you want to connect.

A command line window opens with default shell that was configured for the specified user.

To open a Security Gateway Gaia Portal

Step Description

1 In SmartConsole, right-click the Security Gateway object.

2 Select Actions > Gaia Portal.

Note - For a cluster, select the cluster member, for which you want to
open the Gaia Portal.

The Gaia Portal opens in the default web browser.

The URL is taken from the Platform Portal page of the Security Gateway object.
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Network Management
This chapter includes configuration procedures for:

n Interfaces (Physical, VLAN, Bond, Bridge, Loppback, VTI, Alias)

n ARP

n DHCPServer

n Hosts

n DNS

n Static Routes

n Netflow Export
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Network Interfaces
Gaia supports these network interface types:

n Ethernet physical interfaces

n Alias (Secondary IP addresses for different interface types. This is not supported in ClusterXL.)

n VLAN

n Bond

n Bridge

n Loopback

n 6in4 tunnel

n PPPoE

Note - When you add, delete or make changes to interface IP addresses, it is possible
that when you use theGet Topology option in SmartConsole in the Security Gateway
or Cluster object, the incorrect topology is shown. If this occurs, run the "cpstop" and
then the "cpstart" commands on the Security Gateway or Cluster Members.



Physical Interfaces

Gaia R80.40 Administration Guide      |      82

Physical Interfaces
In This Section:

Configuring Physical Interfaces in Gaia Portal 83

Configuring Physical Interfaces in Gaia Clish 84

This section has configuration procedures and examples for defining different types of interfaces on a Gaia
platform.

Gaia automatically identifies physical interfaces (NICs) installed on the computer.

You cannot add or delete a physical interface using the Gaia Portal, or the Gaia Clish.

You cannot add, change or remove physical interface cards while the Gaia computer is running.

To add or remove an interface card

Step Description

1 Turn off the Gaia computer:

n In Gaia Portal:

ClickMaintenance > Shut Down, and
clickHalt

n In Gaia Clish:

Run: halt

2 Add, remove, or replace the interface cards.

3 Turn on the Gaia computer.

Gaia automatically identifies the new or changed physical interfaces and assigns an interface name.
The physical interfaces show in the list in the Gaia Portal.
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Configuring Physical Interfaces in Gaia Portal

This section includes procedures for changing physical interface parameters using the Gaia Portal.

To configure a physical interface

Step Description

1 In the navigation tree, clickNetwork Management >Network Interfaces.

2 Select an interface from the list and click Edit.

3 Select the Enable option to set the interface status to UP.

4 In the Comment field, enter the applicable comment text (up to 100 characters).

5 On the IPv4 tab, do one of these:

n SelectObtain IPv4 address automatically to get the IPv4 address from the DHCPv4
server.

n Enter the IPv4 address and subnet mask in the applicable fields.

6 On the IPv6 tab (optional), do one of these:

n SelectObtain IPv6 address automatically to get the IPv6 address from the DHCPv6
server.

n Enter the IPv6 address and mask length in the applicable fields.

Important - First, you must enable the IPv6 Support and reboot (see "System
Configuration" on page 247). R80.40 does not support IPv6 Address on Gaia
Management Interface (Known Limitation 01622840).

7 On the Ethernet tab:

n Select Auto Negotiation, or select a link speed and duplex setting from the list.

n In the Hardware Address field, enter the Hardware MAC address (if not automatically
received from the NIC).

Caution:Do not manually change the MAC address unless you are sure that it is
incorrect or has changed. An incorrect MAC address can lead to a communication
failure.

n In theMTU field, enter the applicable Maximum Transmission Unit (MTU) value
(minimal value is 68, maximal value is 16000, and default value is 1500).

n SelectMonitor Mode, if needed.

For Monitor Mode configuration procedure, see the R80.40 Installation and Upgrade
Guide > Chapter Special Scenarios for Security Gateways > Section Deploying a
Security Gateway inMonitor Mode.

8 ClickOK.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
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Configuring Physical Interfaces in Gaia Clish

Note - There are some command options and parameters that you cannot configure in
the Gaia Portal.

Syntax

To configure an interface

set interface <Name of Physical Interface>
auto-negotiation {on | off}
comments "Text"
ipv4-address <IPv4 Address> {subnet-mask <Mask> | mask-length

<Mask Length>}
ipv6-address <IPv6 Address> mask-length <Mask Length>
ipv6-autoconfig {on | off}
link-speed {10M/half | 10M/full | 100M/half | 100M/full |

1000M/full | 10000M/full}
mac-addr <MAC Address>
monitor-mode {on | off}
mtu <68-16000 | 1280-16000>
rx-ringsize <0-4096>
state {on | off}
tx-ringsize <0-4096>

To show all configured settings of all interfaces

show interfaces all

To show all configured settings of a specific interface

show interface <Name of Physical Interface>

To show the specific configured setting of a specific interface

show interface <Name of Physical Interface><SPACE><TAB>

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

CLI Parameters

Parameter Description

interface <Name of Physical
Interface>

Specifies a physical interface.

auto-negotiation {on | off} Configures automatic negotiation of
interface link speed and duplex settings:

n on - Enabled

n off - Disabled

comments "Text" Configures an optional free text comment.

n Write the text in double-quotes.

n Text must be up to 100 characters.

n This comment appears in the Gaia
Portal and in the output of the show
configuration command.

ipv4-address <IPv4 Address> Configures the IPv4 address.

ipv6-address <IPv6 Address> Configures the IPv6 address.

Important - First, you must enable
the IPv6 Support and reboot (see
"SystemConfiguration" on
page 247). R80.40 does not
support IPv6 Address on Gaia
Management Interface (Known
Limitation 01622840).

subnet-mask <Mask> Configures the IPv4 subnet mask using
dotted decimal notation (X.X.X.X).

mask-length <Mask Length> Configures the IPv4 or IPv6 subnet mask
length using the CIDR notation (integer
between 2 and 32).
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Parameter Description

ipv6-autoconfig {on | off} Configures if this interface gets an IPv6
address from a DHCPv6 Server:

n on - Gets an IPv6 address from a
DHCPv6 Server

n off - Does not get an IPv6 address
from a DHCPv6 Server (you must
assign it manually)

Important - First, you must enable
the IPv6 Support and reboot (see
"SystemConfiguration" on
page 247).

link-speed {10M/half | 10M/full |
100M/half | 100M/full | 1000M/full |
1000M/full}

Configures the interface link speed and
duplex status.

Available speed and duplex combinations
are:

n 10M/half

n 10M/full

n 100M/half

n 100M/full

n 1000M/full

n 10000M/full

mac-addr <MAC Address> Configures the hardware MAC address.

monitor-mode {on | off} Configures Monitor Mode on this interface:

n on - Enabled

n off - Disabled

Default: off

For configuration procedure, see the
R80.30 Installation and UpgradeGuide.

https://sc1.checkpoint.com/documents/R80.30/WebAdminGuides/EN/CP_R80.30_Installation_and_Upgrade_Guide/html_frameset.htm
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Parameter Description

mtu <68-16000 | 1280-16000> Configures the Maximum Transmission Unit
size for an interface.

For IPv4:

n Range: 68 - 16000 bytes

n Default: 1500 bytes

For IPv6:

n Range: 1280 - 16000 bytes

n Default: 1500 bytes

rx-ringsize <0-4096> Configures the receive buffer size.

n Range: 0 - 4096 bytes

n Default: 4096 bytes

state {on | off} Configures the interface state:

n on - Enabled

n off - Disabled

tx-ringsize <0-4096> Configures the transmit buffer size.

n Range: 0 - 4096 bytes

n Default: 4096 bytes

Example

gaia> set interface eth2 ipv4-address 40.40.40.1 subnet-mask
255.255.255.0
gaia> set interface eth2 mtu 1400
gaia> set interface eth2 state on
gaia> set interface eth2 link-speed 100M/full
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Aliases
This section shows you how to configure an alias using the Gaia Portal and the Gaia Clish.

Interface aliases let you assign more than one IPv4 address to physical or virtual interfaces (Bonds,
Bridges, VLANs, and Loopbacks).

Notes:

n ClusterXL does not support aliases.

n You cannot change settings of an existing
interface alias.

Configuring Aliases in Gaia Portal

To add an interface alias

Step Description

1 In the navigation tree, clickNetwork Management >Network Interfaces.

2 Click Add >Alias.

3 On the IPv4 tab, enter the IPv4 address and subnet mask.

4 On the Alias tab, select the interface, to which this alias is assigned.

5 ClickOK.

The new alias interface name is automatically created by adding a sequence number to the interface
name.

For example, the name of first alias added to eth1 is eth1:1. The second alias added is eth1:2, and so
on.

To delete an interface alias

Step Description

1 In the navigation tree, clickNetwork Management >Network Interfaces.

2 Select an interface alias and clickDelete.

3 ClickOK, when the confirmation message shows.
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Configuring Aliases in Gaia Clish

Syntax

To add an alias

add interface <Name of Interface> alias <IPv4 Address>/<Mask Length>

To see the configured aliases

show interface <Name of Interface> aliases

To delete an alias

delete interface <Name of Interface> alias <Name of Alias Interface>

Note - A new alias interface name is automatically created by adding a sequence
number to the original interface name. For example, the name of first alias added to
eth1 is eth1:1. The second alias added is eth1:2, and so on.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

CLI Parameters

Parameter Description

<Name of
Interface>

Specifies the name of the interface, on which to create an alias IPv4
address

<IPv4 Address> Assigns the alias IPv4 address

<Mask Length> Configures alias IPv4 subnet mask length using the CIDR notation (integer
between 2 and 32)

<Name of Alias
Interface>

Specifies the name of the alias interface in the format <IF>:XX, where XX
is the automatically assigned sequence number

Example

gaia> add interface eth1 alias 10.10.99.1/24

gaia> show interface eth1 aliases

gaia> delete interface eth1 alias eth1:2
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VLAN Interfaces
In This Section:

Configuring VLAN Interfaces in Gaia Portal 91

Configuring VLAN Interfaces in Gaia Clish 92

Access Mode VLAN and Trunk Mode VLAN 95

This section shows you how to configure VLAN interfaces using the Gaia Portal and the Gaia Clish.

You can configure virtual LAN (VLAN) interfaces on Ethernet interfaces.

VLAN interfaces let you configure subnets with a secure private link to Security Gateways and
Management Servers using your existing topology.

With VLAN interfaces, you can multiplex Ethernet traffic into many channels using one cable.
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Configuring VLAN Interfaces in Gaia Portal

Workflow

Step Description

1 In the navigation tree, clickNetwork Management >Network Interfaces.

2 Make sure that the physical interface, on which you add a VLAN interface, does not have an
IP address.

3 Click Add >VLAN.

To configure an existing VLAN interface, select the VLAN interface and click Edit.

4 In the Add VLAN (or Edit VLAN) window, select the Enable option to set the VLAN interface
to UP.

5 On the IPv4 tab, enter the IPv4 address and subnet mask.

You can optionally select theObtain IPv4 Address automatically option.

6 On the IPv6 tab, enter the IPv6 address and mask length.

You can optionally select theObtain IPv6 Address automatically option.

Important - First, you must enable the IPv6 Support and reboot (see "System
Configuration" on page 247).

7 On the VLAN tab, enter or select a VLAN ID (VLAN tag) between 2 and 4094.

8 In theMember Of field, select the physical interface related to this VLAN.

Note - You cannot change the VLAN ID or physical interface for an existing VLAN
interface. To change these parameters, delete the VLAN interface and then create
a New VLAN interface.
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Configuring VLAN Interfaces in Gaia Clish

Important - Make sure that the physical interface, on which you wish to add a VLAN
interface, does not have an IP address.

Syntax

To add a new VLAN interface

add interface <Name of Physical Interface> vlan <VLAN ID>

To configure a VLAN interface

set interface <Name of Physical Interface>.<VLAN ID>
comments "Text"
ipv4-address <IPv4 Address>

subnet-mask <Mask>
mask-length <Mask Length>

ipv6-address <IPv6 Address> mask-length <Mask Length>
ipv6-autoconfig {on | off}
mtu <68-16000 | 1280-16000>
state {on | off}

To show the configuration of a specific VLAN interface

show interface<SPACE><TAB>

show interface <Name of VLAN Interface>

To delete a VLAN interface

delete interface <Name of Physical Interface> vlan <VLAN ID>

Note - You cannot change the VLAN ID or physical interface for an existing VLAN
interface. To change these parameters, delete the VLAN interface and then create a
new VLAN interface.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

CLI Parameters

Parameter Description

<Name of Physical
Interface>

Specifies a physical interface.

comments "Text" Defines the optional comment.

n Write the text in double-quotes.

n Text must be up to 100 characters.

n This comment appears in the Gaia Portal and in the output of
the show configuration command.

<VLAN ID> Configures the ID of the VLAN interface (integer between 2 and 4094).

<IPv4 Address> Assigns the IPv4 address.

<IPv6 Address> Assigns the IPv6 address.

Important - First, you must enable the IPv6 Support and
reboot (see "SystemConfiguration" on page 247).

subnet-mask <Mask> Configures the IPv4 subnet mask using the dotted decimal notation
(X.X.X.X).

mask-length <Mask
Length>

Configures the IPv4 or IPv6 subnet mask length using CIDR notation
(/xx) - integer between 2 and 32.

ipv6-autoconfig
{on | off}

Configures if this interface gets an IPv6 address from a DHCPv6
Server:

n on - Gets an IPv6 address from a DHCPv6 Server

n off - Does not get an IPv6 address from a DHCPv6 Server
(you must assign it manually)

Important - First, you must enable the IPv6 Support and
reboot (see "SystemConfiguration" on page 247).



VLAN Interfaces

Gaia R80.40 Administration Guide      |      94

Parameter Description

mtu <68-16000 |
1280-16000>

Configures the Maximum Transmission Unit size for an interface.

For IPv4:

n Range: 68 - 16000 bytes

n Default: 1500 bytes

For IPv6:

n Range: 1280 - 16000 bytes

n Default: 1500 bytes

state {on | off} Configures interface's state:

n on - Enabled

n off - Disabled

Example

gaia> add interface vlan eth1
gaia> set interface eth1.99 ipv4-address 99.99.99.1 subnet-mask
255.255.255.0
gaia> set interface eth1.99 ipv6-address 209:99:1 mask-length 64
gaia> delete interface eth1 vlan 99
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Access Mode VLAN and Trunk Mode VLAN

VLAN traffic can pass through a Bridge interface in one of these modes:

Access Mode VLAN

If you configure the switch ports in Access Mode, create the Bridge interface with two VLAN interfaces
as its slaves.

For VLAN translation, use different numbered VLAN interfaces to create the Bridge interface.

You can build multiple VLAN translation bridges on the same Security Gateway.

1. Configure two VLAN interfaces.

2. Create a Bridge interface and select the VLAN interfaces as its slaves (see "Bridge Interfaces" on
page 115).

Note - VLAN translation is not supported over bridged ports of a FONIC (Fail-Open
NIC, see sk85560).

Example topology:

Item Description

1 Security Gateway

2 Switch

3 Access mode bridge 1 with VLAN translation

http://supportcontent.checkpoint.com/solutions?id=sk85560
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Item Description

4 Access mode bridge 2 with VLAN translation

5 VLAN 3 (eth 1.3)

6 VLAN 33 (eth 2.33)

7 VLAN 2 (eth 1.2)

8 VLAN 22 (eth 2.22)

Trunk Mode VLAN

If you configure the switch ports as VLAN trunk, the Check Point Bridge interface should not interfere
with the VLANs.

To configure a Bridge interface with VLAN trunk, create the Bridge interface with two physical (non-
VLAN) interfaces as its slaves (see "Bridge Interfaces" on page 115).

The Security Gateway processes the tagged packet and does not remove VLAN tags from them.

The traffic passes with the original VLAN tag to its destination.

Note - VLAN translation is not supported in Trunk mode.
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Bond Interfaces (Link Aggregation)
Check Point security devices support Link Aggregation, a technology that joins multiple physical interfaces
into one virtual interface, known as a bond interface. The bond interface share the load among many
interfaces, which gives fault tolerance and increases throughput. Check Point devices support the IEEE
802.3ad Link Aggregation Control Protocol (LCAP) for dynamic link aggregation.

Item Description

1 Security Gateway

1A Interface 1

1B Interface 2

2 Bond Interface

3 Router

A bond interface (also known as a bonding group or bond) is identified by its Bond ID (for example:
bond1) and is assigned an IP address. The physical interfaces included in the bond are called slaves and
do not have IP addresses.
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You can configure a bond interface to use one of these functional strategies:

n High Availability (Active/Backup): Gives redundancy when there is an interface or a link failure.
This strategy also supports switch redundancy. Bond High Availability works in Active/Backup
mode - interface Active/Standby mode. When an Active slave interface is down, the connection
automatically fails over to the primary slave interface. If the primary slave interface is not available,
the connection fails over to a different slave interface.

n Load Sharing (Active/Active): All slave interfaces in the UP state are used simultaneously. Traffic is
distributed among the slave interfaces to maximize throughput. Bond Load Sharing does not
support switch redundancy.

Note - Bonding Load Sharing mode requires SecureXL to be enabled on
Security Gateway or each Cluster Member.

You can configure Bond Load Sharing to use one of these modes:

l Round Robin - Selects the Active slave interfaces sequentially.

l 802.3ad - Dynamically uses Active slave interfaces to share the traffic load. This mode uses
the LACP protocol, which fully monitors the interface link between the Check Point Security
Gateway and a switch.

l XOR - All slave interfaces in the UP state are Active for Load Sharing. Traffic is assigned to
Active slave interfaces based on the transmit hash policy: Layer 2 information (XOR of
hardware MAC addresses), or Layer 3+4 information (IP addresses and Ports).

For Bonding High Availability mode and for Bonding Load Sharing mode:

n The number of bond interfaces that can be defined is limited by the maximal number of interfaces
supported by each platform. See the R80.40 Release Notes.

n Up to 8 physical slave interfaces can be configured in a single bond interface.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_RN/Default.htm
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Configuring Bond Interfaces in Gaia Portal

Step Description

1 In the navigation tree, clickNetwork Management >Network Interfaces.

2 Make sure that the slave interfaces, which you wish to add to the Bond interface, do not have IP
addresses.

3 For a new bond interface, select Add >Bond.

To edit an existing Bond interface, select the Bond interface and click Edit.

4 On the IPv4 tab, enter the IPv4 address and subnet mask.

You can optionally select theObtain IPv4 Address automatically option.

5 On the IPv6 tab (optional), enter the IPv6 address and mask length.

You can optionally select theObtain IPv6 Address automatically option.

Important - First, you must enable the IPv6 Support and reboot (see "System
Configuration" on page 247).

6 On the Bond tab:

a. Select or enter a Bond Group ID. This parameter is an integer between 0 and 1024.

b. Select the slave interfaces from the Available Interfaces list and then click Add.

Note - Make sure that the slave interfaces do not have any IP addresses or
aliases configured.

c. Select anOperation Mode:

n Round Robin (default) - Bond uses all slave interfaces sequentially (High
Availability + Load Sharing).

n Active-Backup - Bond uses one slave interface at a time (High Availability).

n XOR - Bond uses slave interfaces based on a hash function (High Availability +
Load Sharing).

n 802.3ad - Dynamic bonding according to IEEE 802.3ad (Load Sharing).
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Step Description

7 On the Advanced tab:

a. Configure the requiredMTU for your network (if not sure, leave the default value).

b. Configure theMonitor Interval - Howmuch time to wait between checking each slave
interface for link-failure. The valid range is 1-5000 ms. The default is 100 ms.

c. Configure the Down Delay - Howmuch time to wait, after sending a monitor request to a
slave interface, before bringing down the slave interface. The valid range is 1-5000 ms.
The default is 200 ms.

d. Configure the Up Delay - Howmuch time to wait, after sending a monitor request to a
slave interface, before bringing up the slave interface. The valid range is 1-5000 ms. The
default is 200 ms.

8 Additional configuration settings are available depending on the selected Bond Operation
Mode:

n If you selected the Round Robin bond operation mode, then there are no additional
configuration settings.

n If you selected the Active-Backup bond operation mode, then select the Primary
Interface.

n If you selected the XOR bond operation mode, then select the Transmit Hash Policy -
the algorithm for slave interface selection according to the specified TCP/IP Layer.

Select either Layer 2 (uses XOR of the physical interface MAC address), or Layer 3+4
(uses Layer 3 and Layer 4 protocol data).

n If you selected the 802.3ad bond operation mode, then perform these two steps:

a. Select the Transmit Hash Policy - the algorithm for slave interface selection
according to the specified TCP/IP Layer.

Select either Layer 2 (uses XOR of the physical interface MAC address), or Layer
3+4 (uses IP addresses and Ports).

b. Select the LACP Rate - how frequently the LACP partner should transmit
LACPDUs.

Select either Slow (every thirty seconds), or Fast (every one second).

9 ClickOK.
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Configuring Bond Interfaces in Gaia Clish

In Gaia Clish, bond interfaces are called bonding groups.

Step Description

1 Make sure that the physical slave interfaces do not have IP addresses.

2 Add a new bonding group.

3 Set the state of the physical slave interfaces to UP.

4 Add slave interfaces to the bonding group.

5 Configure the bond operating mode.

6 Configure other bond parameters: primary interface, media monitoring, and delay rate.

7 Examine the bonding group configuration.

8 Save the configuration.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Note - You configure an IP address on a Bonding Group in the same way as you do on
a physical interface (see "Physical Interfaces" on page 82).

Syntax

To add a new Bonding Group

Syntax

add bonding group <Bond Group ID>

Example

gaia> add bonding group 777

Note - Do not change the state of bond interface manually using the "set
interface <Bond ID> state" command. This is done automatically by the
bonding driver.
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To add a new slave interface to an existing Bonding Group

Syntax

add bonding group <Bond Group ID> interface <Name of Slave
Interface>

Important - Make sure that the slave interfaces, which you wish to add to the
Bonding Group, do not have IP addresses.

Example

gaia> add bonding group 777 interface eth4

gaia> add bonding group 777 interface eth5

Notes:

n The slave interfaces must not have IP addresses assigned to
them.

n The slave interfaces must not have aliases assigned to them.

n A bond interface can contain between two and eight slave
interfaces.

To configure an existing Bonding Group

Syntax

set bonding group <Bond Group ID>
mode active-backup [primary <Name of Slave Interface>]
mode round-robin
mode 8023AD [lacp-rate {slow | fast}]
mode xor xmit-hash-policy {layer2 | layer3+4}
[up-delay <0-5000>]
[down-delay <0-5000>]
[monitoring-type {arp <options> | mii <options>}]
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Configuring the Bond Operating Mode

Bond operating mode specifies how slave interfaces are used in a bond interface.

Syntax

set bonding group <Bond Group ID> mode
round-robin
active-backup [primary <Name of Slave Interface>]
xor xmit-hash-policy {layer2 | layer3+4}
8023AD [lacp-rate {slow | fast}]

Example

gaia> set bonding group 1 mode active-backup primary eth2

gaia> set bonding group 2 mode xor xmit-hash-policy layer3+4

Notes:

n The Active-Backup mode supports configuration of the primary slave
interface.

n The XORmode requires the configuration of the transmit hash policy.

n The 8023ADmode supports the configuration of the LACP packet
transmission rate.

Configuring the Up Delay Time

The Up-Delay specifies showmuch time in milliseconds to wait before enabling a slave after link
recovery was detected.

Syntax

set bonding group <Bond Group ID> up-delay <0-5000>

Example

gaia> set bonding group 1 up-delay 100

Note - The default up-interval value is 200 ms.
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Configuring the Down Delay Time

The Down-Delay specifies howmuch time in milliseconds to wait before disabling a slave after link
failure was detected

Syntax

set bonding group <Bond Group ID> down-delay <0-5000>

Example

gaia> set bonding group 1 down-delay 100

Note - The default down-interval value is 200 ms.

Configuring the Bond Monitoring

You can configure the monitoring of the slave interfaces for link-failure.

Syntax

set bonding group <Bridge Group ID> monitoring-type
arp arp-target-ip <IPv4 Address>
mii mii-interval<0-5000>

Example

gaia> set bonding group 1 monitoring-type arp arp-target-ip
192.168.1.1

gaia> set bonding group 1 monitoring-type mii mii-interval 50

Note - The default mii-interval value is 100 ms.
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To delete a slave interface from an existing Bonding Group

Syntax

delete bonding group <Bond Group ID> [interface <Interface Name> |
force-ignore-routes]

Example

gaia> delete bonding group 777 interface eth4

Note - You must delete all non-primary slave interfaces before you remove the
primary slave interface.

To delete the bonding group

Syntax

delete bonding group <Bond Group ID> interface <Name of Slave
Interface 1>

delete bonding group <Bond Group ID> interface <Name of Slave
Interface 2>

delete bonding group <Bond Group ID> interface <Name of Slave
Interface ...>

delete bonding group <Bond Group ID> interface <Name of Slave
Interface N>

delete bonding group <Bond Group ID>

Example

gaia> delete bonding group 777

Notes:

n You must delete all non-primary slave interfaces before you remove the
primary slave interface.

n You must delete all slave interfaces from the bonding group before you
remove the bonding group.

n Do not change the state of bond interface manually using the "set
interface bondID state" command. This is done automatically by the
bonding driver.
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To show the Bonding Group configuration

Syntax

show bonding {group <Bond Group ID> | groups}

Parameters

CLI Parameters

Parameter Description

<Bond Group ID> Configures the Bond Group ID.

n Range: 0 - 1024

n Default:No default value

<Name of Slave
Interface>

Specifies the name of the slave physical interface, which you add
to (or remove from) the bond group.

Make sure that the slave interfaces do not have any IP
addresses or aliases configured.

mode <Mode> Configures the Bond operating mode:

n round-robin:

Bond uses all slave interfaces sequentially (High
Availability + Load Sharing). This is the default mode.

n active-backup [primary <Name of Slave
Interface>]:

Bond uses one slave interface at a time (High Availability)

n xor xmit-hash-policy {layer2 |
layer3+4}:

Bond uses slave interfaces based on a hash function
(High Availability + Load Sharing)

n 8023AD [lacp-rate {slow | fast}]:

Dynamic bonding according to IEEE 802.3ad (Load
Sharing)

primary <Name of Slave
Interface>

Specifies the name of the primary slave interface in the bond.

The first slave interface added to the bond group, becomes the
primary.

Note - Applies only to the active-backup bond mode.
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Parameter Description

up-delay <0-5000> Specifies the time in milliseconds to wait before enabling a slave
after link recovery was detected.

n Range: 0 - 5000 ms

n Default: 200 ms

down-delay <0-5000> Specifies the time in milliseconds to wait before disabling a slave
after link failure was detected.

n Range: 0 - 5000 ms

n Default: 200 ms

lacp-rate {fast |
slow}

Specifies the Link Aggregation Control Protocol packet
transmission rate:

n slow- LACPDU packets are sent every 30 seconds

n fast- LACPDU packets are sent every second

Note - Applies only to the 802.3AD bond mode.

monitoring-type {arp |
mii}

Specifies the Bond monitoring type:

n arp- ARPmonitoring

n mii- Media monitoring

xmit-hash-policy
{layer2 | layer3+4}

Specifies the algorithm to use for assigning the traffic to Active
slave interfaces:

n layer2 - Based on the XOR of hardware MAC addresses

n layer3+4 - Based on the IP addresses and Ports

Note - Applies only to the XOR bond mode.



Configuring Bond Interfaces in Gaia Clish

Gaia R80.40 Administration Guide      |      108

Examples

Example 1 - Configuring Bond in "Active-Backup" mode with default settings

gaia> add bonding group 1
gaia> add bonding group 1 interface eth2
gaia> add bonding group 1 interface eth3
gaia> set bonding group 1 mode active-backup primary eth2
gaia> show bonding group 1
Bond Configuration

xmit-hash-policy Not configured
down-delay 200
primary eth2
monitoring-type Not configured
arp-target-ip Not configured
lacp-rate Not configured
mode active-backup
up-delay 200
mii-interval 100
Bond Interfaces

eth2
eth3

gaia>

Example 2 - Configuring Bond in "XOR" mode with default settings

gaia> add bonding group 1
gaia> add bonding group 1 interface eth2
gaia> add bonding group 1 interface eth3
gaia> set bonding group 1 mode xor xmit-hash-policy layer3+4
gaia> show bonding group 1
Bond Configuration

xmit-hash-policy layer3+4
down-delay 200
primary Not configured
monitoring-type Not configured
arp-target-ip Not configured
lacp-rate Not configured
mode xor
up-delay 200
mii-interval 100
Bond Interfaces

eth2
eth3

gaia>
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Example 3 - Configuring Bond in "XOR" mode with monitoring type "mii"

gaia> add bonding group 1
gaia> add bonding group 1 interface eth2
gaia> add bonding group 1 interface eth3
gaia> set bonding group 1 mode xor xmit-hash-policy layer3+4
gaia> set bonding group 1 monitoring-type mii mii-interval 50
gaia> show bonding group 1
Bond Configuration

xmit-hash-policy layer3+4
down-delay 100
primary Not configured
monitoring-type mii
arp-target-ip 0
lacp-rate Not configured
mode xor
up-delay 100
mii-interval 50
Bond Interfaces

eth2
eth3

gaia>

Example 4 - Configuring Bond in "XOR" mode with monitoring type "arp"

gaia> add bonding group 1
gaia> add bonding group 1 interface eth2
gaia> add bonding group 1 interface eth3
gaia> set bonding group 1 mode xor xmit-hash-policy layer3+4
gaia> set bonding group 1 monitoring-type arp arp-target-ip
192.168.1.1
gaia> show bonding group 1
Bond Configuration

xmit-hash-policy layer3+4
down-delay 0
primary Not configured
monitoring-type arp
arp-target-ip 192.168.1.1
lacp-rate Not configured
mode xor
up-delay 0
mii-interval 0
Bond Interfaces

eth2
eth3

gaia>



Making Sure that Bond Interface is Working

Gaia R80.40 Administration Guide      |      110

Making Sure that Bond Interface is Working

Step Instructions

1 Connect to the command line on the Security Gateway or Cluster Member.

2 Log in to the Expert mode.

3 Examine the Bond interface state and configuration:

[Expert@Gaia:0]# cat /proc/net/bonding/<Bond
Group ID>

Example 1 - output for Bond Operating Mode "Round Robin"

[Expert@Gaia:0]# cat /proc/net/bonding/bond1
Ethernet Channel Bonding Driver: v3.2.4 (January 28, 2008)

Bonding Mode: load balancing (round-robin)
MII Status: up
MII Polling Interval (ms): 100
Up Delay (ms): 200
Down Delay (ms): 200

Slave Interface: eth2
MII Status: up
Link Failure Count: 0
Permanent HW addr: 00:50:56:a3:73:69

Slave Interface: eth3
MII Status: up
Link Failure Count: 0
Permanent HW addr: 00:50:56:a3:73:70
[Expert@Gaia:0]#
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Example 2 - output for Bond Operating Mode "Active-Backup"

[Expert@Gaia:0]# cat /proc/net/bonding/bond1
Ethernet Channel Bonding Driver: v3.2.4 (January 28, 2008)

Bonding Mode: fault-tolerance (active-backup)
Primary Slave: eth2
Currently Active Slave: eth2
MII Status: up
MII Polling Interval (ms): 100
Up Delay (ms): 200
Down Delay (ms): 200

Slave Interface: eth2
MII Status: up
Link Failure Count: 0
Permanent HW addr: 00:50:56:a3:73:69

Slave Interface: eth3
MII Status: up
Link Failure Count: 0
Permanent HW addr: 00:50:56:a3:73:70
[Expert@Gaia:0]#

Example 3 - output for Bond Operating Mode "XOR"

[Expert@Gaia:0]# cat /proc/net/bonding/bond1
Ethernet Channel Bonding Driver: v3.2.4 (January 28, 2008)

Bonding Mode: load balancing (xor)
Transmit Hash Policy: layer2 (0)
MII Status: up
MII Polling Interval (ms): 100
Up Delay (ms): 200
Down Delay (ms): 200

Slave Interface: eth2
MII Status: up
Link Failure Count: 0
Permanent HW addr: 00:50:56:a3:73:69

Slave Interface: eth3
MII Status: up
Link Failure Count: 0
Permanent HW addr: 00:50:56:a3:73:70
[Expert@Gaia:0]#
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Example 4 - output for Bond Operating Mode "802.3ad"

[Expert@Gaia:0]# cat /proc/net/bonding/bond1
Ethernet Channel Bonding Driver: v3.2.4 (January 28, 2008)

Bonding Mode: IEEE 802.3ad Dynamic link aggregation
Transmit Hash Policy: layer2 (0)
MII Status: up
MII Polling Interval (ms): 100
Up Delay (ms): 200
Down Delay (ms): 200

802.3ad info
LACP rate: slow

Slave Interface: eth2
MII Status: up
Link Failure Count: 0
Permanent HW addr: 00:50:56:a3:73:69
Aggregator ID: 1

Slave Interface: eth3
MII Status: up
Link Failure Count: 0
Permanent HW addr: 00:50:56:a3:73:70
Aggregator ID: 1
[Expert@Gaia:0]#
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Configuring Bond High Availability in VRRP Cluster

The R80.20 version introduced an improved Active/Backup Bond mechanism (Enhanced Bond) when
working in ClusterXL.

If you work with ClusterXL, the Enhanced Bond feature is enabled by default, and no additional
configuration is required.

If you change your cluster configuration from ClusterXL to VRRP (MCVR &VRRP), or configure the VRRP
(MCVR &VRRP) cluster from scratch, the Enhanced Bond feature is disabled by default.

If you change your cluster configuration from VRRP to ClusterXL, you must manually enable the Enhanced
Bond feature.

To enable the Enhanced Bond feature in VRRPCluster, set the value of the kernel parameter fwha_
bond_enhanced_enable to 1 on each VRRPCluster Member. You can set the value of the kernel
parameter temporarily, or permanently.

Setting the value of the kernel parameter temporarily

Important - This change does not survive reboot.

Step Description

1 Connect to the command line on each VRRPCluster Member.

2 Log in to the Expert mode.

3 Set the value of the kernel parameter fwha_bond_enhanced_enable to 1:

fw ctl set int fwha_bond_enhanced_enable 1

4 Make sure the value of the kernel parameter fwha_bond_enhanced_enable was set to
1:

fw ctl get int fwha_bond_enhanced_enable
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Setting the value of the kernel parameter permanently

Step Description

1 Connect to the command line on eachCluster Member.

2 Log in to the Expert mode.

3 Back up the current $FWDIR/boot/modules/fwkern.conf file:

cp -v $FWDIR/boot/modules/fwkern.conf{,_BKP}

4 Edit the current $FWDIR/boot/modules/fwkern.conf file:

vi $FWDIR/boot/modules/fwkern.conf

5 Add this line to the file (spaces and comments are not allowed):

fwha_bond_enhanced_enable=1

6 Save the changes in the file and exit the editor.

7 Reboot the Cluster Member.

8 Make sure the value of the kernel parameter fwha_bond_enhanced_enable was set to
1:

fw ctl get int fwha_bond_enhanced_enable

Important - If you change your cluster configuration from VRRP to ClusterXL, you must
remove the kernel parameter configuration from each Cluster Member.
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Bridge Interfaces
Configure interfaces as a bridge to deploy security devices in a topology without reconfiguration of the IP
routing scheme. This is an important advantage for large-scale, complex environments.

Bridge interfaces connect two different interfaces (bridge ports). Bridging two interfaces causes every
Ethernet frame that is received on one bridge port to be transmitted to the other port. Thus, the two bridge
ports participate in the same Broadcast domain (different from router port behavior). The security policy
inspects every Ethernet frame that passes through the bridge.

Important - Only two interfaces can be connected by one Bridge interface, creating a
virtual two-port switch. Each port can be a physical, VLAN, or bond device.

You can configure bridge mode with one Security Gateway or with a Cluster. The bridge functions without
an assigned IP address. Bridged Ethernet interfaces (including aggregated interfaces) to work like ports on
a physical bridge. You can configure the topology for the bridge ports in SmartConsole. A separate
network or group object represents the networks or subnets that connect to each port.

Notes:

n Gaia OS supports bridge interfaces that implement native, Layer 2 bridging.

n Gaia OS does not support Spanning Tree Protocol (STP) bridges.

n A slave interface that is a part of a bond interface cannot be a part of a bridge
interface.

The bridge interfaces send traffic with Layer 2 addressing. On the same device, you can configure some
interfaces as bridge interfaces, while other interfaces work as Layer 3 interfaces. Traffic between bridge
interfaces is inspected at Layer 2. Traffic between two Layer 3 interfaces, or between a bridge interface
and a Layer 3 interface is inspected at Layer 3.
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Configuring Bridge Interfaces in Gaia Portal

Note - For additional information, see the R80.40 Installation and UpgradeGuide >
Chapter Special Scenarios for Security Gateways > Section Deploying a Security
Gateway or a ClusterXL in BridgeMode.

Step Description

1 With a web browser, connect to Gaia Portal at:

https://<IP address of Gaia Management Interface>

2 In the left navigation tree, clickNetwork Management >Network Interfaces.

3 Make sure that the slave interfaces, which you wish to add to the Bridge interface, do not have
IP addresses assigned.

4 Click Add >Bridge.

To configure an existing Bridge interface, select the Bridge interface and click Edit.

5 On the Bridge tab, enter or select a Bridge Group ID (unique integer between 1 and 1024).

6 Select the interfaces from the Available Interfaces list and then click Add.

Notes:

n Make sure that the slave interfaces do not have any IP addresses or aliases
configured.

n Do not select the interface that you configured as Gaia Management Interface.

n ABridge interface in Gaia can contain only two slave interfaces.

7 On the IPv4 tab, enter the IPv4 address and subnet mask.

You can optionally select theObtain IPv4 Address automatically option.

8 On the IPv6 tab (optional), enter the IPv6 address and mask length.

You can optionally select theObtain IPv6 Address automatically option.

Important - First, you must enable the IPv6 Support and reboot (see "System
Configuration" on page 247).

9 ClickOK.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
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Configuring Bridge Interfaces in Gaia Clish

Note - For additional information, see the R80.40 Installation and UpgradeGuide >
Chapter Special Scenarios for Security Gateways > Section Deploying a Security
Gateway or a ClusterXL in BridgeMode.

In Gaia Clish, bond interfaces are called bridging groups.

Note - You configure an IP address on a Bridging Group in the same way as you do on
a physical interface (see "Physical Interfaces" on page 82).

Procedure

Step Description

1 Connect to the command line on the Security Gateway.

2 Log in to Gaia Clish.

3 Make sure that the slave interfaces, which you wish to add to the Bridge interface, do not have
IP addresses assigned:

show interface <Name of Slave Interface> ipv4-address

show interface <Name of Slave Interface> ipv6-address

4 Add a new bridging group:

add bridging group <Bridge Group ID 0 - 1024>

Note - Do not change the state of bond interface manually using the "set
interface <Bridge Group ID> state" command. This is done
automatically by the bridging driver.

5 Add slave interfaces to the new bridging group:

add bridging group <Bridge Group ID> interface <Name of First
Slave Interface>

add bridging group <Bridge Group ID> interface <Name of Second
Slave Interface>

Notes:

n Do not select the interface that you configured as Gaia Management Interface.

n Only Ethernet, VLAN, and Bond interfaces can be added to a bridge group.

n ABridge interface in Gaia can contain only two slave interfaces.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
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Step Description

6 Assign an IP address to the bridging group.

Note - You configure an IP address on a Bridging Group in the same way as you do on
a physical interface (see "Physical Interfaces" on page 82).

n To assign an IPv4 address, run:

set interface <Name of Bridging Group> ipv4-address <IPv4
Address> {subnet-mask <Mask> | mask-length <Mask Length>}

You can optionally configure the bridging group to obtain an IPv4 Address automatically.

n To assign an IPv6 address, run:

set interface <Name of Bridging Group> ipv6-address <IPv6
Address> mask-length <Mask Length>

You can optionally configure the bridging group to obtain an IPv6 Address automatically.

Important - First, you must enable the IPv6 Support and reboot (see "System
Configuration" on page 247).

7 Save the configuration:

save config

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Syntax

To add a new bridging group

Syntax

add bridging group <Bridge Group ID>

Note - Do not change the state of bond interface manually using the "set
interface <Bridge Group ID> state" command. This is done
automatically by the bridging driver.
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To add a new slave interface to an existing bridging group

Syntax

add bridging group <Bridge Group ID> interface <Name of Slave
Interface>

Example

gaia> add bridging group 56 interface eth1

Note - Make sure that the slave interfaces do not have any IP addresses or aliases
configured.

To add a fail-open interface to an existing bridging group

Syntax

add bridging group <Bridge Group ID> fail-open-interfaces <Name of
Slave Interface>

To configure an existing Bridging Group

Syntax

set interface <Name of Bridge Interface>
comments "Text"
ipv4-address <IPv4 Address>

subnet-mask <Mask>
mask-length <Mask Length>

ipv6-address <IPv6 Address> mask-length <Mask Length>
ipv6-autoconfig {on | off}
mac-addr <MAC Address>
mtu <68-16000 | 1280-16000>
rx-ringsize <0-4096>
tx-ringsize <0-4096>

Example

gaia> set interface br1 ipv6-address 3000:40::1 mask-length 64
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To delete a slave interface from an existing bridging group

Syntax

delete bridging group <Bridge Group ID> interface <Name of Slave
Interface>

Example

gaia> delete bridging group 56 interface eth1

To delete a fail-open interface from the bridging group

Syntax

delete bridging group <Bridge Group ID> fail-open-interfaces <Name
of Slave Interface>

To delete the bridging group

Syntax

delete bridging group <Bridge Group ID>

Notes:

n You must delete all slave interfaces from the bridging group before you
delete the bridging group.

n Do not change the state of bond interface manually using the "set
interface <Bridge Group ID> state" command. This is done
automatically by the bridging driver.

Example

gaia> delete bridging group 56

To show the slave interfaces of an existing bridging group

Syntax

show bridging group <Bridge Group ID>

To show the configured bridging groups

Syntax

show bridging groups
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Parameters

CLI Parameters

Parameter Description

<Bridge Group ID> Configures the Bridge Group ID.

n Range: 0 - 1024

n Default:No default value

<Name of Bridge
Interface>

Configures the name of the Bridge interface.

<Name of Slave
Interface>

Specifies a physical slave interface.

comments "Text" Configures an optional free text comment.

n Write the text in double-quotes.

n Text must be up to 100 characters.

n This comment appears in the Gaia Portal and in the output of
the show configuration command.

ipv4-address <IPv4
Address>

Configures the IPv4 address.

ipv6-address <IPv6
Address>

Configures the IPv6 address.

Important - First, you must enable the IPv6 Support and
reboot (see "SystemConfiguration" on page 247).

subnet-mask <Mask> Configures the IPv4 subnet mask using dotted decimal notation
(X.X.X.X).

mask-length <Mask
Length>

Configures the IPv4 or IPv6 subnet mask length using the CIDR
notation (integer between 2 and 32).

ipv6-autoconfig
{on | off}

Configures if this interface gets an IPv6 address from a DHCPv6
Server:

n on - Gets an IPv6 address from a DHCPv6 Server

n off - Does not get an IPv6 address from a DHCPv6 Server (you
must assign it manually)

Important - First, you must enable the IPv6 Support and
reboot (see "SystemConfiguration" on page 247).
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Parameter Description

mac-addr <MAC
Address>

Configures the hardware MAC address.

mtu <68-16000 |
1280-16000>

Configures the Maximum Transmission Unit size for an interface.

For IPv4:

n Range: 68 - 16000 bytes

n Default: 1500 bytes

For IPv6:

n Range: 1280 - 16000 bytes

n Default: 1500 bytes

rx-ringsize <0-
4096>

Configures the receive buffer size.

n Range: 0 - 4096 bytes

n Default: 4096 bytes

tx-ringsize <0-
4096>

Configures the transmit buffer size.

n Range: 0 - 4096 bytes

n Default: 4096 bytes

Example

gaia> add bridging group 56 interface eth1
gaia> set interface br1 ipv6-address 3000:40::1 mask-length 64
gaia> show bridging groups
gaia> delete bridging group 56 interface eth1
gaia> delete bridging group 56
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Accept, or Drop Ethernet Frames with Specific Protocols

Important - In Cluster, you must configure all the Cluster Members in the same way

By default, Security Gateway and Cluster in Bridge mode allowsEthernet frames that carry protocols other
than IPv4 (0x0800), IPv6 (0x86DD), or ARP (0x0806) protocols.

Administrator can configure a Security Gateway and Cluster in Bridge mode to either accept, or drop
Ethernet frames that carry specific protocols.

When Access Mode VLAN (VLAN translation) is configured, BPDU frames can arrive with the wrong VLAN
number to the switch ports through the Bridge interface. This mismatch can cause the switch ports to enter
blocking mode.

In Active/Standby Bridge Mode only, you can disable BPDU forwarding to avoid such blocking mode:

Step Description

1 Connect to the command line on the Security Gateway (each Cluster Member).

2 Log in to the Expert mode.

3 Backup the current /etc/rc.d/init.d/network file:

cp -v /etc/rc.d/init.d/network{,_BKP}

4 Edit the current /etc/rc.d/init.d/network file:

vi /etc/rc.d/init.d/network

5 After the line:

./etc/init.d/functions

Add this line:

/sbin/sysctl -w net.bridge.bpdu_forwarding=0

6 Save the changes in the file and exit the Vi editor.

7 Reboot the Security Gateway (each Cluster Member).

8 Make sure the new configuration is loaded:

sysctl net.bridge.bpdu_forwarding

The output must show:

net.bridge.bpdu_forwarding = 0
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Loopback Interfaces
In This Section:

Configuring Loopback Interfaces in Gaia Portal 124

Configuring Loopback Interfaces in Gaia Clish 126

You can define a virtual loopback interface by assigning an IPv4 or IPv6 address to the lo (local) interface.
This can be useful for testing purposes or as a proxy interface for an unnumbered interface. This section
shows you how to configure a loopback interface using the Gaia Portal and the Gaia Clish.

Configuring Loopback Interfaces in Gaia Portal

To add a loopback interface

Step Description

1 In the navigation tree, click Interface Management >Network Interfaces.

2 Click Add > Loopback.

3 In the Add loopback window:

1. The Enable option is selected by default to set the loopback interface status
to UP.

2. In the Comment field, enter the applicable comment text (up to 100
characters).

3. On the IPv4 tab, enter the IPv4 address and subnet mask.

These IPv4 addresses are not allowed:

n 0.x.x.x

n 127.x.x.x

n 224.x.x.x - 239.x.x.x (Class D)

n 240.x.x.x - 255.x.x.x (Class E)

n 255.255.255.255

4. On the IPv6 tab (optional), enter the IPv6 address and mask length.

Important - First, you must enable the IPv6 Support and reboot
(see "SystemConfiguration" on page 247).

4 ClickOK.

Note - The new loopback interface name is automatically created with the addition
of a sequence number to the string 'loop'. For example, the name of first loopback
interface is loop00. The second loopback interface is loop01, and so on.
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To configure a loopback interface

Step Description

1 In the navigation tree, click Interface Management >Network Interfaces.

2 Select a loopback interface and click Edit.

3 In the Edit loop<NN> window:

1. If required, change the IPv4 address and subnet mask.

2. If required, change the IPv6 address and mask length.

4 ClickOK.

To delete a loopback interface

Step Description

1 In the navigation tree, clickNetwork Management >Network Interfaces.

2 Select a loopback interface and clickDelete.

3 ClickOK, when the confirmation message shows.
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Configuring Loopback Interfaces in Gaia Clish

Syntax

To add a loopback interface

add interface lo loopback <IPv4 Address>/<Mask Length>

Note - When you create a new loopback interface, Gaia automatically assigns a
name in the format loopXX, where XX is a sequence number starting from 00.

To configure a loopback interface

set interface <Name of Loopback Interface> {ipv4-address <options> |
ipv6-address <options>}

Note - You can only change IPv4 or IPv6 address on a loopback interface.

To show a loopback interface

show interface<SPACE><TAB>

show interface <Name of Loopback Interface>

To delete a loopback interface

delete interface lo loopback <Name of Loopback Interface>

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

CLI Parameters

Parameter Description

lo You must use the lo (local interface) keyword to define a loopback
interface
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Parameter Description

<IPv4 Address> Specifies the IPv4 address

These IPv4 addresses are not allowed:

n 0.x.x.x

n 127.x.x.x

n 224.x.x.x - 239.x.x.x (Class D)

n 240.x.x.x - 255.x.x.x (Class E)

n 255.255.255.255

<Mask Length> Configures the IPv4 subnet mask length using the CIDR notation
(integer between 2 and 32)

<Name of Loopback
Interface>

Specifies a loopback interface name

Example

gaia> add interface lo loopback 10.10.99.1/24

gaia> delete interface lo loopback loop01
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VPN Tunnel Interfaces
Virtual Tunnel Interface (VTI) is a virtual interface that is a member of an existing, Route-Based, VPN
tunnel. Each peer Security Gateway has one VTI that connects to the tunnel.

The VPN tunnel and its properties are defined by the VPN community that contains the two Security
Gateways.

You must define the VPN community and its member Security Gateways before you can create a VTI.

To learn more about Route Based VPN, see the R80.40 Site to Site VPN Administration Guide > Chapter
Route Based VPN.

Procedure:

1. Make sure that the IPsec VPN Software Blade is enabled on the applicable Security Gateways.

2. Create and configure the Security Gateways.

3. Define the VPN community in SmartConsole that includes the two peer Security Gateways.

Configuring VPN community

You must define the VPNCommunity and add the member Security Gateways to it before you
configure a VPN Tunnel Interface. This section includes the basic procedure for defining a Site-
to-Site VPNCommunity. To learn more about VPN communities and their definition procedures,
see the R80.40 Site to Site VPN Administration Guide.

Step Description

1
In SmartConsole, click the VPNCommunities tab in the navigation tree.

2 Right-click Site To Site and selectNew Site To Site >Meshed or Star.

3 In the Community Properties windowGeneral tab, enter the VPN community name.

4 Select Accept all encrypted traffic.

This option automatically adds a rule to encrypt all traffic between Security Gateways
in a VPN community.

5 On the Participating Gateways tab, select member Security Gateways from the list.

For Star VPN communities, use the Center Gateway and Satellite Gateway tabs to
do this.

6 Configure other VPN community parameters as necessary.

7 Publish the SmartConsole session.

4. Make Route Based VPN the default option.

Do this procedure one time for each.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SitetoSiteVPN_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SitetoSiteVPN_AdminGuide/Default.htm
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Configuring Route Based VPN

When Domain Based VPN and Route Based VPN are defined for a Security Gateway, Domain
Based VPN is active by default. You must do two short procedures to make sure that Route
Based VPN is always active.

The first procedure defines an empty encryption domain group for your VPN peer Security
Gateways. You do this step one time for each Security Management Server. The second step is
to make Route Based VPN the default option for all Security Gateways.

To define an empty group

Step Description

1 In the SmartConsole, clickObjects menu > More object types > Network Object
> Group > clickNew Network Group.

2 Enter a group name.

3 Do not add members to this group.

4 ClickOK.

To make Route Based VPN the default choice

Do these steps for each Security Gateway.

Step Description

1 In SmartConsole, double-click the applicable Security Gateway.

2 In theGateway pane, click Topology.

3 In the VPN Domain section, selectManually define and then select the empty
group you created earlier.

4 Install the Access Policy.

5. Define the VTI.

You can configure the VPN Tunnel Interfaces (VTI) in Gaia Portal or Gaia Clish.

Configuring VTI in Gaia Portal

Step Description

1 In the Gaia Portal, selectNetwork Management >Network Interfaces.

2 Click Add >VPN Tunnel.

To configure an existing VTI interface, select the VTI interface and click Edit.
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Step Description

3 In the Add/Editwindow, configure these parameters:

n VPN Tunnel ID - Unique tunnel name (integer from 1 to 99).

Gaia automatically adds the prefix "vpnt" to the Tunnel ID.

n Remote Peer Name - Alphanumeric character string as defined for the Remote
Peer Name in the VPN community.

You must define the two peers in the VPN community before you can define the
VTI.

n VPN Tunnel Type - SelectNumbered or Unnumbered.

n Local Address - Defines the local peer IPv4 address. Applies to the Numbered
VTI only.

n Remote Address - Defines the remote peer IPv4 address. Applies to the
Numbered VTI only.

n Physical Device - Local peer interface name. Applies to the Unnumbered VTI
only.

Configuring VTI in Gaia Clish
Syntax

n To add a VPN Tunnel Interface (VTI):

add vpn tunnel <Tunnel ID>
type

numbered local <Local IP address> remote
<Remote IP address> peer <Peer Name>

unnumbered peer <Peer Name> dev <Name of
Local Interface>

n To see the configuration of the specific VPN Tunnel Interface (VTI):

show vpn tunnel <Name of VTI>

n To see the configured VPN Tunnel Interfaces (VTIs):

show vpn tunnels

n To delete a VPN Tunnel Interface (VTI):

delete vpn tunnel <Tunnel ID>

Important - After you add, configure, or delete features, run the "save
config" command to save the settings permanently.
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CLI Parameters

Parameter Description

<Tunnel ID> Defines the unique Tunnel ID (integer from 1 to 99).

Gaia automatically adds the prefix 'vpnt' to the Tunnel ID.

Example: vnpt10

type numbered Defines a numbered VTI that uses a specified, static IPv4
addresses for local and remote connections.

type unnumbered Defines an unnumbered VTI that uses the interface and the
remote peer name to get addresses.

local <Local IP
address>

Defines the local peer IPv4 address in dotted decimal format
(numbered VTI only).

remote <Remote IP
address>

Defines the remote peer IPv4 address in dotted decimal format
(numbered VTI only).

peer <Peer Name Specifies the name of the remote peer as defined in the VPN
community.

You must define the two peers in the VPN community before
you can define the VTI.

The Peer Name is an alphanumeric character string.

dev <Name of
Local Interface>

Defines the name of the local interface (unnumbered VTI only).

Example

gaia> add vpn tunnel 20 type numbered local 10.10.10.1 remote
20.20.20.1 peer MyPeer

gaia> add vpn tunnel 10 type unnumbered peer MyPeer dev eth1

gaia> show vpn tunnels

gaia> delete vpn tunnel 10

6. Define Route Based VPNRules.

Configuring Route Based VPN Rules

To make sure that your security rules work correctly with Route Based VPN traffic, you must add
directional matching conditions and allow OSPF traffic.

(A) Defining Directional Matching VPN Rules

This section contains the procedure for defining directional matching rules. Directional
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matching is necessary for Route Based VPNwhen a VPN community is included in the VPN
column in the rule. This is because without bi-directional matching, the rule only applies to
connections between a community and an encryption domain (Domain Based Routing).

Name Source Destination VPN Service Action

VPN Tunnel Any Any MyIntranet Any Accept

The directional rule must contain these directional matching conditions:

n Community > Community

n Community > Internal_Clear

n Internal_Clear > Community

Name Source Destination VPN Service Action

VPN
Tunnel

Any Any MyIntranet >
MyIntranet

MyIntranet >
Internal_Clear

Internal_Clear >
MyIntranet

Any Accept

Notes:

n MyIntranet is the name of a VPNCommunity.

n Internal_Clear refers to all traffic from IP addresses to and from the
specified VPN community.

n It is not necessary to define bidirectional matching rules if the VPN
column contains the value Any.

To enable VPN directional matching

Step Description

1 In SmartConsole, clickMenu >Global properties> expand VPN >Advanced.

2 Select the Enable VPN Directional Match in VPN Column option.

3 In SmartConsole, double-click each member gateway and click the Topology
page.

a. ClickGet > Interfaces with Topology to update the topology to include the
newly defined VTIs.

b. Click Accept.

c. ClickOK.
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To define a VPN directional matching rule

Step Description

1 Double-click the VPN cell in the applicable rule.

2 In the VPN Match Conditions window, selectMatch traffic in this direction
only.

3 Click Add to define sets of matching conditions.

4 In the Direction VPN Match Conditionwindow, select the source and
destination matching conditions.

Do this step for each set of matching conditions.

(B) Defining Rules to Allow OSPF Traffic

One advantage of Route Based VPN is the fact that you can use dynamic routing protocols to
distribute routing information between Security Gateways.

The OSPF (Open Shortest Path First) protocol is commonly used with VTIs.

To learn about configuring OSPF, see the R80.40Gaia Advanced Routing Administration
Guide.

Step Description

1 In the Gaia Portal or Gaia Clish, add the applicable VPN Tunnel Interfaces to the
OSPF configuration page.

2 In SmartConsole, add an Access Control rule that allows traffic to the VPN
community (or all communities) that uses the OSPF service:

Name Source Destination VPN Service Action

Allow OSPF for
a VPN
Community

Any Any MyIntranet ospf Accept

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_Advanced_Routing_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_Advanced_Routing_AdminGuide/Default.htm
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7. Save the configuration and install the policy.

Instructions

You must save your configuration to the database and install policies to the Security Gateways
before the VPN can be fully functional.

Step Description

1 Save the configuration to the database.

2 Install the policy on the Security Gateways.

3 Make sure that the VTI tunnel and the rules are working correctly.
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Gaia Management Interface
This section shows you how to select the Gaia Management Interface.

This is the main interface, through which you connect to Gaia Operating System.

Note - You selected this interfaces during the Gaia First Time Configuration Wizard.

Selecting Management Interface in Gaia Portal

Procedure

Step Description

1 In the navigation tree, clickNetwork Management >Network Interfaces.

2 In the sectionManagement Interface, click Set Management Interface.

You can see the name of the current Management Interface above this button.

3 In theManagement Interface field, select an interface.

4 ClickOK.

Selecting Management Interface in Gaia Clish

Syntax

To see the current interface

show management interface

To select a new interface

set management interface <Name of Interface>

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

CLI Parameters

Parameter Description

<Name of
Interface>

Specifies the name of the interface, on which to create an alias IPv4
address

Example

gaia> show management interface

gaia> set management interface eth2
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CLI Reference (interface)
This section summarizes the Gaia Clish interface command and its parameters.

Note - There are some command options and parameters that you cannot configure in
the Gaia Portal.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Description

Add, configure, and delete interfaces and interface properties.

Syntax

To add an interface

add interface <Name of Interface>
6in4 <6in4 Tunnel ID> remote <IPv4 Address> [ttl <Time>]
alias <IPv4 Address>/<Mask Length>
loopback <IPv4 Address>/<Mask Length>
vlan <VLAN ID>

To configure an interface

set interface <Name of Interface>
auto-negotiation {on | off}
comments "Text"
ipv4-address <IPv4 Address>

mask-length <Mask Length>
subnet-mask <Mask>

ipv6-address <IPv6 Address> mask-length <Mask Length>
ipv6-autoconfig {on | off}
link-speed

10M/half
10M/full
100M/half
100M/full
1000M/full

mac-addr <MAC Address>
monitor-mode {on | off}
mtu <68-16000 | 1280-16000>
rx-ringsize <0-4096>
state {on | off}
tx-ringsize <0-4096>

To show an interface

show interface<SPACE><TAB>

show interfaces all
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To delete an interface, or interface configuration

delete interface <Name of Interface>
6to4 <6in4 Tunnel ID>
alias <IPv4 Address>
ipv4-address <IPv4 Address>
ipv6-address <IPv6 Address>
loopback <IPv4 Address>/<Mask Length>
vlan <VLAN ID>

To work with Gaia Management Interface

show management interface

set management interface <Name of Interface>
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ARP
The Address Resolution Protocol (ARP) allows a host to find the physical address of a target host on the
same physical network using only the target's IP address.

ARP is a low-level protocol that hides the underlying network physical addressing and permits assignment
of an arbitrary IP address to every machine.

ARP is considered part of the physical network system and not as part of the Internet protocols.
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Configuring ARP in Gaia Portal
To show dynamic ARP entries

Step Description

1 In the navigation tree, clickNetwork Management > ARP.

2 In the upper right corner, click theMonitoring tab.

To show static ARP entries

Step Description

1 In the navigation tree, clickNetwork Management > ARP.

2 In the upper right corner, click the Configuration tab.

To change static and dynamic ARP parameters

Step Description

1 In the navigation tree, clickNetwork Management > ARP.

2 In the upper right corner, click the Configuration tab.

3 In the ARP Table Settings section:

a. Enter theMaximum Entries.

This is the maximal number of entries in the ARP cache.

Range: 1024 - 16384 entries

Default: 4096 entries

Note - Make sure to configure a value large enough to accommodate at
least 100 dynamic entries, in addition to the maximum number of static
entries.

b. Enter the Validity Timeout.

This is the time, in seconds, to keep resolved dynamic ARP entries.

If the entry is not referred to and is not used by traffic before the time elapses, it is
deleted.

Otherwise, a request is sent to verify the MAC address.

Range: 60 - 86400 seconds (24 hours)

Default: 60 seconds
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To add a static ARP entry

Step Description

1 In the navigation tree, clickNetwork Management > ARP.

2 In the upper right corner, click the Configuration tab.

3 In the Static ARP Entries section, click Add.

4 Enter the IP Address of the static ARP entry and theMAC Address used when forwarding
packets to the IP address.

5 ClickOK.

To delete a static ARP entry

Step Description

1 In the navigation tree, clickNetwork Management > ARP.

2 In the upper right corner, click the Configuration tab.

3 In the Static ARP Entries section, select a Static ARP entry.

4 ClickRemove.

To delete all dynamic ARP entries

Step Description

1 In the navigation tree, clickNetwork Management > ARP.

2 In the upper right corner, click theMonitoring tab.

3 Click Flush All.
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Configuring ARP in Gaia Clish

Syntax

To add a static ARP entry

add arp static ipv4-address <IPv4 Address> macaddress <MAC Address>

To delete static and dynamic ARP entries

delete arp
dynamic all
static ipv4-address <IPv4 Address>

To configure ARP table parameters

set arp table
validity-timeout <Seconds>
cache-size <Number of Entries>

To show ARP table parameters

show arp
dynamic all
static all
table validity-timeout
table cache-size

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

CLI Parameters

Parameter Description

static Configures static ARP entries.

dynamic Configures dynamic ARP entries.

ipv4-address <IPv4
Address>

Configures IPv4 Address for a static ARP entry.

n Range:Dotted-quad ([0-255].[0-255].[0-255].[0-255])

n Default:No default value
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Parameter Description

macaddress Configures the hardware MAC address (six hexadecimal octets
separated by colons) for a static ARP entry.

n Range: 00:00:00:00:00:00 - FF:FF:FF:FF:FF:FF

n Default:No default value

table validity-
timeout <Seconds>

Configures the time, in seconds, to keep resolved dynamic ARP entries
in the ARP cache table.

If the entry is not referred to and is not used by traffic before this time
elapses, the dynamic ARP entry is deleted from the ARP cache table.

Otherwise, an ARPRequest will be sent to verify the MAC address.

n Range: 60 - 86400 seconds (24 hours)

n Default: 60 seconds

table cache-size
<Number of
Entries>

Configures the maximal number of entries in the ARP cache table.

n Range: 1024 - 16384

n Default: 4096

Note - Make sure to configure a value large enough to
accommodate at least 100 dynamic ARP entries, in addition
to the maximum number of static ARP entries.
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DHCP Server
You can configure the Gaia device to be a Dynamic Host Configuration Protocol (DHCP) server.

The DHCP server gives IP addresses and other network parameters to network hosts.

DHCPmakes it unnecessary to configure each host manually, and therefore reduces configuration errors.

You configure DHCP server subnets on the Gaia device interfaces.

A DHCP subnet allocates these network parameters to hosts behind the Gaia interface:

n IPv4 address

n Default Gateway (optional)

n DNS parameters (optional):

l Domain name

l Primary, secondary and tertiary DNS servers

Allocating DHCP parameters to hosts (for the details, see the next section)

Workflow

Step Description

1 To define a DHCP subnet on a Gaia interface:

a. Enable DHCPServer on the Gaia network interface.

b. Define the network IPv4 address of the subnet on the interface.

c. Define an IPv4 address pool.

d. Optional:Define routing and DNS parameters for DHCP hosts.

2 Define additional DHCP subnets on other Gaia interfaces, as needed.

3 Enable the DHCPServer process for all configured subnets.

4 Configure the network hosts to use the Gaia DHCP server.



Configuring a DHCP Server in Gaia Portal

Gaia R80.40 Administration Guide      |      145

Configuring a DHCP Server in Gaia Portal
To allocate DHCP parameters to hosts

Step Description

1 In the navigation tree, clickNetwork Management >DHCP Server.

2 In the DHCP Server Subnet Configuration section, click Add.

The Add DHCP window opens.

You now define a DHCP subnet on an Ethernet interface of the Gaia device.

Hosts behind the Gaia interface get IPv4 addresses from address pools in the subnet.

3 Select Enable DHCP to enable DHCP for the subnet you will configure.

4 On the Subnet tab:

Define the DHCP offer and lease settings:

In the Network IP Address field, enter the IPv4 address of the applicable interface's subnet.

In the Subnet mask field, enter the subnet mask.

Note - To do this automatically, clickGet from interface and select the applicable
interface. ClickOK.

In the Address Pool section, click Add to define the range of IPv4 addresses that the server
assigns to hosts.

a. In the Type field, select Include or Exclude.

This specifies whether to include or exclude this range of IPv4 addresses in the IP
pool.

b. In the Status field, select Enable ofDisable.

This enables or disables the DHCPServer for this subnet, or the DHCPServer
process (depending on the context).

c. In the Start field, enter the first IPv4 address of the range.

d. In the End field, enter the last IPv4 address of the range.

e. ClickOK.

Optional: In the Lease Configuration section, configure the DHCP lease settings:

a. In the Default lease field, enter the default lease time (in seconds), for host IPv4
addresses. This applies only if DHCP clients do not request a unique lease time. The
default is 43,200 seconds.

b. In theMaximum Lease field, enter the maximal lease time (in seconds), for host IPv4
addresses. The default is 86,400 seconds.
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Step Description

5 Optional:On the Routing & DNS tab, define routing and DNS parameters for DHCP clients:

n In the Default Gateway field, enter the IPv4 address of the default gateway for the
DHCP clients.

n In the Domain Name field, enter the domain name for the DHCP clients (for example,
example.com).

n In the Primary DNS Server field, enter the IPv4 address of the Primary DNS server
for the DHCP clients.

n In the Secondary DNS Server field, enter the IPv4 address of the Secondary DNS
server for the DHCP clients (to use if the primary DNS server does not respond).

n In the Tertiary DNS Server field, enter the IPv4 address of the Tertiary DNS server
for the DHCP clients (to use if the primary and secondary DNS servers do not
respond).

6 ClickOK.

7 Optional:Define DHCP subnets on other Gaia interfaces, as needed.

8 In the DHCP Server Configuration section, select Enable DHCP Server and click Apply.

9 The DHCP server on Gaia is now configured and enabled.

You can now configure your network hosts to get their network parameters from the DHCP
server on Gaia.

To change DHCP parameters in a subnet

Step Description

1 In the navigation tree, clickNetwork Management >DHCP Server.

2 In the DHCP Server Subnet Configuration section, select the Subnet and click Edit.

3 Change the applicable settings.

4 ClickOK.

To disable DHCP server on all interfaces

Step Description

1 In the navigation tree, clickNetwork Management >DHCP Server.

2 In the DHCP Server Configuration section, clear the Enable DHCP Server.

3 Click Apply.
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To delete DHCP subnet

Step Description

1 In the navigation tree, clickNetwork Management >DHCP Server.

2 In the DHCP Server Subnet Configuration section, select the Subnet and clickDelete.

3 ClickOK to confirm.

Note - Before you delete the last DHCP subnet, you must disable DHCP server on
all interfaces.
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Configuring a DHCP Server in Gaia Clish

Syntax

To add a DHCP Server subnet

add dhcp server subnet <Subnet Entry>
netmask <Mask>
include-ip-pool start <First IPv4 Address> end <Last IPv4

Address>
exclude-ip-pool start <First IPv4 Address> end <Last IPv4

Address>

To configure a DHCP Server subnet

set dhcp server subnet <Subnet Entry>
enable
disable
include-ip-pool <First IPv4 Address-Last IPv4 Address> {enable

| disable}
exclude-ip-pool <First IPv4 Address-Last IPv4 Address> {enable

| disable}
default-lease <Lease in Seconds>
max-lease <Maximal Lease in Seconds>
default-gateway <Gateway IPv4 Address>
domain <Domain Name for the DHCP Clients>
dns <DNS Server IPv4 Address>

To delete a DHCP Server subnet

delete dhcp server subnet <Subnet Entry>
include-ip-pool <First IPv4 Address-Last IPv4 Address>
exclude-ip-pool <First IPv4 Address-Last IPv4 Address>

To enable or disable the DHCP Server process

set dhcp server {enable | disable}

To show DHCP Server configuration

show dhcp server
all
status
subnet <Subnet Entry> ip-pools
subnets

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

CLI Parameters

Parameter Description

subnet <Subnet Entry> Specifies the IPv4 address of the DHCP subnet on an Ethernet
interface of the Gaia device. Hosts behind the Gaia interface get
IPv4 addresses from address pools in the subnet.

For example: 192.0.2.0

netmask <Mask> Specifies the IPv4 subnet mask in CIDR notation.

For example: 24

include-ip-pool start
<First IPv4 Address>
end <Last IPv4
Address>

Specifies the IPv4 address that starts and the IPv4 address that
ends the included allocated IP Pool range.

For example: 192.0.2.20 and 192.0.2.90

exclude-ip-pool start
<First IPv4 Address>
end <Last IPv4
Address>

Specifies the IPv4 address that starts and the IPv4 address that
ends the excluded allocated IP Pool range.

For example: 192.0.2.155 and 192.0.2.254

include-ip-pool <First
IPv4 Address-Last IPv4
Address>

Specifies the range of IPv4 addresses to include in the IP pool.

For example: 192.0.2.20-192.0.2.90

exclude-ip-pool <First
IPv4 Address-Last IPv4
Address>

Specifies the range of IPv4 addresses to exclude from the IP
pool.

For example: 192.0.2.155-192.0.2.254

enable Enables the DHCPServer subnet, or the DHCPServer process
(depending on the context).

disable Disables the DHCPServer subnet, or the DHCPServer process
(depending on the context).

default-lease <Lease
in Seconds>

Specifies the default DHCP lease in seconds, for host IPv4
addresses. Applies only if DHCP clients do not request a unique
lease time. If you do not enter a value, the default is 43,200
seconds.

max-lease <Maximal
Lease in Seconds>

Specifies the maximal DHCP lease in seconds, for host IPv4
addresses. This is the longest lease available. If you do not enter
a value, the configuration default is 86,400 seconds.

default-gateway
<Gateway IPv4 Address>

Optional. Specifies the IPv4 address of the default gateway for
the network hosts
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Parameter Description

domain <Domain Name
for the DHCP Clients>

Optional. Specifies the domain name of the network hosts.

For example: example.com

dns <DNS Server IPv4
Address>

Optional. Specifies the DNS servers that the network hosts will
use to resolve hostnames. Optionally, specify a primary,
secondary and tertiary server in the order of precedence.

For example: 192.0.2.101, 192.0.2.102,
192.0.2.103

all Shows all DHCPServer's configuration settings.

subnets Configures the DHCPServer subnet settings.

subnet <Subnet Entry>
ip-pools

The IP addresses pools in the DHCPServer subnet, and their
status: Enabled or Disabled.

status The status of the DHCPServer process: Enabled or Disabled.
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Example

gaia> add dhcp server subnet 192.168.2.0 netmask 24

gaia> add dhcp server subnet 192.168.2.0 include-ip-pool start
192.168.2.20 end 192.168.2.90

gaia> add dhcp server subnet 192.168.2.0 include-ip-pool start
192.168.2.120 end 192.168.2.150

gaia> add dhcp server subnet 192.168.2.0 exclude-ip-pool start
192.168.2.155 end 192.168.2.254

gaia> set dhcp server subnet 192.168.2.0 include-ip-pool 192.168.2.20-
192.168.2.90 enable

gaia> set dhcp server subnet 192.168.2.0 include-ip-pool
192.168.2.120-192.168.2.150 disable

gaia> set dhcp server subnet 192.168.2.0 exclude-ip-pool
192.168.2.155-192.168.2.254 enable

gaia> set dhcp server subnet 192.168.2.0 default-lease 43200

gaia> set dhcp server subnet 192.168.2.0 max-lease 86400

gaia> set dhcp server subnet 192.168.2.0 default-gateway 192.168.2.103

gaia> set dhcp server subnet 192.168.2.0 domain example.com

gaia> set dhcp server subnet 192.168.2.0 dns 192.168.2.101,
192.168.2.102, 192.168.2.103

gaia> set dhcp server subnet 192.168.2.0 enable

gaia> add dhcp server subnet 172.30.4.0 netmask 24

gaia> add dhcp server subnet 172.30.4.0 include-ip-pool start
172.30.4.10 end 172.30.4.99

gaia> set dhcp server subnet 172.30.4.0 include-ip-pool 172.30.4.10-
172.30.4.99 enable

gaia> set dhcp server subnet 172.30.4.0 default-lease 43200

gaia> set dhcp server subnet 172.30.4.0 max-lease 86400

gaia> set dhcp server subnet 172.30.4.0 disable
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gaia> add dhcp server subnet 10.20.30.0 netmask 24

gaia> set dhcp server subnet 10.20.30.0 default-lease 43200

gaia> set dhcp server subnet 10.20.30.0 max-lease 86400

gaia> set dhcp server subnet 10.20.30.0 disable

gaia> show dhcp server all
DHCP Server Enabled
DHCP-Subnet 192.168.2.0

State Enabled
Net-Mask 24
Maximum-Lease 86400
Default-Lease 43200
Domain example.com
Default Gateway 192.168.2.103
DNS 192.168.2.101, 192.168.2.102, 192.168.2.103
Pools (Include List)

192.168.2.20-192.168.2.90 : enabled
192.168.2.120-192.168.2.150 : disabled

Pools (Exclude List)
192.168.2.155-192.168.2.254 : enabled

DHCP-Subnet 172.30.4.0
State Disabled
Net-Mask 24
Maximum-Lease 86400
Default-Lease 43200
Pools (Include List)

172.30.4.10-172.30.4.99 : enabled
DHCP-Subnet 10.20.30.0

State Disabled
Net-Mask 24
Maximum-Lease 86400
Default-Lease 43200

gaia>
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Hosts and DNS
This page lets you configure:

n System Name - Host Name and Domain Name (see "SystemName" on page 154)

n DNS settings (see "DNS" on page 158)

n Hosts (see "Hosts" on page 155)
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System Name
You set the host name (system name) during initial configuration. You can change the name.

Configuring Host Name and Domain Name in Gaia Portal

Step Description

1 In the navigation tree, clickNetwork Management > Host and DNS.

2 In the System Name section, enter:

n Host Name - The network name of the Gaia device.

n Domain Name - Optional. For example, example.com.

Configuring Host Name and Domain Name in Gaia Clish

Description

Configure the host name of your platform.

Syntax

n To configure a hostname:

set hostname <Name of Host>

n To show the configured hostname:

show hostname

n To configure a domain name (optional):

set domainname <Domain>

n To show the configured domain name:

show domainname

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Hosts
You should add host addresses for systems that communicate frequently with the Gaia system.

You can:

n View the entries in the hosts table.

n Add an entry to the list of hosts.

n Modify the IP address of a host.

n Delete a host entry.

Configuring Hosts in Gaia Portal

To add a static host entry

Step Description

1 In the navigation tree, clickNetwork Management > Hosts and DNS.

2 In the Hosts section, click Add.

3 Enter:

n Host Name - Must include only alphanumeric characters, dashes ('-'), and periods
('.'). Periods must be followed by a letter or a digit. The name may not end with a dash
or a period. There is no default value.

n IPv4 address

n IPv6 address

To edit the static host entry

Step Description

1 In the navigation tree, clickNetwork Management > Hosts and DNS.

2 In the Hosts section, select a host entry and click Edit.

3 Edit:

n Host Name

n IPv4 address

n IPv6 address
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To delete the static host entry

Step Description

1 In the navigation tree, clickNetwork Management > Hosts and DNS.

2 In the Hosts section, select a host entry and clickDelete.

Configuring Hosts in Gaia Clish

Description

Add, edit, delete and show the name and IP addresses for hosts that communicate frequently with the Gaia
system.

Syntax

To add a static host entry

add host name <Name of Host>
ipv4-address <IPv4 Address of Host>
ipv6-address <IPv6 Address of Host>

To edit the static host entry

set host name <Name of Host>
ipv4-address <IPv4 Address of Host>
ipv6-address <IPv6 Address of Host>

To delete the static host entry

delete host name <Name of Host> {ipv4 | ipv6}

To show the configured static host entry

show host name<SPACE><TAB>

show host name <Name of Host> {ipv4 | ipv6}

To show all configured IP addresses of all hosts

show host names [ipv4 | ipv6]

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

CLI Parameters

Parameter Description

name <Name
of Host>

The name of a static host. Must include only alphanumeric characters, dashes
('-'), and periods ('.'). Periods must be followed by a letter or a digit. The name
must not end in a dash or a period. There is no default value.

ipv4-
address
<IPv4
Address of
Host>

The IPv4 address of the host.

ipv6-
address
<IPv6
Address of
Host>

The IPv6 address of the host.
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DNS
Gaia uses the Domain Name Service (DNS) to translate host names into IP addresses.

To enable DNS lookups, you must enter the primary DNS server for your system. You can also enter
secondary and tertiary DNS servers.

When the system resolves host names, it consults the primary name server. If a failure or time-out occurs,
the system consults the secondary name server, and if necessary, the tertiary.

You can also define a DNSSuffix, which is a search for host-name lookup.

Configuring DNS in Gaia Portal

To configure the DNS Servers

Step Description

1 In the navigation tree, clickNetwork Management > Hosts and DNS.

2 In the System Name section:

In the Domain Name field, enter the domain name (for example, example.com).
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Step Description

3 In the DNS section:

a. In the DNS Suffix field, enter the domain name suffix.

Gaia adds it at the end of all DNS searches, if they fail.

By default, it must be the local domain name configured in the Domain Name field
above.

A valid domain name suffix is made up of subdomain strings separated by periods.
Subdomain strings must begin with an alphabetic letter and can consist only of
alphanumeric characters and hyphens. The domain name syntax is described in RFC
1035 (modified slightly in RFC 1123).

Note - Domain names that are also valid numeric IP addresses(for example:
10.19.76.100), although syntactically correct, are not permitted.

Example:

You configured the DNSSuffix "example.com" and you try to ping the host "foo"
(with the command "ping foo"). If Gaia cannot resolve "foo", then Gaia tries to
resolve "foo.example.com".

b. In the Primary DNS Server field, enter the IPv4 or IPv6 address of the Primary DNS
server.

c. Optional: In the Secondary DNS Server field, enter the IPv4 or IPv6 address of the
Secondary DNS server (to use if the primary DNS server does not respond).

d. Optional: In the Tertiary DNS Server field, enter the IPv4 or IPv6 address of the
Tertiary DNS server (to use if the primary and secondary DNS servers do not
respond).

e. Click Apply.
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Configuring DNS in Gaia Clish

Description

Configure, show and delete the DNS servers and the DNS suffix for the Gaia computer.

Syntax

To configure the DNS servers and the DNS suffix

set dns
primary <IPv4 or IPv6 Address>
secondary <IPv4 or IPv6 Address>
tertiary <IPv4 or IPv6 Address>
suffix <Name for Local Domain>

To show the DNS servers and the DNS suffix

show dns
primary
secondary
tertiary
suffix

To delete the DNS servers and the DNS suffix

delete dns
primary
secondary
tertiary
suffix

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

CLI Parameters

Parameter Description

primary
<IPv4 or
IPv6
Address>

Specifies the IPv4 or IPv6 address of the primary DNS server, which resolve host
names.

This must be a host that runs a DNS server.

secondary
<IPv4 or
IPv6
Address>

Specifies the IPv4 or IPv6 address of the secondary DNS server, which resolves host
names if the primary server does not respond.

This must be a host that runs a DNS server.
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Parameter Description

tertiary
<IPv4 or
IPv6
Address>

Specifies the IPv4 or IPv6 address of the tertiary DNS server, which resolves host
names if the primary and secondary servers do not respond.

This must be a host that runs a DNS server.

suffix
<Name for
Local
Domain>

Specifies the name that is put at the end of all DNS searches if they fail. By default, it
must be the local domain name.

A valid domain name suffix is made up of subdomain strings separated by periods.
Subdomain strings must begin with an alphabetic letter and can consist only of
alphanumeric characters and hyphens. The domain name syntax is described in
RFC 1035 (modified slightly in RFC 1123).

Note - Domain names that are also valid numeric IP addresses(for
example: 10.19.76.100), although syntactically correct, are not permitted.

Example:

You configured the DNSSuffix "example.com" and you try to ping the host "foo"
(with the command "ping foo"). If Gaia cannot resolve "foo", then Gaia tries to
resolve "foo.example.com".
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IPv4 Static Routes
A static route defines the destination and one or more paths (next hops) to get to that destination.

You define static routes manually using the Gaia Portal, or the Gaia Clish "set static-route"
command.

Static routes let you add paths to destinations that are unknown by dynamic routing protocols. You can
define multiple paths (next hops) to a destination and define priorities for selecting a path. Static routes are
also useful for defining the default route.

Static route definitions include these parameters:

n Destination IPv4 address.

n Route type:

l Normal - Accepts and forwards packets to the specified destination.

l Reject - Drops packets and sends ICMP unreachable packet.

l Blackhole - Drops packets, without sending ICMP unreachable packet.

n Next-hop type:

l Address - Identifies the next hop gateway by its IPv4 address.

l Logical - Identifies the next hop gateway by the name of the local interface that connects to it.
Use this option only if the next hop gateway has an unnumbered interface.

n Gateway identifier - IPv4 address, or name of local interface.

n Priority (Optional) - Assigns a path priority when there are many different paths.

n Rank (Optional) - Selects a route when there are many routes to a destination that use different
routing protocols. You must use the Gaia Clish to configure the rank.
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Configuring IPv4 Static Routes in Gaia Portal
You can configure IPv4 static routes one at a time, or many routes at once.

Configuring One IPv4 Static Route at a Time

Step Description

1 In the navigation tree, clickNetwork Management > IPv4 Static Routes.

2 In the IPv4 Static Routes section, click Add.

The Add Destination Routewindow opens.

3 In the Destination field, enter the IPv4 address of destination host, or network.

4 In the Subnet mask field, enter the subnet mask.

5 In the Next Hop Type field, select one of these:

n Normal - To accept and forward packets

n Blackhole - To drop packets, without sending ICMP unreachable packet to the traffic
source

n Reject - To drop packets, and send ICMP unreachable packet to the traffic source

6 In the Rank field, leave the default value (60), or enter the relative rank of the IPv4 static
route (an integer from 1 to 255).

This value specifies the rank for the configured route when there are overlapping routes from
different protocols.

7 Select the Local Scope option, if needed.

Use this setting on a cluster member when the ClusterXL Virtual IPv4 address is in a different
subnet than the IPv4 address of a physical interface.

This lets the cluster member accept static routes on the subnet of the Cluster Virtual IPv4
address.

To make sure that the scopelocal attribute is set correctly, run the "cat
/etc/routed.conf" command. For more information, see sk92799.

8 In the Comment field, enter the applicable comment text (up to 100 characters).

http://supportcontent.checkpoint.com/solutions?id=sk92799
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Step Description

9 Click Add Gateway and select one of these options:

n Option 1:

a. Select IP Address to specify the next hop by its IPv4 address.

b. In the IPv4 Address field, enter the IPv4 address of the next hop gateway.

c. In the Priority field, either do not enter anything, or select an integer between 1
and 8.

d. AddMonitored IPs.

e. ClickOK.

n Option 2:

a. SelectNetwork Interface to specify the next hop by the name of the local
interface name that connects to it.

b. In the Local Interface field, select an interface that connects to the next hop
gateway.

c. In the Priority field, either do not enter anything, or select an integer between 1
and 8.

d. AddMonitored IPs.

e. ClickOK.

Notes:

n Priority defines which gateway to select as the next hop when multiple
gateways are configured. The lower the priority, the higher the preference -
priority 1 means the highest preference, and priority 8 means the lowest
preference. You can define two or more paths using the same priority to
specify a backup path with equal priority. Gateways with no priority
configured are preferred over gateways with priority configured.

n Multihop ping in Static Routes uses ICMPEcho Request to monitor
reachability of an IP address multiple hops away. Multihop ping in Static
Routes updates the status of an associated nexthop in accordance to the
reachability status. The nexthop status becomes "down", if that IP address is
unreachable.

10 If you defined a next hop gateway by IP Address, you can select the Ping option, if you need
to monitor next hops for the IPv4 static route with the ping.

The Ping feature sends ICMPEcho Requests to verify that the nexthop for a static route is
working. Only nexthop gateways, which are verified as working are included in the kernel
forwarding table. When Ping is enabled, an IPv4 static route is added to the kernel
forwarding table only after at least one gateway is reachable.

11 Click Save.

12 In the Advanced Options section, you can adjust the Ping behavior. If you changed the
default settings, click Apply.
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Configuring Many IPv4 Static Routes at Once

You can use the batch mode to configure multiple static routes in one step.

Note - This mode does not allow configuring static routes using a logical interface option.

Step Description

1 In the navigation tree, clickNetwork Management > IPv4 Static Routes.

2 In the Batch Mode section, click Add Multiple Static Routes.

3 In the Add Multiple Routes window, select the Next Hop Type:

n Normal - To accept and forward packets

n Blackhole - To drop packets, without sending ICMP unreachable packet

n Reject - To drop packets, and send ICMP unreachable packet

4 Add the routes in the text box, using this syntax:

<Destination IPv4 Address>/<Mask Length> <IPv4 Address of
Next Hop Gateway> ["<Comment>"]

Where:

n <Destination IPv4 Address>/<Mask Length> - Specifies the IPv4
address of destination host or network using the CIDR notation (IPv4_
Address/MaskLength).

Example: 192.168.2.0/24

You can use the default keyword instead of an IPv4 address when referring to the
default route.

n <IPv4 Address of Next Hop Gateway> - Specifies the IPv4 address of the
next hop gateway

n "<Comment>" - Optional. Free text comment for the static route.

Write the text in double-quotes. Maximal length of the text string is 100 characters.

Example:

default 192.0.2.100 192.0.2.1 "Default Route"
192.0.2.200/24 192.0.2.18 "My Backup Route"

5 Click Apply.

The newly configured static routes show in the IPv4 Static Routes section.

Note - The text box shows entries that contain errors with messages at the top of
the page.
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Step Description

6 Correct errors and reload the affected routes.

7 In the top right corner, click theMonitoring tab to make sure that the routes are configured
correctly.



Configuring IPv4 Static Routes in Gaia Clish

Gaia R80.40 Administration Guide      |      167

Configuring IPv4 Static Routes in Gaia Clish

Description

Configure, show and delete IPv4 static routes.

Syntax

To add or configure a default static IPv4 route

set static-route default
comment {"Text" | off}
nexthop

gateway
address <IPv4 Address of Next Hop Gateway>

[priority <Priority>] {on | off}
logical <Name of Local Interface> [priority

<Priority>] {on | off}
blackhole
reject

ping {on | off}
rank <Rank>
scopelocal {on | off}

To add or configure a specific static IPv4 route

set static-route <Destination IPv4 Address>
comment {"Text" | off}
nexthop

gateway
address <IPv4 Address of Next Hop Gateway>

{on | off}
monitored-ip <monitored_ip> {on | off}
monitored-ip-option {fail-all | fail-any |

force-if-symmetry {on | off}}
[priority <Priority>]

logical <Name of Local Interface>
{on | off}
[priority <Priority>]

blackhole
reject

off
ping {on | off}
rank <Rank>
scopelocal {on | off}

To show all configured static IPv4 routes

show route static all

To remove a default static IPv4 route

set static-route default off
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To remove a specific static IPv4 route

set static-route <Destination IPv4 Address> off

To remove a specific path only, when multiple nexthops are configured

set static-route <Destination IPv4 Address> nexthop gateway <IPv4
Address of Next Hop Gateway> off

set static-route <Destination IPv4 Address> nexthop gateway <Name of
Local Interface> off

Note - There are no "add" commands for the static route feature.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

CLI Parameters

Parameter Description

default Defines the default static IPv4 route.

<Destination IPv4
Address>

Specifies the IPv4 address of destination host or network using the
CIDR notation (IPv4_Address/MaskLength).

Example: 192.168.2.0/24

You can use the default keyword instead of an IPv4 address when
referring to the default route.

comment {"Text" |
off}

Defines of removes the optional comment for the static route.

n Write the text in double-quotes.

n Text must be up to 100 characters.

n This comment appears in the Gaia Portal and in the output of
the "show configuration" command.

nexthop Defines the next hop path, which can be a gateway, blackhole,
or reject.

gateway Specifies that this next hop accepts and sends packets to the
specified destination.

blackhole Specifies that this next hop drops packets, but does not send ICMP
unreachable packet to the traffic source.
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Parameter Description

reject Specifies that this next hop drops packets and sends ICMP
unreachable packet to the traffic source.

address <IPv4
Address of Next Hop
Gateway>

Specifies the IPv4 address of the next hop gateway.

logical <Name of
Local Interface>

Identifies the next hop gateway by the name of the local interface that
connects to it.

Use this option only if the next hop gateway has an unnumbered
interface.

monitored-ip
<monitored_ip> {on
| off}

Remote IPv4 address to monitor for the next hop gateway.

Set a gateway to monitor IP address(es) configured with the "ip-
reachability-detection".

The gateway becomes usable with respect to reachability of IP
address(es) reported from the "ip-reachability-
detection".

monitored-ip-option
{fail-all | fail-
any | force-if-
symmetry {on |
off}}

Set failure condition and flavor for the configured monitored IP
address(es).

n fail-all

Fails the next hop gateway when all monitored IP addresses
become unreachable.

Restores the next hop gateway when one of the monitored IP
addresses becomes reachable.

Default: off

n fail-any

Fails the next hop gateway when one of the monitored IP
addresses becomes unreachable.

Restores the next hop gateway when all monitored IP
addresses become reachable.

Default: on

n force-if-symmetry

Ignores IP reachability reports from IP addresses with
asymmetric traffic.

Default: off
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Parameter Description

priority <Priority> Defines which gateway to select as the next hop when multiple
gateways are configured.

The lower the priority, the higher the preference - priority 1 means
the highest preference, and priority 8 means the lowest preference.

You can define two or more paths using the same priority to specify a
backup path with equal priority.

Gateways with no priority configured are preferred over gateways
with priority configured.

nexthop ... on Adds the specified next hop.

nexthop ... off Deletes the specified next hop.

If you specify a next hop, only the specified path is deleted.

If no next hop is specified, the route and all related paths are deleted.

off Removes the static route.

ping {on | off} Enables (on) or disables (off) the ping of specified next hop
gateways for IPv4 static routes.

The Ping feature sends ICMPEcho Requests to verify that the
nexthop for a static route is working. Only nexthop gateways, which
are verified as working are included in the kernel forwarding table.

When Ping is enabled, an IPv4 static route is added to the kernel
forwarding table only after at least one gateway is reachable.

To adjust the ping behavior, run:

set ping count <value>

set ping interval <value>

rank <Rank> Selects a route, if there are many routes to a destination that use
different routing protocols.

The route with the lowest rank value is selected.

Use the rank keyword in place of the nexthop keyword with no
other parameters.

Accepted values are: default (60), integer numbers from 0 to 255.

In addition, see this command: "set protocol-rank
protocol <Rank>"
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Parameter Description

scopelocal {on |
off}

Defines a static route with a link-local scope.

Use this setting on a cluster member, when the ClusterXL Virtual
IPv4 address is in a different subnet than the IPv4 address of a
physical interface. This lets the cluster member accept static routes
on the subnet of the Cluster Virtual IPv4 address.

To make sure that the scopelocal attribute is set correctly, run the
"cat /etc/routed.conf" command.
For more information, see sk92799.

Example

gaia> set static-route 192.0.2.0/24 nexthop gateway address
192.0.2.155 on

gaia> set static-route 192.0.2.0/24 nexthop gateway address
192.0.2.155 off

gaia> set static-route 192.0.2.0/24 nexthop gateway logical eth0 on

gaia> set static-route 192.0.2.0/24 off

gaia> set static-route 192.0.2.100/32 nexthop blackhole

gaia> set static-route 192.0.2.100/32 rank 2

gaia> show route static
Codes: C - Connected, S - Static, R - RIP, B - BGP,

O - OSPF IntraArea (IA - InterArea, E - External, N - NSSA)
A - Aggregate, K - Kernel Remnant, H - Hidden, P - Suppressed

S 0.0.0.0/0 via 192.168.3.1, eth0, cost 0, age 164115
S 192.0.2.100 is a blackhole route
S 192.0.2.240 is a reject route
gaia>

http://supportcontent.checkpoint.com/solutions?id=sk92799
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IPv6 Static Routes
In This Section:

Configuring IPv6 Static Routes in Gaia Portal 172

Configuring IPv6 Static Routes in Gaia Clish 174

Troubleshooting 179

Important - First, you must enable the IPv6 Support and reboot (see "System
Configuration" on page 247).

Configuring IPv6 Static Routes in Gaia Portal
You can configure IPv6 static routes only one route at a time.

Procedure

Step Description

1 In the navigation tree, clickNetwork Management > IPv6 Static Routes.

2 In the IPv6 Static Routes section, click Add.

3 In the Destination / Mask Length field, enter the IPv6 address and prefix (default prefix is
64).

4 Select the Next Hop Type field select:

n Normal - To accept and forward packets

n Blackhole - To drop packets, without sending ICMP unreachable packet to the traffic
source

n Reject - To drop packets, and send ICMP unreachable packet to the traffic source

5 In the Rank field, leave the default value (60), or enter the relative rank of the IPv6 static
route (an integer from 1 to 255).

This value specifies the rank for the configured route when there are overlapping routes from
different protocols.

6 In the Comment field, enter the applicable comment text (up to 100 characters).

7 In the Add Gateway section, click Add.

The Add Gateway window opens.

8 In theGateway Address field, enter the IPv6 address of the next hop gateway.
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Step Description

9 In the Priority field, either do not enter anything, or select an integer between 1 and 8.

Priority defines the order for selecting the next hop among many gateways. The lower the
priority, the higher the preference - priority 1 means the highest preference, and priority 8
means the lowest preference. Gateways with no priority configured are preferred over
gateways with priority configured. Two gateways cannot be configured with the same priority
because IPv6 Equal Cost Multipath Routes are not supported.

10 ClickOK.

11 Select the Ping6 option, if you need to monitor next hops for the IPv6 static route using
ping6.

The Ping6 feature sends ICMPv6 Echo Requests to verify that the nexthop for a static route
is working. Only nexthop gateways, which are verified as working are included in the kernel
forwarding table. When Ping6 is enabled, an IPv6 static route is added to the kernel
forwarding table only after at least one gateway is reachable.

12 Click Save.

13 In the Advanced Options section, you can adjust the Ping6 behavior. If you changed the
default settings, you must click Apply.
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Configuring IPv6 Static Routes in Gaia Clish

Syntax

To add or configure the default static IPv6 route

set ipv6 static-route default
comment {"Text" | off}
nexthop

gateway <IPv6 Address of Next Hop Gateway>
[priority <Priority>] {on | off}
interface <Name of Local Interface> [priority

<Priority>] {on | off}
blackhole
reject

off
ping6 {on | off}
rank <Rank>

To add or configure the specific static IPv6 route

set ipv6 static-route <Destination IPv6 Address>
comment {"Text" | off}
nexthop

gateway <IPv6 Address of Next Hop Gateway>
[priority <Priority>] {on | off}
interface <Name of Local Interface> [priority

<Priority>] {on | off}
blackhole
reject

off
ping6 {on | off}
rank <Rank>

To show all configured static IPv6 routes

show ipv6 route static all

To remove the default static IPv6 route

set ipv6 static-route default off

To remove the specific static IPv6 route

set ipv6 static-route <Destination IPv6 Address> off
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To remove the specific path only, when multiple nexthops are configured

set ipv6 static-route <Destination IPv6 Address> nexthop gateway
<IPv6 Address of Next Hop Gateway> off

set ipv6 static-route <Destination IPv6 Address> nexthop gateway
<Name of Local Interface> off

Note - There are no "add" commands for the static route feature.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

CLI Parameters

Parameter Description

default Defines the default static IPv6 route.

<Destination
IPv6 Address>

Defines the IPv6 address of destination host or network using the CIDR
notation (IPv6_Address/MaskLength).

Example: fc00::/64

Mask length must be in the range 8-128.

comment {"Text"
| off}

Defines of removes the optional comment for the static route.

n Write the text in double-quotes.

n Text must be up to 100 characters.

n This comment appears in the Gaia Portal and in the output of the
show configuration command.

nexthop Defines the next hop path, which can be a gateway, blackhole, or
reject.

gateway Specifies that this next hop accepts and sends packets to the specified
destination.

blackhole Specifies that this next hop drops packets, but does not send ICMP
unreachable packet to the traffic source.

reject Specifies that this next hop drops packets and sends ICMP unreachable
packet to the traffic source.

address <IPv6
Address of Next
Hop Gateway>

Defines the IPv6 address of the next hop gateway.

interface <Name
of Local
Interface>

Identifies the next hop gateway by the local interface that connects to it.

Use this option only if the next hop gateway has an unnumbered interface.

priority
<Priority>

Defines which gateway to select as the next hop when multiple gateways
are configured.

The lower the priority, the higher the preference - priority 1 means the
highest preference, and priority 8 means the lowest preference.

Gateways with no priority configured are preferred over gateways with
priority configured.

Two gateways cannot be configured with the same priority because IPv6
Equal Cost Multipath Routes are not supported.

nexthop ... on Adds the specified next hop.
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Parameter Description

nexthop ... off Deletes the specified next hop.

If you specify a next hop, only the specified path is deleted.

If no next hop is specified, the route and all related paths are deleted.

off Removes the static route.

ping6 {on |
off}

Enables (on) or disables (off) the ping of specified next hop gateways for
IPv6 static routes.

The Ping6 feature sends ICMPv6 Echo Requests to verify that the nexthop
for a static route is working. Only nexthop gateways, which are verified as
working are included in the kernel forwarding table.

When Ping6 is enabled, an IPv6 static route is added to the kernel
forwarding table only after at least one gateway is reachable.

To adjust the ping6 behavior, run:

set ping count <value>

set ping interval <value>

rank <Rank> Selects a route, if there are many routes to a destination that use different
routing protocols.

The route with the lowest rank value is selected.

Use the rank keyword in place of the nexthop keyword with no other
parameters.

Accepted values are: default (60), integer numbers from 0 to 255.

In addition, see this command: set protocol-rank protocol
<Rank>
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Example

gaia> set ipv6 static-route 3100:192::0/64 nexthop gateway
3900:172::1 on

gaia> set ipv6 static-route 3100:192::0/64 nexthop gateway
3900:172::1 interface eth3 on

gaia> set ipv6 static-route 3100:192::0/64 nexthop gateway
3900:172::1 priority 3 on

gaia> set ipv6 static-route 3100:192::0/64 nexthop reject

gaia> set ipv6 static-route 3100:192::0/64 nexthop blackhole

gaia> set ipv6 static-route 3100:192::0/64 off

gaia> set ipv6 static-route 3100:192::0/64 nexthop gateway
3900:172::1 off

gaia> set ipv6 static-route 3100:192::0/64 nexthop gateway
3900:172::1 interface eth3 off

gaia> show ipv6 route static
Codes: C - Connected, S - Static, B - BGP, Rg - RIPng, A -

Aggregate,
O - OSPFv3 IntraArea (IA - InterArea, E - External),
K - Kernel Remnant, H - Hidden, P - Suppressed

S 3100:55::1/64 is directly connected
S 3200::/64 is a blackhole route
S 3300:123::/64 is a blackhole route
S 3600:20:20:11::/64 is directly connected, eth3
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Troubleshooting
Symptoms

You cannot enable the VPN Software Blade. This message shows:

VPN blade demands gateway's IP address corresponding to the interface's
IP addresses

Cause

IPv6 feature is active on the Security Gateway, but the main IPv6 address is not configured in the Security
Gateway object.

Solution

1. In SmartConsole, open the Security Gateway object.

2. Click theGeneral Properties page.

3. Configure the main IPv6 address.

4. ClickOK.

5. Install the Access Policy on the Security Gateway object.
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Configuring IPv6 Neighbor Entries

Description

You can add and delete entries in the Gaia IPv6 Neighbor table.

Note - You can add or delete Neighbor entries only from the Gaia Clish

Important - First, you must enable the IPv6 Support and reboot (see "System
Configuration" on page 247).

Syntax

n To add an IPv6 neighbor entry:

add neighbor-entry ipv6-address <IPv6 Address of Neighbor>
macaddress <MAC Address of Neighbor> interface <Name of Local
Interface>

n To show an IPv6 neighbor entry:

show neighbor<SPACE><TAB>

show neighbor TABLE

n To delete an IPv6 neighbor entry:

delete neighbor-entry ipv6-address <IPv6 Address of Neighbor>
interface <Name of Local Interface>

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

Parameter Description

<IPv6 Address of
Neighbor>

Specifies the IPv6 address of a new static Neighbor Discovery
entry

<MAC Address of
Neighbor>

Specifies the MAC address for respective IPv6 address

<Name of Local
Interface>

Name of the local interface that connects to the Neighbor
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Netflow Export
In This Section:

Introduction 181

Configuration Procedure 183

Introduction
NetFlow is an industry standard for traffic monitoring. It is a network protocol developed by Cisco for
collecting network traffic patterns and volume. It lets one host (the Exporter) send information about
network flows to another host (the Collector). A network flow is a unidirectional stream of packets that
share a set of characteristics.

You can configure Security Gateways and Cluster Members that run on Gaia Operating System as an
Exporter of NetFlow records for all the traffic they inspect.

Note - The state of the SecureXL on a Security Gateway is irrelevant for NetFlow export.

The Collector is supplied by a different vendor, and is configured separately.

NetFlow Export configuration is a list of collectors, to which the service sends records:

n To enable NetFlow, configure at least one collector.

n To disable NetFlow, make sure no collectors are configured.

You can configure up to three collectors. NetFlow records go to all configured collectors. If you configure
three collectors, each record is sent three times.

Regardless of which NetFlow export format you choose, Gaia operating system exports values as set of
fields.
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The fields

n Source IP address

n Destination IP address

n Source port

n Destination port

n Ingress physical interface index (defined by SNMP)

n Egress physical interface index (defined by SNMP)

n Packet count for this flow

n Byte count for this flow

n Start of flow timestamp (FIRST_SWITCHED)

n End of flow timestamp (LAST_SWITCHED)

n IP protocol number

n TCP flags from the flow (TCP only)

n VSXVSID

Notes:

n The IP addresses and TCP/UDP ports reported by NetFlow are the ones, on
which it expects to receive traffic.

Therefore, for NATed connections, one of the two directions of flow is
reported with the NATed address.

n NetFlow sends the connection records after the connections have
terminated.

If the system is idle or the connections are long lasting, you may have to wait
to see NetFlow packets.

For more information, see sk102041: NetFlow support byGaia OS.

Important - In Cluster, you must configure all the Cluster Members in the same way

http://supportcontent.checkpoint.com/solutions?id=sk102041
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Configuration Procedure
1. Configure the Netflow Export settings on Gaia

You can configure these settings either in Gaia Portal, or in Gaia Clish.

Configuring the NetFlow settings In Gaia Portal

a. In the left navigation tree, clickNetwork Management >NetFlow Export.

b. Click Add.

c. Enter the required data for each collector:

Parameter Description

IP address The IPv4 address, to which NetFlow packets are sent.

This is mandatory.

UDP port
Number

The UDP port number, on which the collector is listening.

This is mandatory.

There is no default or standard port number for NetFlow.

Export
format

The NetFlow protocol version to send:

n Netflow_V5

n Netflow_V9

n IPFIX (known as "NetFlow v10")

Each protocol version has a different packet format.

The default isNetflow_V9.

Source IP
address

Optional: The IPv4 address of the NetFlow packets source.

This must be an IPv4 address of the local host.

The default (which is recommended) is an IPv4 address from the
network interface, on which the NetFlow traffic is going out.

Configuring the NetFlow settings In Gaia Clish
Syntax

n To add a Netflow collector:

add netflow collector ip <IPv4 Address of Collector>
port <Destination Port on Collector> [srcaddr <Source
IPv4 Address> export-format {Netflow_V5 | Netflow_V9 |
IPFIX}] enable
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n To change settings of a Netflow collector:

set netflow collector for-ip <IPv4 Address of
Collector>

ip <IPv4 Address of Collector>
port <Destination Port on Collector>
srcaddr <Source IPv4 Address> export-format

{Netflow_V5 | Netflow_V9 | IPFIX}
export-format {Netflow_V5 | Netflow_V9 | IPFIX}
enable
disable

n To show a Netflow collector:

show netflow collector

show netflow collector<SPACE><TAB>

show netflow all

n To delete a Netflow collector:

delete netflow collector for-ip <IPv4 Address of
Collector> [for-port <Destination Port on Collector>]

Important - After you add, configure, or delete features, run the "save
config" command to save the settings permanently.

CLI Parameters

Parameter Description

ip <IPv4
Address of
Collector>

Specifies the IPv4 address of the NetFlow Collector, to which NetFlow
packets are sent. This is mandatory.

port <
Destination
Port on
Collector>

Specifies the UDP port number on the NetFlow Collector, on which
the collector is listening. This is mandatory. There is no default or
standard port number for NetFlow.

srcaddr
<Source
IPv4
Address>

Optional: Specifies the IPv4 address of the NetFlow packets source.
This must be an IPv4 address that belongs to one of the local
interfaces of the local host. The default (which is recommended) is an
IPv4 address that belongs to the network interface that connects to
the NetFlow Collector.
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Parameter Description

export-
format
{Netflow_V5
| Netflow_
V9 | IPFIX}

The NetFlow protocol version to send:

n NetFlow v5

n NetFlow v9

n IPFIX (known as "NetFlow v10")

Each NetFlow protocol version has a different packet format.

The default is NetFlow v9.

for-ip
<IPv4
Address of
Collector>

for-port <
Destination
Port on
Collector>

These parameters specify the configured NetFlow Collector.

If you only have one collector configured, you do not need these
parameters.

If you have two or three collectors with different IP addresses, use
for-ip.

If you have two or three collectors with the same IP address and
different UDP ports, you must use for-ip and for-port to identify
the one you want to work on.

2. In SmartConsole, configure the explicit Access Control rule

a. In the left navigation tree, click Security Policies.

b. Open the applicable policy.

c. In the top left corner, click Access Control > Policy.

d. Add an explicit rule for the traffic that you wish to export with Netflow:

Important - In the Track column, you must select Log and Accounting.

Source Destination VPN Services &
Applications Content Action Track

Source
Host or
Network
objects

Destination
Host or
Network
objects

*Any Applicable
service
objects

* Any Accept Log

Accounting

e. Publish the SmartConsole session.

f. Install the Access Control policy on the Security Gateway or Cluster object.
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SystemManagement
This chapter includes procedures and reference information for:

n Time and Date

n Cloning Groups

n SNMP

n Job Scheduler

n Mail Notification

n Login Messages

n Session in Gaia Portal and Gaia Clish

n Core Dump Files

n System Logging

n Network Access over Telnet

n GUI Clients for Security Management Server
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Time
All Security Gateways, Security Management Servers and cluster members must synchronize their system
clocks. This is important for these reasons:

n SIC trust can fail if devices are not synchronized correctly.

n Cluster synchronization requires precise clock synchronization between members.

n SmartEvent correlation uses time stamps that must be synchronized to approximately one a
second.

n To make sure that cron jobs run at the correct time.

n To do certificate validation for applications based on the correct time.

You can use these methods to set the system date and time:

n Network Time Protocol (NTP).

n Manually, using the Gaia Portal, or the Gaia Clish.

Network Time Protocol (NTP)

Network Time Protocol (NTP) is an Internet standard protocol used to synchronize the clocks of computers
in a network to the millisecond.

NTP runs as a background client program on a client computer. It sends periodic time requests to specified
servers to synchronize the client computer clock.

Best Practice - Configure more than one NTP server for redundancy.
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Configuring the Time and Date in Gaia Portal
Configuring the time and date manually

Step Description

1 In the navigation tree, click System Management > Time.

2 Click Set Time and Date.

3 Enter the time and date in the applicable fields.

4 ClickOK.

Configuring the time and date automatically using NTP

Step Description

1 In the navigation tree, click System Management > Time.

2 Click Set Time and Date.

3 In the Time and Date Settings window, select Set Time and Date automatically using
Network Time Protocol (NTP).

4 Enter the Hostname or IP address of the primary and (optionally) secondary NTP servers.

Best Practice - Configure more than one NTP server for redundancy.

5 Select the NTP version for the applicable server.

6 ClickOK.

Configuring the Time Zone

Step Description

1 In the navigation tree, click System Management > Time.

2 Click Set Time Zone and select the time zone from the list.

3 ClickOK.
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Configuring the Time and Date in Gaia Clish

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Showing the current system date and time

Syntax

show clock

Example

gaia> show clock
Wed Jan 8 15:20:00 2020 GMT+1
gaia>

Configuring and Showing the Time

Syntax

n To configure the time:

set time <Time of the Day>

n To show the current time:

show time

Parameters

Parameter Description

<Time of the Day> The current system time in HH:MM:SS format.
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Configuring and Showing the date

Syntax

n To configure a date:

set date <Date>

n To configure the configured date:

show date

Parameters

Parameter Description

<date> The date in the YYYY-MM-DD format.

Example

To configure the 20th of January 2020, run:

gaia> set date 2020-01-20
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Configuring and Showing the Time Zone

Syntax

n To configure the time zone:

set timezone <Area> / <Region>

Important - The spaces before and after the slash character (/) are mandatory.

n To show the configured time zone:

show timezone

Parameters

Parameter Description

<Area> Continent or geographic area (case sensitive).

To see the valid values, press <SPACE> and <TAB>:

<Region> Region within the specified area (case sensitive).

To see the valid values, press <SPACE> and <TAB>:

Examples

gaia> set timezone America / Detroit

gaia> set timezone Asia / Tokyo
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Configuring and Showing the NTP

Syntax

n To add a new NTP server:

set ntp
active {on | off}
server

primary <IPv4 address or Hostname of NTP Server>
version {1|2|3|4}

secondary <IPv4 address or Hostname of NTP Server>
version {1|2|3|4}

n To show NTP configuration:

show ntp
active
current
servers

n To delete an NTP server:

delete ntp server <IPv4 address or Hostname of NTP Server>

Parameters

Parameter Description

active Shows the NTP status (enabled or disabled).

current Shows the IP address or Host name of the NTP server Gaia uses right now.

servers Shows the configured NTP servers.

active {on |
off}

Enables (on) or disables (off) NTP.

server Keyword that identifies the NTP server - time server, from which Gaia
synchronizes its clock.

The specified time server does not synchronize to the local clock of Gaia.

primary Configures the IP address or Host name of the primary NTP server.

secondary Configures the IP address or Host name of the secondary NTP server.

Best Practice - Configure more than one NTP server for
redundancy.
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Parameter Description

version
{1|2|3|4}

Configures the version number of the NTP - 1, 2, 3, or 4.

Best Practice - Run NTP version 3.

Example

gaia> set ntp server primary pool.ntp.org version 3
gaia> set ntp active on
gaia> show ntp servers
IP Address Type Version
pool.ntp.org Primary 3
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Cloning Group
ACloning Group is a collection of Gaia Security Gateways that synchronize their OS configurations and
settings for a number of shared features, for example DNS or ARP.
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Configuring Cloning Groups in Gaia Portal
To create a new Cloning Group

Step Description

1 With a web browser, connect to Gaia Portal at:

https://<IP address of Gaia Management Interface>

2 Click System Management > Cloning Group.

3 Click Start Cloning Group Creation Wizard.

The Cloning Group Creation Wizard opens.

4 SelectCreate a new Cloning Group.

The New Gaia Cloning Groupwindow opens.

a. In the Cloning Group Name field, enter a name for the Cloning Group.

b. In the IP for cloning field, select an IPv4 address (interface) for synchronizing settings
between member Security Gateways.

Select an interface on a secure internal network.

c. In the Password field, enter a password for the administration account (cadmin).

This password is necessary to:

n Manage the Cloning Group

n Add other Security Gateways to the Cloning Group

n Create encrypted traffic between members of the Cloning Group

d. In the Confirm Password field, enter the password again.

5 In the Shared Features screen, select features to clone to other members of the Cloning
Group.

Pay attention to the features you want to clone.

For example, you might not want to clone static routes to Security Gateways that are
members of a cluster.

6 ClickNext for theWizard Summary.

7 Click Finish.
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List of Shared Features

The features are listed in the same order, in which they are shown in Gaia Portal.

Shared Feature Description

SNMP Configure SNMP.

Banner
Messages

Configure banner messages.

Job Scheduler Schedule automated tasks that perform actions at a specific time.

DNS Configure DNS servers.

ARP Configure static ARP entries and proxy ARP entries, control dynamic ARP
entries.

System Logging Configure system logging settings.

Host Access
Control

Configure which hosts are allowed to connect to the cluster devices.

Proxy Settings Configure proxy settings.

Host Address
Assignment

Configure known hosts.

NTP Configure Network Time Protocol for synchronizing the system's clock over
a network.

Password Policy Configure password and account policies.

Time Configure the time and date of the system.

Network Access Configure network access to Gaia.

Display Format Configure how the system displays time, date and netmask.

Mail Notification Configure email address, to which Gaia sends mail notifications.

Inactivity timeout Configure session parameters, such as inactivity timeout.

Users and Roles Configure users and roles settings.

Static Routes Configure static routes.

DHCPRelay Configure relay of DHCP and BOOTPmessages between clients and
servers on different IPv4 Networks.

IPv6 DHCPRelay Configure relay of DHCPv6 messages between clients and servers on
different IPv6 Networks.

Table: Shared Features in Gaia Portal
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Shared Feature Description

BGP Configure dynamic routing via the Border Gateway Protocol.

IGMP Establish multicast group memberships via the Internet Group Management
Protocol.

PIM Configure Protocol-Independent Multicast.

Static Multicast
Routes

Configure static multicast routes.

RIP Configure IPv4 dynamic routing via the Routing Information Protocol.

RIPng Configure IPv6 dynamic routing via the Routing Information Protocol.

OSPF Configure IPv4 dynamic routing via the Open Shortest-Path First v2
protocol.

IPv6 OSPF Configure IPv6 dynamic routing via the Open Shortest-Path First v3
protocol.

Route
Aggregation

Create a supernet network from the combination of networks with a
common routing prefix.

Inbound Route
Filters

Configure Inbound Route Filters for RIP, OSPFv2, BGP, and OSPFv3
(supports IPv4 and IPv6).

IP Reachability
Detection

Configure reachability detection of IP Addresses.

Route
Redistribution

Configure advertisement of routing information from one protocol to another
(supports IPv4 and IPv6).

Route Map Configure dynamic routing route maps.

Prefix Lists and
Trees

Configure dynamic routing prefix lists and trees.

Routing Options Configure protocol ranks and trace (debug) options.

Policy Based
Routing

Configure policy based routing (PBR) priority rules and action tables.

Scheduled
Backups

Configure Gaia scheduled backups.

Table: Shared Features in Gaia Portal (continued)
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To manage a Cloning Group

Step Description

1 Sign out of the Gaia Portal.

2 Sign in to the sameGaia Portal using the cadmin account and password.

(Alternatively, log in to the Gaia Portal on the Security Gateway using the cadmin
credentials.)

Important - No unique URL or IP address is needed to access the Cloning Group
Portal or Clish command line. Use the URL or IP address of the member Security
Gateway.

3 In System Management > Cloning Group, select features from the Shared Features.

4 Click Set Shared Features.

The shared features are propagated to all members of the group.

If, for example, you then configure a primary DNS server on one member of the Cloning
Group, and DNS is one of the Shared Features, then the DNS settings are propagated to all
members of the group. The DNS settings in the Portal of each member are grayed out.

Note - A user that gets cloning group administration privileges (the RBA role
CloningGroupManagement), can manage specific Cloning Groups features
granted by the administrator and grant Cloning Group capabilities to other users,
including remote users. When these privileges are assigned, theGroup Mode
button shows in Gaia Portal.

To manage a Cloning Group as an assigned administrator

Step Description

1 Connect to the Gaia Portal on a Cloning Group member Security Gateway.

With a web browser, connect to Gaia Portal at:

https://<IP address of Gaia Management
Interface>

2 At the top, clickGroup Mode.

The Security Gateway switches to Cloning Group management mode.
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To join a Cloning Group

Step Description

1 Connect to the Gaia Portal on a Security Gateway.

With a web browser, connect to Gaia Portal at:

https://<IP address of Gaia Management Interface>

2 In System Management > Cloning Group, click Start Cloning Group Creation Wizard.

The Cloning Group Wizard opens.

3 Select Join an existing Cloning Group.

4 The Join Existing Cloning Groupwindow opens.

n In the Remote Member Address field, enter the IPv4 address of a remote member of
the Cloning Group.

n In the IP for cloning field, select an IP address (interface) for synchronizing the
settings between Security Gateways.

Select an interface on a secure internal network. Make sure there is a physical
connectivity to the Gaia computer that runs the Cloning Group, to which you wish to
join.

n In the Password field, enter a password for the Cloning Group administration account
(cadmin).

(The same password you entered when you created the Cloning Group, to which you
wish to join.)

The cadmin password:

l Lets you log in to the cadmin account

l Is used to create authentication credentials for members during
synchronization

5 Click Finish.
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To create a Cloning Group that follows ClusterXL

Select this option, if the Security Gateway is a member of a ClusterXL.

Important - In Cluster, you must configure all the Cluster Members in the same way

Step Description

1 Connect to the Gaia Portal on a Security Gateway.

With a web browser, connect to Gaia Portal at:

https://<IP address of Gaia Management Interface>

2 In System Management > Cloning Group, click Start Cloning Group Creation Wizard.

The Cloning Group Creation Wizard opens.

3 SelectCloning group follows ClusterXL.

n Enter the Cloning Group name.

n Enter a password for the Cloning Group administration account (cadmin).

4 ClickNext for theWizard Summary.

5 Click Finish.

6 Repeat Steps 1-5 for all members of the cluster.
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Configuring Cloning Groups in Gaia Clish
In This Section:

Cloning Group Modes 201

CLI Syntax 202

Note - When run from the cadmin account, these commands apply to all members of
the Gaia group.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Cloning Group Modes

You can create Cloning Groups in eitherManual mode, or ClusterXLmode.

To Create the first Cloning Group member in Manual mode

Step Description

1 Set the cloning group mode to manual.

2 Set the cloning group local IP address.

3 Set the cloning group password.

4 Set the cloning group state to on.

5 Optional: Set a name for the Cloning Group.

To Add other Security Gateways to the Cloning Group in Manual mode

Perform these steps on each of the Security Gateways.

Step Description

1 Set the cloning group mode to manual.

2 Set the cloning group local IP address.

3 Set the cloning group password.

4 Run the "join cloning group" command to join the Cloning Group.
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To Create Cloning Group members in ClusterXL mode

Perform these steps on all member Security Gateways.

Step Description

1 Set the cloning group mode to ClusterXL.

2 Set the cloning group password.

3 Set the cloning group state to on.

CLI Syntax

To Create and configure a Cloning Group

Syntax

set cloning-group

      local-ip <IPv4 address>

      mode {manual | cluster-xl}

      name <Name of Cloning Group>

      password <Password>

      state {on | off}
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Parameters

Parameter Description

local-ip <IPv4
address>

The IPv4 address used to synchronize shared features between members
of the Cloning Group.

mode {manual |
cluster-xl}

The mode determines whether the Cloning Group is defined manually, or
through ClusterXL.

name <Name of
Cloning Group>

Name of the Cloning Group.

password
<Password>

Password for the administrator's (cadmin) account, used to access the
Cloning Group configuration in the Gaia Portal, or Gaia Clish.

When prompted, enter and confirm the password.

state {on |
off}

Enables (on) or disables (off) the Cloning Group feature.

Important - When you configure the state "off", the Security
Gateway is removed from the Cloning Group.

To add Shared Features

Syntax

add cloning-group shared-feature <Feature>

Parameters

Parameter Description

<
Feature>

The name of the feature to be synchronized between the members of the Cloning
Group.

List of Shared Features

The features are listed in the same order, in which they are shown in Gaia Clish when you run the
"show cloning-group shared-feature" command.

Name of Shared
Feature Description

aggregate Configure route aggregation - create a supernet network from the
combination of networks with a common routing prefix.

Table: Shared Features in Gaia Clish
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Name of Shared
Feature Description

bgp Configure dynamic routing via the Border Gateway Protocol.

bootp Configure IPv4 DHCPRelay - relay of DHCP and BOOTPmessages
between clients and servers on different IPv4 Networks.

cron Configure job scheduler - schedule automated tasks that perform actions
at a specific time.

dhcp6relay Configure IPv6 DHCPRelay - relay of DHCPv6 messages between clients
and servers on different IPv6 Networks.

dns Configure DNS servers.

hosts Configure known hosts.

igmp Establish multicast group memberships via the Internet Group
Management Protocol.

inboundfilters Configure Inbound Route Filters for RIP, OSPFv2, BGP, and OSPFv3
(supports IPv4 and IPv6).

ipreachdetect Configure reachability detection of IP Addresses.

time Configure the time and date of the system.

ntp Configure Network Time Protocol (NTP) for synchronizing the system's
clock over a network.

message Configure banner messages.

ospf Configure IPv4 dynamic routing via the Open Shortest-Path First v2
protocol.

ospf3 Configure IPv6 dynamic routing via the Open Shortest-Path First v3
protocol.

password-
controls

Configure password and account policies.

mailrelay Configure email address, to which Gaia sends mail notifications.

display-format Configure how the system displays time, date and netmask.

http Configure session parameters, such as inactivity timeout.

net-access Configure network access to Gaia.

users-and-
roles

Configure users and roles settings.

Table: Shared Features in Gaia Clish (continued)
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Name of Shared
Feature Description

arp Configure static ARP entries and proxy ARP entries, control dynamic ARP
entries.

syslog Configure system logging settings.

proxy Configure proxy settings.

host-access Configure which hosts are allowed to connect to the cluster devices.

pbr Configure policy based routing (PBR) priority rules and action tables.

pim Configure Protocol-Independent Multicast.

prefix Configure dynamic routing prefix lists and trees.

redistribution Configure route redistribution - advertisement of routing information from
one protocol to another (supports IPv4 and IPv6).

rip Configure IPv4 dynamic routing via the Routing Information Protocol.

ripng Configure IPv6 dynamic routing via the Routing Information Protocol.

routemap Configure dynamic routing route maps.

routingoptions Configure protocol ranks and trace (debug) options.

static Configure static routes.

static-mroute Configure static multicast routes.

snmp Configure SNMP.

backup Configure Gaia scheduled backups.

Table: Shared Features in Gaia Clish (continued)
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To delete Shared Features

Syntax

delete cloning-group shared-feature <Feature>

Parameters

Parameter Description

<Feature> The name of the feature to be deleted from the list of shared features.

To see the list of the enabled Shared Features:

a. Enter:

delete cloning-group shared-feature

b. Press <SPACE> and <TAB>.

To join a Cloning Group

Syntax

join cloning-group remote-ip <IPv4 address of Cloning Group>

Parameters

Parameter Description

<IPv4 address of Cloning
Group>

The IPv4 address of the Cloning Group member, to which
you join.

Note - This option is not available, if you are
logged into the cadmin account.

To remove a member from a Cloning Group

leave cloning-group



Configuring Cloning Groups in Gaia Clish

Gaia R80.40 Administration Guide      |      207

To remove an inaccessible Cloning Group member

Syntax

delete cloning-group disconnected-member <IPv4 address of Member>

Parameters

Parameter Description

<IPv4 address of
Member>

The IPv4 address of the Cloning Group member that became
inaccessible.

Important - Use this command only for troubleshooting purposes, when the remote
Cloning Group member is not accessible. A normal way to remove a member from a
Cloning Group is to run the "leave cloning-group" command on that
member.

Notes:

n The Cloning Group configuration on the remote member itself does not
change, and as soon as the device regains connectivity, it joins the Cloning
Group again.

n This command can only be run if the Cloning Group is in Manual mode.

To view the Cloning Group configuration

Syntax

show cloning-group

      local-ip

      members

      mode

      name

      shared-feature

      state

      status
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Parameters

Parameter Description

local-ip The IPv4 address used to synchronize shared features between the members of
the Cloning Group.

members Shows the members of the Cloning Group.

mode Shows the Cloning Group mode - Manual, or Cluster XL

name Shows the name of the Cloning Group

shared-
feature

Lists the shared features that are enabled to be used by all members of the
Cloning Group.

state Shows the Cloning Group state - enabled, or disabled.

status Shows the status of the Cloning Group member.

Note - This option is not available, if you are logged into the cadmin
account.

To synchronize a member in the Cloning Group

re-synch cloning-group

To Enable or disable the Cloning Group management mode

When a user (local or remote) receives Cloning Group management privileges, the user can enable (or
disable) the Cloning Group management mode, to create, delete, and edit Cloning Groups.

Syntax

set cloning-group-management {on | off}

Parameters

Parameter Description

on Enables the Cloning Group management mode.

off Disables the Cloning Group management mode.
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SNMP
In This Section:

Introduction 209

SNMP v3 - User-Based Security Model (USM) 210

Enabling SNMP 211

SNMP Agent Address 211

SNMP Traps 211

Introduction
Simple Network Management Protocol (SNMP) is an Internet standard protocol. SNMP is used to send and
receive management information to other network devices. SNMP sends messages, called protocol data
units (PDUs), to different network parts. SNMP-compliant devices, called agents, keep data about
themselves in Management Information Bases (MIBs) and resend this data to the SNMP requesters.

Through the SNMP protocol, network management applications can query a management agent using a
supported MIB. The Check Point SNMP implementation lets an SNMPmanager monitor the system and
modify selected objects only. You can define and change one read-only community string and one
read-write community string. You can set, add, and delete trap receivers and enable or disable various
traps. You can also enter the location and contact strings for the system.

To view detailed information about each MIB that the Check Point implementation supports (also, see
sk90470):

MIB Location

Standard MIBs /usr/share/snmp/mibs/*.txt

Check Point MIBs $CPDIR/lib/snmp/chkpnt.mib

$CPDIR/lib/snmp/chkpnt-trap.mib

Check Point Gaia trap MIB /etc/snmp/GaiaTrapsMIB.mib

Notes:

n The Check Point implementation also supports the User-based Security model
(USM) portion of SNMPv3.

n The Gaia implementation of SNMP is built on NET-SNMP. Changes were made
to the first version to address security and other fixes. For more information, see
the Net-SNMP.

Warning - If you use SNMP, we recommend that you change the community strings for security
purposes. If you do not use SNMP, disable SNMP or the community strings.

http://supportcontent.checkpoint.com/solutions?id=sk90470
http://www.net-snmp.org/
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SNMP, as implemented on Check Point platforms enables an SNMPmanager to monitor the device using
GetRequest, GetNextRequest, GetBulkRequest, and a select number of traps. The Check Point
implementation also supports using SetRequest to change these attributes: sysContact,
sysLocation, and sysName. You must configure read-write permissions for set operations to work.

Check Point Gaia supports SNMP v1, v2, and v3.

Use Gaia to run these tasks:

n Define and change one read-only community string.

n Define and change one read-write community string.

n Enable and disable the SNMP daemon.

n Create SNMP users.

n Change SNMP user accounts.

n Add or delete trap receivers.

n Enable or disable the various traps.

n Enter the location and contact strings for the device.

SNMP v3 - User-Based Security Model (USM)
Gaia supports the user-based security model (USM) component of SNMPv3 to supply message-level
security. With USM (described in RFC 3414), access to the SNMP service is controlled based on user
identities. Each user has a name, an authentication pass phrase (used for identifying the user), and an
optional privacy pass phrase (used for protection against disclosure of SNMPmessage payloads).

The system uses the MD5 hashing algorithm to supply authentication and integrity protection and DES to
supply encryption (privacy).

Best Practice - Use authentication and encryption. You can use them independently
by specifying one or the other with your SNMPmanager requests. The Gaia system
responds accordingly.

SNMP users are maintained separately from system users. You can create SNMP user accounts with the
same names as existing user accounts or different. You can create SNMP user accounts that have no
corresponding system account. When you delete a system user account, you must separately delete the
SNMP user account.
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Enabling SNMP
The SNMP daemon is disabled by default.

If you choose to use SNMP, enable and configure it according to your security requirements.

At minimum, you must change the default community string to something other than public.

You can choose to use all versions of SNMP (v1, v2, and v3) on your system, or to grant SNMPv3 access
only.

Best Practice - If your SNMPmanagement station supports SNMP v3, select only
SNMP v3 on your Gaia system. SNMPv3 limits community access. Only requests from
users with enabled SNMPv3 access are allowed, and all other requests are rejected.

Note - If you do not plan to use SNMP to manage the network, disable it. Enabling
SNMP opens potential attack vectors for surveillance activity. It lets an attacker learn
about the configuration of the device and the network.

SNMP Agent Address
An agent address is a specified IP address, on which the SNMP agent listens and reacts to requests.

The default behavior is for the SNMP agent to listen to and react to requests on all interfaces. If you specify
one or more agent addresses, the system SNMP agent listens and responds only on those interfaces.

You can use the agent address as a different method to limit SNMP access. For example: you can limit
SNMP access to one secure internal network that uses a specified interface. Configure that interface as
the only agent address.

SNMP Traps
Managed devices use trap messages to report events to the Network Management Station (NMS).

When some types of events occur, the platform sends a trap to the management station.

The Gaia proprietary traps are defined in the /etc/snmp/GaiaTrapsMIB.mib file.

Gaia supports these types of SNMP traps:

Type of Trap Description

coldStart Notifies when the SNMPv2 agent is re-initialized.

linkUpLinkDown Notifies when one of the links changes state to up or down.

authorizationError Notifies when an SNMP operation is not properly authenticated.

configurationChange Notifies when a change to the system configuration is applied.

configurationSave Notifies when a permanent change to the system configuration occurs.

Table: SNMPTraps in Gaia
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Type of Trap Description

lowDiskSpace Notifies when space on the system disk is low.

Sent if the disk space utilization in the / partition has reached 80 percent
or more of its capacity.

powerSupplyFailure Notifies when a power supply for the system fails.

This trap is supported only on platforms with two power supplies installed
and running.

fanFailure Notifies when a CPU or chassis fan fails.

overTemperature Notifies when the temperature rises above the threshold.

highVoltage Notifies if one of the voltage sensors exceeds its maximum value.

lowVoltage Notifies if one of the voltage sensors falls below its minimum value.

raidVolumeState Notifies if the raid volume state is not optimal.

This trap works only if RAID is supported on the Gaia computer.

To make sure that RAIDmonitoring is supported, run the command
raid_diagnostic and confirm that it shows the RAID status.

biosFailure Notifies when the Primary BIOS failure is detected.

Sent once the event occurs. Applies to computers with Dual BIOS.

vrrpv2AuthFailure Notifies when the VRRPCluster Member has packet an authentication
failure in VRRPv2 (IPv4) and VRRPv3 (IPv6).

Sent each polling interval.

vrrpv2NewMaster Notifies when the VRRPCluster Member transitioned to VRRP Master
state in VRRPv2 (IPv4).

Sent each polling interval.

vrrpv3NewMaster Notifies when the VRRPCluster Member transitioned to VRRPMaster
state in VRRPv3 (IPv6).

Sent each polling interval.

vrrpv3ProtoError Notifies when the VRRPCluster Member has a protocol error in VRRPv2
(IPv4) and VRRPv3 (IPv6).

Sent each polling interval.

Table: SNMPTraps in Gaia (continued)
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Configuring SNMP in Gaia Portal
For detailed information, see sk90860: How to configure SNMP onGaia OS.

To enable SNMP

Step Description

1 In the navigation tree, click System Management >SNMP.

2 Select Enable SNMP Agent.

3 In the Version drop down list, select the version of SNMP to run:

n 1/v2/v3 (any)

Select this option if your SNMPmanagement station does not support SNMPv3.

n v3-Only

Select this option if your SNMPmanagement station supports v3.

SNMPv3 provides a higher level of security than v1 or v2.

4 In SNMP Location String, enter a string that contains the location for the system.

The maximum length for the string is 128 characters.

That includes letters, numbers, spaces, special characters

For example: Bldg 1, Floor 3, WAN Lab, Fast Networks, Speedy, CA

5 In SNMP Contact String, enter a string that contains the contact information for the device.

The maximum length for the string is 128 characters.

That includes letters, numbers, spaces, special characters.

For example: John Doe, Network Administrator, (111) 222-3333

6 Click Apply.

To set an SNMP Agent interface

Step Description

1 In the navigation tree, click System Management >SNMP.

The SNMPAddresses table shows the applicable interfaces and their IP addresses.

2 By default, all interfaces are selected. You can select the individual interfaces.

Note - If you do not specify agent addresses, the SNMP protocol responds to
requests from all interfaces.

http://supportcontent.checkpoint.com/solutions?id=sk90860


Configuring SNMP in Gaia Portal

Gaia R80.40 Administration Guide      |      214

To configure the SNMP community strings

Step Description

1 In the V1/V2 Settings section, in Read Only Community String, set a string other than
public.

You must always use this is a basic security precaution.

2 Optional.

Set a Read-Write Community String.

Warning - Set a read-write community string only if you have reason to enable set
operations, and if your network is secure.
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To add a USM user

Step Description

1 In the navigation tree, click System Management >SNMP.

2 In the V3 - User-Based Security Model (USM) section, click Add.

The Add New USM User window opens.

3 In the User Name, enter the applicable user name that is between 1 and 31 alphanumeric
characters with no spaces, backslash, or colon characters.

This can be the same as a user name for system access.

4 In the Security Level, select one of these options from the drop-down list:

n authPriv - The user has authentication and privacy pass phrases and can connect
with privacy encryption.

n authNoPriv - The user has only an authentication pass phrase and can connect only
without privacy encryption.

5 In the User Permissions, select one of these options from the drop-down list:

n read-only

n read-write

6 In the Authentication Protocol, select one of these options from the drop-down list:

n MD5

n SHA1

The default isMD5.

7 In the Authentication Pass Phrase, enter a password for the user that is between 8 and 128
characters in length.

8 In the Privacy Protocol, select:

n DES

n AES

The default isDES.

9 In the Privacy Pass Phrase, enter a pass phrase that is between 8 and 128 characters in
length.

Used for protection against disclosure of SNMPmessage payloads.

10 Click Save.

The new user shows in the table.
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To delete a USM user

Step Description

1 In the navigation tree, click System Management >SNMP.

2 In the V3 - User-Based Security Model (USM) section, select the user and clickRemove.

The Deleting USM User Entry window opens.

3 The window shows this message:

Are you sure you want to delete "username" entry?.

Click Yes.

To edit a USM user

Step Description

1 In the navigation tree, click System Management >SNMP.

2 In the V3 - User-Based Security Model (USM) section, select the user and click Edit.

The Edit USM User window opens.

3 You can change the Security Level,User Permissions, the Authentication Protocol, the
Authentication Passphrase, or the Privacy Protocol.

4 Click Save.
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To enable or disable SNMP trap types

Step Description

1 In the navigation tree, click System Management >SNMP.

2 In the Enabled Traps section, click Set.

The Add New Trap Receiver window opens.

n To enable a trap:

Select from the Disabled Traps list, and click Add>

n To disable a trap:

Select from the Enabled Traps list, and clickRemove>

3 Click Save.

4 Add a USM user.

You must do this even if you use only SNMPv1 or SNMPv2.

In the Trap User, select an SNMP user.

5 In Polling Frequency, specify the number of seconds between polls.

6 Click Apply.

To configure SNMP trap receivers

Step Description

1 In the navigation tree, click System Management >SNMP.

2 In the Trap Receivers Settings section, click Add.

The Add New Trap Receiver window opens.

3 In the IPv4 Address, enter the IP address of an SNMP receiver.

4 In the Version, select the SNMPVersion for the specified receiver.

5 In the Community String, enter the SNMP community string for the specified receiver.

6 Click Save.
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To edit SNMP trap receivers

Step Description

1 In the navigation tree, click System Management >SNMP.

2 In the Trap Receivers Settings section, select the SNMP receiver and click Edit.

The Edit Trap Receiver window opens.

3 You can change the SNMP version or the SNMP community string.

4 Click Save.

To delete SNMP trap receivers

Step Description

1 In the navigation tree, click System Management >SNMP.

2 In the Trap Receivers Settings section, select the SNMP trap receiver and clickRemove.

The Deleting Trap Receiver Entry window opens.

3 The window shows this message: Are you sure you want to delete "IPv4 address" entry?

Click Yes.
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Configuring SNMP in Gaia Clish
For detailed information, see sk90860: How to configure SNMP onGaia OS.

Best Practice:

For commands that include "auth-pass-phrase", "privacy-pass-phrase", or
both, use the hashed commands.

To get the hashed password, run the "show configuration snmp" command.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Syntax for set commands
Note - To see all available commands:

1. Enter:

set snmp

2. Press <SPACE>

3. Press <ESC><ESC>

Syntax

set snmp agent {on | off}

set snmp agent-version {any | v3-Only}

set snmp clear-trap interval <Value> retries <Value>

set snmp custom-trap <Custom Trap Name> <Property> <Value>

set snmp traps coldStart-threshold <Seconds>

set snmp traps polling-frequency <Seconds>

set snmp traps receiver <IPv4 address> version {v1 | v2 | v3}
community <String>

set snmp traps trap {authorizationError | biosFailure | coldStart |
configurationChange | configurationSave | fanFailure | highVoltage |
linkUpLinkDown | lowDiskSpace | lowVoltage | overTemperature |
powerSupplyFailure | raidVolumeState | vrrpv2AuthFailure |
vrrpv2NewMaster | vrrpv3NewMaster | vrrpv3ProtoError}

set snmp traps trap-user <UserName>

set snmp community <String> {read-only | read-write}

set snmp contact <Contact Information>

set snmp location <Location Information>

set snmp mode {default | vs}

http://supportcontent.checkpoint.com/solutions?id=sk90860
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set snmp usm user <UserName> security-level authPriv auth-pass-
phrase <Pass Phrase> privacy-pass-phrase <Privacy Pass Phrase>
privacy-protocol {DES | AES} authentication-protocol {MD5 | SHA1}

set snmp usm user <UserName> security-level authPriv auth-pass-
phrase-hashed <Hashed Pass Phrase> privacy-pass-phrase <Privacy Pass
Phrase> privacy-protocol {DES | AES} authentication-protocol {MD5 |
SHA1}

set snmp usm user <UserName> security-level authNoPriv auth-pass-
phrase <Pass Phrase> authentication-protocol {MD5 | SHA1}

set snmp usm user <UserName> security-level authNoPriv auth-pass-
phrase-hashed <Hashed Pass Phrase>

set snmp usm user <UserName> {usm-read-only | usm-read-write}

set snmp usm user <UserName> vsid {all | <IDs of allowed Virtual
Devices> }

set snmp vs-direct-access {on | off}

Description of commands

Command Description

set snmp agent-
version {any | v3-
Only}

Configures the supported SNMP version:

n all - support SNMP v1, v2 and v3.

n v3-Only - support SNMP v3 only.

set snmp agent {on |
off}

Enables (on) or disables (off) the SNMPAgent.

set snmp clear-trap
...

Configures the indication of a custom SNMP trap termination.

set snmp community
<String> {read-only
| read-write}

Configures the SNMP community password and if this password
lets you only read the values of SNMP objects (read-only), or set
the values as well (read-write).

set snmp contact ... Configures the contact name for the SNMP community.

set snmp custom-trap
...

Configures the custom SNMP trap.

set snmp location
...

Configures the contact location for the SNMP community.
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Command Description

set snmp mode
{default | vs}

Configures how to run the SNMP daemon:

n default

l On non-VSXGateway, this is the only supported mode.

l On VSXGateway, SNMP daemon runs only in the
context of VS0.

n vs

l For VSXGateway only.

l Each Virtual Device has a separate SNMP daemon
running in the context of that Virtual Device.

set snmp traps
coldStart-threshold
<Seconds>

Configures the threshold for the SNMP coldStart trap.

set snmp traps
polling-frequency
<Seconds>

Configures the polling interval for the SNMP traps.

set snmp traps
receiver ...

Configures the IPv4 address of the SNMPTrap Sink.

set snmp traps trap-
user <UserName>

Configures the user, which will generate the SNMP traps.

set snmp traps trap
...

Configures the Gaia built-in SNMP traps.

set snmp usm user
<UserName> ...

Configures the SNMPv3 USM user.

set snmp vs-direct-
access {on | off}

Enables (on) and disables (off) the SNMP direct queries on the IP
address of a Virtual System (not only VS0), or Virtual Router.

This mode works only when SNMP vsmode is enabled.

See the R80.40 VSX Administration Guide.

Syntax for add commands
Note - To see all available commands:

1. Enter:

add snmp

2. Press <SPACE>

3. Press <ESC><ESC>

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_VSX_AdminGuide/Default.htm
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Syntax

add snmp interface <Name of Interface>

add snmp traps receiver <IPv4 address> version {v1 | v2 | v3}
community <String>

add snmp custom-trap <Custom Trap Name> oid <Value> operator
<Logical Operator> threshold <Value> frequency <Value> message
<Text>

add snmp usm user <UserName> security-level authPriv auth-pass-
phrase <Pass Phrase> privacy-pass-phrase <Privacy Pass Phrase>
privacy-protocol {DES | AES} authentication-protocol {MD5 | SHA1}

add snmp usm user <UserName> security-level authPriv auth-pass-
phrase-hashed <Hashed Pass Phrase> privacy-pass-phrase <Privacy Pass
Phrase> privacy-protocol {DES | AES} authentication-protocol {MD5 |
SHA1}

add snmp usm user <UserName> security-level authNoPriv auth-pass-
phrase <Pass Phrase> authentication-protocol {MD5 | SHA1}

add snmp usm user <UserName> security-level authNoPriv auth-pass-
phrase-hashed <Hashed Pass Phrase>

Description of commands

Command Description

add snmp custom-trap
...

Adds a customer SNMP trap.

add snmp interface
...

Adds a local interface to the list of local interfaces, on which the
SNMP daemon listens.

add snmp traps
receiver ...

Adds a SNMPTrap Sink.

add snmp usm user
...

Adds an SNMPv3 USM user.

Syntax for delete commands
Note - To see all available commands:

1. Enter:

delete snmp

2. Press <SPACE>

3. Press <ESC><ESC>
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Syntax

delete snmp clear-trap

delete snmp traps coldStart-threshold

delete snmp traps polling-frequency

delete snmp traps receiver <IPv4 address>

delete snmp traps trap-user <UserName>

delete snmp custom-trap <Custom Trap Name>

delete snmp community <String>

delete snmp contact <Contact Information>

delete snmp location <Location Information>

delete snmp interface <Name of Interface>

delete snmp usm user <UserName>

Description of commands

Command Description

delete snmp clear-trap Removes the indication of a custom SNMP trap termination.

delete snmp community
<String>

Removes the SNMP community password.

delete snmp contact ... Removes the contact name for the SNMP community.

delete snmp custom-
trap<Custom Trap Name>

Removes the custom SNMP trap.

delete snmp interface
<Name of Interface>

Removes the local interface from the list of local interfaces,
on which the SNMP daemon listens.

delete snmp location ... Removes the contact location for the SNMP community.

delete snmp traps
coldStart-threshold

Removes the threshold for the SNMP coldStart trap.

delete snmp traps
polling-frequency

Removes the polling interval for the SNMP traps.

delete snmp traps
receiver <IPv4 address>

Removes the IPv4 address of the SNMPTrap Sink.

delete snmp traps trap-
user <UserName>

Removes the user, which will generate the SNMP traps.
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Command Description

delete snmp usm user
<UserName>

Removes the SNMPv3 USM user.
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Interpreting SNMP Error Messages
This section lists and explains certain common error status values that can appear in SNMPmessages.

SNMP PDU

Within the SNMPPDU, the third field can include an error-status integer that refers to a specific problem.

The integer zero (0) means that no errors were detected.

When the error field is anything other than 0, the next field includes an error-index value that identifies the
variable, or object, in the variable-bindings list that caused the error.

This table lists the error status codes and their meanings:

Error status code Meaning Error status code Meaning

0 noError 10 wrongValue

1 tooBig 11 noCreation

2 NoSuchName 12 inconsistentValue

3 BadValue 13 resourceUnavailable

4 ReadOnly 14 commitFailed

5 genError 15 undoFailed

6 noAccess 16 authorizationError

7 wrongType 17 notWritable

8 wrongLength 18 inconsistentName

9 wrongEncoding

Note - You might not see the codes. The SNMPmanager or utility interprets the codes
and then logs the appropriate message.

Within the SNMP PDU, the fourth field, contains the error index when the error-status field is nonzero.

That is, when the error-status field returns a value other than zero, which indicates that an error occurred.
The error-index value identifies the variable, or object, in the variable-bindings list that caused the error.
The first variable in the list has index 1, the second has index 2, and so on.
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Within the SNMP PDU, the fifth field, is the variable-bindings field.

This field consists of a sequence of pairs:

n The first element in a pair is the identifier.

n The second element in a pair is one of these options: value, unSpecified, noSuchOjbect,
noSuchInstance, or EndofMibView.

This table describes the elements:

Variable-bindings
element Description

value Value that is associated with each object instance. This value is specified in a
PDU request.

unSpecified ANULL value is used in retrieval requests.

noSuchObject Indicates that the agent does not implement the object, to which it refers by this
object identifier.

noSuchInstance Indicates that this object does not exist for this operation.

endOfMIBView Indicates an attempt to reference an object identifier that is beyond the end of
the MIB at the agent.

GetRequest

This table lists possible value field sets in the response PDU or error-status messages when performing an
SNMP GetRequest.

Value Field Set Description

noSuchObject If a variable does not have an OBJECT IDENTIFIER prefix that exactly matches
the prefix of any variable accessible by this request, its value field is set to
noSuchObject.

noSuch
Instance

If the variable's name does not exactly match the name of a variable, its value field
is set to noSuchInstance.

genErr If the processing of a variable fails for any other reason, the responding entity
returns genErr and a value in the error-index field that is the index of the problem
object in the variable-bindings field.

tooBig If the size of the message that encapsulates the generated response PDU exceeds
a local limitation or the maximum message size of the request's source party, then
the response PDU is discarded and a new response PDU is constructed. The new
response PDU has an error-status of tooBig, an error-index of zero, and an
empty variable-bindings field.
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GetNextRequest

The only values that can be returned as the second element in the variable-bindings field to a
GetNextRequest when an error-status code occurs are unSpecified or endOfMibView.

GetBulkRequest

The GetBulkRequestminimizes the number of protocol exchanges and lets the SNMPv2 manager
request that the response is large as possible.

The GetBulkRequest PDU has two fields that do not appear in the other PDUs: non-repeaters and
max-repetitions. The non-repeaters field specifies the number of variables in the variable-bindings list, for
which a single-lexicographic successor is to be returned. The max-repetitions field specifies the number of
lexicographic successors to be returned for the remaining variables in the variable-bindings list.

If at any point in the process, a lexicographic successor does not exist, the endofMibView value is
returned with the name of the last lexicographic successor, or, if there were no successors, the name of
the variable in the request.

If the processing of a variable name fails for any reason other than endofMibView, no values are
returned. Instead, the responding entity returns a response PDUwith an error-status of genErr and a
value in the error-index field that is the index of the problem object in the variable-bindings field.
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Job Scheduler
You can use Gaia Portal to access cron and schedule regular jobs.

You can configure the jobs to run at the dates and times that you specify, or at startup.
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Configuring Job Scheduler in Gaia Portal
To schedule jobs

Step Description

1 In the navigation tree, click System Management > Job Scheduler.

2 Click Add.

The Add A New Scheduled Jobwindow opens.

3 In the Job Name, enter the name of the job.

Use alphanumeric characters only, and no spaces.

4 In the Command to Run, enter the name of the command.

The command must be a UNIX command.

Note - If you wish to run a Check Point command, then use this syntax (see
sk90441):

source /etc/profile.d/CP.sh ; <your command>

5 Below the Schedule, select the frequency (Daily,Weekly,Monthly, At startup) for this job.

Where applicable, enter the Time of day for the job, in the 24-hour clock format (HH:MM).

6 ClickOK.

The job shows in the Scheduled Jobs table.

7 In the E-mail Notification, enter the e-mail address, to which Gaia should send the
notifications.

Note - You must also configure a Mail Server (see "Mail Notification" on page 234).

8 Click Apply.

http://supportcontent.checkpoint.com/solutions?id=sk90441
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To delete scheduled jobs

Step Description

1 In the navigation tree, click System Management > Job Scheduler.

2 In the Scheduled Jobs table, select the job to delete.

3 ClickDelete.

4 ClickOK to confirm.

(ClickCancel to abort.)

To edit the scheduled jobs

Step Description

1 In the navigation tree, click System Management > Job Scheduler.

2 In the scheduled Jobs table, select the job that you want to edit.

3 Click Edit.

The Edit Scheduled Job opens.

4 Enter the changes.

5 ClickOK.
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Configuring Job Scheduler in Gaia Clish

Description

Use these commands to configure your system to schedule jobs. The jobs run on the dates and times you
specify.

You can define an email address, to which Gaia sends the output of the scheduled job.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Syntax

To add scheduled jobs

add cron job <Job Name> command <Command> recurrence
daily time <HH:MM>
monthly month <1-12> days <1-31> time <HH:MM>
weekly days <1-31> time <HH:MM>
system-startup

To change existing scheduled jobs

set cron job <Job Name>
command <Command>
recurrence

daily time <HH:MM>
monthly month <1-12> days <1-31> time <HH:MM>
weekly days <1-31> time <HH:MM>
system-startup

set cron mailto <Email Address>

To monitor configured scheduled jobs

show cron
job <Job Name>

command
recurrence

jobs
mailto

To delete scheduled jobs

delete cron
all
job <Job Name>
mailto

Note - Only the show commands provide an output.
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Parameters

CLI Parameters

Parameter Description

<Job Name> The name of the job that will be scheduled.

<Command> The command that will be scheduled.

recurrence daily time
<HH:MM>

Specifies that the job should run once a day - every day, at
specified time.

Enter the time of day in the 24-hour clock format -
<Hours>:<Minutes>.

Example: 14:35

recurrence monthly month
<1-12> days <1-31> time
<HH:MM>

Specifies that the job should run once a month - on
specified months, on specified dates, and at specified
time.

Months are specified by numbers from 1 to 12:

n January = 1
n February = 2
n ...
n December = 12

Dates of month are specified by numbers from 1 to 31.

To specify several consequent months, enter their
numbers separate by commas.

Example: For January, February, and March, enter
1,2,3

To specify several consequent dates, enter their numbers
separate by commas.

Example: For 1st, 2nd and 3rd day of the month, enter
1,2,3
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Parameter Description

recurrence weekly days <1-
31> time <HH:MM>

Specifies that the job should run once a week - on
specified days of week, and at specified time.

Days of week are specified by numbers from 0 to 6:

n Sunday = 0
n Monday = 1
n Tuesday = 2
n Wednesday = 3
n Thursday = 4
n Friday = 5
n Saturday = 6

To specify several consequent days of a week, enter their
numbers separate by commas.

Example: For Sunday, Monday, and Tuesday, enter
0,1,2

recurrence system-startup Specifies that the job should at every system startup.

mailto <Email Address> Specifies the email address, to which Gaia sends the jobs'
results.

Enter one email address for each command. You must
also configure a mail server (see "Mail Notification" on
page 234).
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Mail Notification
In This Section:

Introduction 234

Configuring Mail Notification in Gaia Portal 234

Configuring Mail Notification in Gaia Clish 235

Introduction
Mail notifications (also known as Mail Relay) allow you to send email from the Security Gateway.

You can send email interactively or from a script. The email is relayed to a mail hub that sends the email to
the final recipient.

Mail notifications are used as an alerting mechanism when a Firewall rule is triggered. It is also used to
email the results of cron jobs to the system administrator.

Gaia supports these mail notification features:

n Presence of a mail client or Mail User Agent (MUA) that can be used interactively or from a script.

n Presence of a Sendmail-like replacement that relays mail to a mail hub by using SMTP.

n Ability to specify the default recipient on the mail hub.

Gaia does not support these mail notification features:

n Incoming e-mail.

n Mail transfer protocols other than outbound SMTP.

n Telnet to port 25.

n E-mail accounts other than admin ormonitor.

Configuring Mail Notification in Gaia Portal

Step Description

1 In the navigation tree, click System Management >Mail Notification.

2 In theMail Server field, enter the IPv4 Address or Hostname of the mail server.

For example: mail.example.com

3 In the User Name field, enter the user name.

For example: user@mail.example.com

4 Click Apply.
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Configuring Mail Notification in Gaia Clish

Description

Use this group of commands to configure mail notifications.

Syntax

n To configure the mail server that receives the mail notifications:

set mail-notification server <IPv4 Address or Hostname>

n To configure the user on the mail server that receives the mail notifications:

set mail-notification username <User Name>

n To show the configured mail server and user:

show mail-notification
server
username

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

Parameter Description

server <IPv4 Address or
Hostname>

The IPv4 address or Hostname of the mail server, to which Gaia
sends mail notifications.

Example: mail.company.com

username <User Name> The username on the mail server that receives the admin or
monitormail notifications.

Example: johndoe

Example

gaia> set mail-notification server mail.company.com

gaia> set mail-notification username johndoe

gaia> show mail-notification server

Mail notification server: mail.company.com

gaia> show mail-notification username

Mail notification user: johndoe
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Messages
In This Section:

Comparison 236

Configuring Messages in Gaia Portal 236

Configuring Messages in Gaia Clish 237

Limits 239

You can configure Gaia to show a Banner Message and aMessage of the Day to users when they log in.

Comparison

Banner Message Message of the Day

Default Message This system is for authorized
use only

You have logged into
the system

When shown in
Gaia Portal

Browser login page, before logging in After logging in to the system

When shown in
Gaia Clish

When logging in, before entering the
password

After logging in to the system

Default state Enabled Disabled

Configuring Messages in Gaia Portal

Step Description

1 In the navigation tree, click System Management >Messages.

2 To enter a Banner message, select Banner message.

3 To enter a Message of the Day, selectMessage of the day.

4 Enter the message text.

See the Limits section below.

5 Click Apply.
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Configuring Messages in Gaia Clish
Syntax for Banner message

n To show if the banner message is enabled or disabled:

show message banner status

show message all status

n To show the configured banner message:

show message banner

show message all

n To define a new single-line banner message:

set message banner on msgvalue <Banner Text>

See the Limits section below.

Example:

gaia> set message banner on msgvalue "This system is private and
confidential"

n To define a newmulti-line banner message:

set message banner on line msgvalue <Banner Text for Line #1>

set message banner on line msgvalue <Banner Text for Line #2>

n To enable or disable the configured banner message:

set message banner on

set message banner off

n To delete the configured banner message perform these two steps:

1. Delete the user-defined banner message:

delete message banner

Note - This deletes the configured banner message, and replaces it
with the default banner message "This system is for
authorized use only."

2. Disable the default banner:

set message banner off
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Syntax for Message of the Day

n To show the configured message of the day:

show message motd

show message all

n To show if the message of the day is enabled or disabled:

show message motd status

show message all status

n To define a new single-line message of the day:

set message motd on msgvalue <Message Text>

See the Limits section below.

Example:

gaia> set message motd on msgvalue "Hi all - no changes allowed
today"

n To define a newmulti-line message of the day:

set message motd on line msgvalue <Message Text for Line #1>

set message motd on line msgvalue <Message Text for Line #2>

See the Limits section below.

n To enable or disable the configured message of the day:

set message motd on

set message motd off

n To delete the configured message of the day, perform these two steps:

1. Delete the user-defined message of the day:

delete message motd

Note - This deletes the configured message of the day, and replaces it
with the default message of the day "You have logged into
the system."

2. Disable the default message of the day:

set message motd off
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Limits

Message type

Maximal supported
total number
of characters
in the message

Maximal supported
total number
of lines
in the message

Maximal supported
number of
characters
in each line

Banner 1600 20 80

Message of the day 1200 20 400
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Display Format
In This Section:

Configuring Display Format in Gaia Portal 240

Configuring Display Format in Gaia Clish 241

You configure format for the Time, Date, and IPv4 netmask on Gaia.

Configuring Display Format in Gaia Portal

Step Description

1 In the navigation tree, click System Management >Display Format.

2 In Time, select one of these options:

n 12-hour

n 24-hour

3 In Date, select one of these options:

n dd/mm/yyyy

n mm/dd/yyyy

n yyyy/mm/dd

n dd-mmm-yyyy

4 In IPv4 netmask, select one of these options:

n Dotted-decimal notation

n CIDR notation

5 Click Apply.
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Configuring Display Format in Gaia Clish

Syntax for the Time

n To show the current time format:

show format time

show format all

n To configure the time format:

set format time
12-hour
24-hour

Syntax for the Date

n To show the current date format:

show format date

show format all

n To configure the date format:

set format date
dd/mm/yyyy
mm/dd/yyyy
yyyy/mm/dd
dd-mmm-yyyy

Syntax for the IPv4 netmask

n To show the current IPv4 netmask format:

show format netmask

show format all

n To configure the IPv4 netmask format:

set format netmask
dotted
length
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Session
You can manage inactivity timeout for Gaia Portal and Gaia Clish.

Configuring the Session in Gaia Portal

Step Description

1 In the navigation tree, click System Management > Session.

2 In the Command Line Shell section, configure the inactivity timeout for the Gaia Clish.

3 In theWeb UI section, configure the inactivity timeout for the Gaia Portal.

n Range: 1 - 720 minutes

n Default: 10 minutes

Configuring the Session in Gaia Clish

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Syntax

n To configure the timeout:

set inactivity-timeout <Timeout>

n To show the configured timeout:

show inactivity-timeout

Parameters

Parameter Description

<Timeout> The inactivity timeout (in minutes) for the Gaia Clish.

n Range: 1 - 720 minutes

n Default: 10 minutes
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Core Dumps
In This Section:

Introduction 243

Configuring Core Dumps in Gaia Portal 243

Configuring Core Dumps in Gaia Clish 245

Introduction
A process core dump file consists of the recorded status of the working memory of the Gaia computer at
the time that a Gaia process terminated abnormally.

When a process terminates abnormally, it produces a core dump file in the
/var/log/dump/usermode/ directory.

If the /log partition has less than 200 MB, no core dumps are created, and all core dumps are deleted to
create space. This prevents the core dump files from filling the /log partition.

Configuring Core Dumps in Gaia Portal
To configure core dumps, enable the feature and then configure parameters.

Procedure

Step Description

1 In the navigation tree, click System Management >Core Dumps.

2 Configure the parameters.

3 Click Apply.
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Parameters

Parameter Description

Total space limit The maximum amount of disk space in MB that is used for storing core dumps.

If disk space is required for a core dump, the oldest core dump is deleted.

The per-process limit is enforced before the space limit.

n Range: 1 - 99999 MB

n Default: 1000 MB

Dumps per
process

The maximum number of dumps that are stored for each process executable
(program) file.

A new core dump overwrites the oldest core dump.

The per-process limit is enforced before the space limit.

n Range: 1 - 99999

n Default: 2

Example

There are two programs "A" and "B", and the per-process limit is limit is 2.

Program "A" terminates 1 time and program "B" terminates 3 times.

The core dumps that remain are:

n 1 core dump for program "A"

n 2 core dumps for program "B"

n Core dump 3 for program "B" is deleted because of the per-process limit.
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Configuring Core Dumps in Gaia Clish
Syntax

n To enable or disable core dumps:

set core-dump {enable | disable}

n To set the total disk space usage limit in MB:

set core-dump total <0-99999>

n To set the number of core dumps per process:

set core-dump per_process <0-99999>

n To show the total disk space usage limit:

show core-dump total

n To show the number of core dumps per process:

show core-dump per_process

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

Parameter Description

total <0-
99999>

The maximum amount of space that is used for core dumps. If space is
required for a dump, the oldest dump is deleted.

The per-process limit is enforced before the space limit.

n Range: 1 - 99999 MB

n Default: 1000 MB

per_process
<0-99999>

The maximum number of core dumps that are stored for each process
executable (program) file.

A new core dump overwrites the oldest core dump.

The per-process limit is enforced before the space limit.

n Range: 1 - 99999

n Default: 2

Example

There are two programs "A" and "B", and the per-process limit is limit is 2.

Program "A" terminates 1 time and program "B" terminates 3 times.

The core dumps that remain are:

n 1 core dump for program "A"

n 2 core dumps for program "B"

n Core dump 3 for program "B" is deleted because of the per-process
limit.
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System Configuration
In This Section:

Configuring IPv6 Support in Gaia Portal 248

Configuring IPv6 Support in Gaia Clish 248

Important:

n Security Management Server R80.40 does not support IPv6 Address on Gaia
Management Interface (Known Limitation 01622840).

n Multi-Domain Server R80.40 does not support IPv6 at all (Known Limitation
PMTR-14989).

Before you can configure IPv6 addresses and IPv6 static routes, you must:

Step Description

1 Enable the IPv6 support.

2 Reboot.

3 To configure IPv6 addresses, see "Network Interfaces" on page 81.

To configure IPv6 static routes, see "IPv6 Static Routes" on page 172.

To enforce a Security Policy for IPv6 traffic:

Step Description

1 Enable the IPv6 support in Gaia OS on both the Security Management Server and the Security
Gateway (each Cluster Member).

2 Connect with SmartConsole to the Management Server.

3 Create the applicable IPv6 objects.

4 Create the applicable IPv6 rules in the Access Control Policy.

5 Install the Access Control Policy on the Security Gateway (the Cluster) object.
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Configuring IPv6 Support in Gaia Portal

Step Instructions

1 With a web browser, connect to Gaia Portal at:

https://<IP address of Gaia Management Interface>

2 From the navigation tree, click System Management > System Configuration.

3 In the IPv6 Support section, selectOn.

4 Click Apply.

5 When prompted, select Yes to reboot.

Important - IPv6 support is not available until you reboot.

Configuring IPv6 Support in Gaia Clish
n To configure IPv6 support:

set ipv6-state {on | off}

Important - This change requires reboot.

n To show the state of IPv6 support:

show ipv6-state

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Procedure

Step Instructions

1 Connect to the command line on the Gaia computer.

2 Log in to Gaia Clish.
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Step Instructions

3 Enable the IPv6 support:

set ipv6-state on

4 Save the changes:

save config

5 Reboot:

reboot

Important - IPv6 support is not available
until you reboot.
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System Logging
You can configure the settings for the system logs, including sending them to a remote server.

Make sure to configure the remote server to receive the system logs.
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Configuring System Logging in Gaia Portal
This section includes procedures for configuring System Logging and Remote System Logging.

System Logging configures if Gaia sends these logs:

n Gaia syslog messages to its Check Point Management Server

n Gaia audit logs upon successful configuration to its Check Point Management Server

n Gaia audit logs upon successful configuration to Gaia syslog facility

Remote System Logging configures a remote syslog server, to which Gaia sends its syslog messages.

Note - There are some command options and parameters, which you cannot configure in the Gaia Portal.

To configure System Logging

Step Description

1 In the navigation tree, click System Management >System Logging.

2 In the System Logging section, select the applicable options:

n Send Syslog messages to management server

Specifies if the Gaia sends the Gaia system logs to a Check Point Management
Server.

Default:Not selected

Note - You can configure this option in Gaia Clish with the "set syslog cplogs
{on | off}" command.

n Send audit logs to management server upon successful configuration

Specifies if the Gaia sends the Gaia audit logs (for configuration changes that
authorized users make) to a Check Point Management Server.

Default: Selected

Note - You can configure this option in the Gaia Clish with the "set syslog
mgmtauditlogs {on | off}" command.

n Send audit logs to syslog upon successful configuration

Specifies if the Gaia saves the logs for configuration changes that authorized users
make.

Otherwise, Gaia uses the default /var/log/messages file.

Default: Selected

To specify a Gaia configuration audit log file, run this command:

set syslog filename </<Path>/<File>>

Note - This option is configured in the Gaia Clish with the "set syslog auditlog
{disable | permanent}" command.
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Step Description

3 Click Apply.

To configure Remote System Logging

Step Description

1 In the navigation tree, click System Management >System Logging.

2 In the Remote System Logging section, click Add.

3 In the IP Address field, enter the IPv4 address of the remote syslog server.

4 In the Priority field, select the severity level of the logs that are sent to the remote server.

These are the accepted values (as defined by the RFC 5424 - Section-6.2.1):

n All - All messages

n Debug - Debug-level messages

n Info - Informational messages

n Notice - Normal but significant condition

n Warning - Warning conditions

n Error - Error conditions

n Critical - Critical conditions

n Alert - Action must be taken immediately

n Emergency - System is unusable

5 ClickOK.

Important - Do not to configure two Gaia computers to send system logs to each
other - directly, or indirectly. Such configuration creates a syslog forwarding loop,
which causes all syslog message to repeat indefinitely on both Gaia computer.
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To edit Remote System Logging settings

Step Description

1 In the navigation tree, click System Management >System Logging.

2 In the Remote System Logging section, select the remote server.

3 Click Edit.

4 In the IP Address field, enter the IPv4 address of the remote syslog server.

5 In the Priority field, select the severity level of the logs that are sent to the remote server.

6 ClickOK.

To delete Remote System Logging settings

Step Description

1 In the navigation tree, click System Management >System Logging.

2 In the Remote System Logging section, select the remote syslog server.

3 ClickDelete.

4 In the confirmation window, click Yes.
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Configuring System Logging in Gaia Clish

Description

You can configure the System Logging and Remote System Logging.

System Logging configures the Gaia to sends these logs:

n Gaia syslog messages to its Check Point Management Server

n Gaia audit logs upon successful configuration to its Check Point Management Server

n Gaia audit logs upon successful configuration to Gaia syslog facility

Remote System Logging configures a remote server, to which Gaia sends its syslog messages.\

Note - There are some command options and parameters, which you cannot configure
in the Gaia Portal.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Syntax for System Logging configuration

n To send the Gaia system logs to a Check Point Management Server:

set syslog cplogs {on | off}

n To send the Gaia configuration audit logs to a Check Point Management Server:

set syslog mgmtauditlogs {on | off}

n To save the Gaia configuration audit logs:

set syslog auditlog {disable | permanent}

n To configure the file name of the Gaia configuration audit log:

set syslog filename /<Path>/<File>

n To show the Gaia system logging configuration:

show syslog
all
auditlog
cplogs
filename
mgmtauditlogs
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Syntax for Remote System Logging configuration

n To send Gaia system logs to a remote syslog server:

add syslog log-remote-address <IPv4 Address> level <Severity>

n To show the Gaia system logging configuration:

show syslog
all
log-remote-address <IPv4 Address>
log-remote-addresses

n To stop sending Gaia system logs to the specific remote server:

delete syslog log-remote-address <IPv4 Address> [level
<Severity>]

CLI Parameters

Parameter Description

cplogs {on |
off}

Specifies if the Gaia sends the Gaia system logs to a Check Point
Management Server:

n on - Send Gaia system syslogs

n off - Do not send Gaia syslogs

Default: off

Note - This command corresponds to the Send Syslog messages
to management server option in the Gaia Portal >System
Management >System Logging.

mgmtauditlogs
{on | off}

Specifies if the Gaia sends the Gaia audit logs (for configuration changes that
authorized users make) to a Check Point Management Server:

n on - Send Gaia audit logs

n off - Do not send Gaia audit logs

Default: on

Note - This command corresponds to the Send audit logs to
management server upon successful configuration option in the
Gaia Portal >System Management >System Logging.
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Parameter Description

auditlog
{disable |
permanent}

Specifies if the Gaia saves the logs for configuration changes that authorized
users make:

n disable - Disables the Gaia audit log facility

n permanent - Enables the Gaia audit log facility to save information
about all successful changes in the Gaia configuration. To specify a
destination file, run the set syslog filename </Path/File>
command (otherwise, Gaia uses the default /var/log/messages
file).

Default: permanent

Note - This command corresponds to the Send audit logs to syslog
upon successful configuration option in the Gaia Portal >System
Management >System Logging.

/<
Path>/<File>

Configures the full path and file name of the system log.

Default: /var/log/messages

Note in Gaia Portal does not let you configure this setting.

log-remote-
address

Configures Gaia to send system logs to a remote syslog server.

Important - Do not configure two Gaia computers to send system
logs to each other - directly, or indirectly. Such configuration creates
a syslog forwarding loop, which causes all syslog messages to
repeat indefinitely on both Gaia computers.

Note - This command corresponds to the Gaia Portal >System
Management >Remote System Logging.

<IPv4
Address>

IPv4 address of the remote syslog server, to which Gaia sends its system logs.

n Range:Dotted-quad ([0-255].[0-255].[0-255].[0-255])

n Default:No default value
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Parameter Description

<Severity> Syslog severity level for the system logging.

These are the accepted values (as defined by the RFC 5424 - Section-6.2.1):

n emerg - System is unusable

n alert - Action must be taken immediately

n crit - Critical conditions

n err - Error conditions

n warning - Warning conditions

n notice - Normal but significant condition

n info - Informational messages

n debug - Debug-level messages

n all - All messages

Notes:

n Until you configure at least one severity level for a given
remote server, Gaia does not send syslog messages.

n If you specify multiple severities, the most general least
severe severity always takes precedence.
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Example

gaia> set syslog auditlog permanent

gaia> set syslog filename /var/log/system_logs.txt

gaia> set syslog mgmtauditlogs on

gaia> set syslog cplogs on

gaia> set syslog log-remote-address 192.168.2.1 level all

gaia> show syslog all
Syslog Parameters:

Remote Address 192.168.2.1
Levels all

Auditlog permanent
Destination Log Filename /var/log/system_logs.txt

gaia>

gaia>show syslog auditlog
permanent
gaia>

gaia> show syslog cplogs
Sending syslog syslogs to Check Point's logs is enabled
gaia>

gaia> show syslog mgmtauditlogs
Sending audit logs to Management Serever is enabled
gaia>

gaia> show syslog filename
/var/log/system_logs.txt
gaia>
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Redirecting RouteD System Logging Messages
By default, Gaia writes the RouteD syslog messages (for example, OSPF or BGP errors) to the
/var/log/messages file.

You can configure Gaia to write the RouteD syslog messages to the /var/log/routed_messages file
instead.

This configuration does not require restart of the RouteD daemon, or reboot.

For more information, see sk116436.

To configure the redirection in the Gaia Portal

Step Description

1 In the navigation tree, click Advanced Routing >Routing Options.

2 In the Routing Process Message Logging Options section, select Log Routed Separately.

3 In theMaximum File Size field, enter the size (in megabytes) for each log file.

The default is 1 MB.

When this maximum size is reached, the current /var/log/routed_messages file is
rotated, and the new /var/log/routed_messages file is created.

4 In theMaximum Number of Files field, enter the maximal number of log files to keep.

The default is 10 log files:

n /var/log/routed_messages

n /var/log/routed_messages.0

n /var/log/routed_messages.1

n ...

n /var/log/routed_messages.9

If the maximum number of files is reached, the oldest file is deleted, and the existing files are
rotated.

Files are named with a number suffix - the greater the suffix number, the older the file.

5 Click Apply.

http://supportcontent.checkpoint.com/solutions?id=sk116436
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To configure the redirection in Gaia Clish

Step Description

1 Connect to the command line on Gaia.

2 Log in to Gaia Clish.

3 Enable separate logging of RouteDmessages:

set routedsyslog on

4 Configure the size (in megabytes) for each log file:

set routedsyslog size <Number of MB between 1 and 2047>

The default is 1 MB.

When this maximum size is reached, the current /var/log/routed_messages file is
rotated, and the new /var/log/routed_messages file is created.

5 Configure the maximal number of log files to keep:

set routedsyslog maxnum <Number of Files between 1 and
4294967295>

The default is 10 log files:

n /var/log/routed_messages

n /var/log/routed_messages.0

n /var/log/routed_messages.1

n ...

n /var/log/routed_messages.9

If the maximum number of files is reached, the oldest file is deleted, and the existing files are
rotated.

Files are named with a number suffix - the greater the suffix number, the older the file.

6 Save the configuration:

save config
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To examine the configuration in CLI

You can examine the configuration in either Gaia Clish, or the Expert mode.

She
ll Command Expected output

Gai
a
Clis
h

show
configurat
ion
routedsysl
og

n If default values were used for "maxnum" and "size":

set routedsyslog on

n If custom values were configured for "maxnum" and "size":

set routedsyslog on
set routedsyslog maxnum <Configured_Value>
set routedsyslog size <Configured_Value>

Exp
ert
mo
de

grep
routedsysl
og
/config/ac
tive

n If default values were used for "maxnum" and "size":

routed:instance:default:routedsyslog t

n If custom values were configured for "maxnum" and "size":

routed:instance:default:routedsyslog t
routed:instance:default:routedsyslog:size
<Configured_Value>
routed:instance:default:routedsyslog:files
<Configured_Value>
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Configuring Log Volume
If there is enough available disk space, you can increase the size of the log partition.

Note - Disk space is added to the log volume by subtracting it from the disk space used
to store Gaia backup images.

Use the lvm_manager tool in the Expert mode.

Step Description

1 Connect to the Gaia system over console.

2 Reboot:

reboot

3 During boot, press any key to enter the Boot menu.

Note - You have approximately 5 seconds.

4 Select Start in maintenance mode.

5 Enter the Expert mode password.

6 Use the interactive lvm_manager tool as described in the sk95566:

lvm_manager

7 Reboot:

reboot

http://supportcontent.checkpoint.com/solutions?id=sk95566
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Network Access

Introduction
Telnet is not recommended for remote login, because it is not secure.

SSH, for example, provides much of the functionality of Telnet with good security.

Network access to Gaia using Telnet is disabled by default. You can allow Telnet access.

Configuring Telnet Access in Gaia Portal

Step Description

1 In the navigation tree, click System Management > Network Access.

2 Select Enable Telnet.

3 Click Apply.

Configuring Telnet Access in Gaia Clish

Syntax

n To configure Telnet access:

set net-access telnet {on | off}

n To show the configured Telnet access:

show net-access telnet

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Host Access
You can configure hosts or networks that are allowed to connect to the Gaia Portal or Gaia Clish on the
Gaia device.

Configuring Allowed Gaia Clients in Gaia Portal

Step Description

1 In the navigation tree, click System Management > Host Access.

2 Click Add.

The Add a New Allowed Clientwindow opens.

3 Select one of these options:

n Any host - All remote hosts can access the Gaia Portal, or
Gaia Clish.

n Host - Enter the IPv4 address of one host.

n Network - Enter the IPv4 address of a network and subnet
mask.

4 ClickOK.
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Configuring Allowed Gaia Clients in Gaia Clish

Syntax

n To add an allowed client:

add allowed-client
host

any-host
ipv4-address <Host IPv4 Address>

network ipv4-address <Network IPv4 Address> mask-length <1-
31>

n To show the configured allowed clients:

show allowed-client all

n To delete an allowed client:

delete allowed-client
host

any-host
host ipv4-address <Host IPv4 Address>

network ipv4-address <Network IPv4 Address>

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

Parameter Description

<Host IPv4 Address> The IPv4 address of the allowed host in dotted decimal format
(X.X.X.X)

<Network IPv4
Address>

The IPv4 address of the allowed network in dotted decimal format
(X.X.X.X)

Example

gaia> add allowed-client host any-host
gaia> show allowed-client all
Type Address Mask
Length
Host Any
gaia>
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Advanced Routing
Dynamic Routing is fully integrated into the Gaia Portal and Gaia Clish.

BGP, OSPF and RIP are supported.

Dynamic Multicast Routing is supported, with PIM (Sparse Mode (SM), Dense Mode (DM), Source-Specific
Multicast (SSM), and IGMP.

To learn about dynamic routing, see the R80.40Gaia Advanced Routing Administration Guide.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_Advanced_Routing_AdminGuide/Default.htm
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User Management
This chapter describes how to manage passwords, user accounts, roles, authentication servers, system
groups, and Gaia Portal clients.

Note - When a user logs in to Gaia, the Gaia Portal navigation tree displayed and Gaia
Clish commands that are available depend on the role or roles assigned to the user. If
the user's roles do not provide access to a feature, the user does not see the feature in
the Gaia Portal navigation tree or in the list of commands. If the user has read-only
access to a feature, they can see the Gaia Portal page, but the controls are disabled.
Similarly, the user can run "show commands, but not "set", "add" or "delete"
commands.



Change My Password

Gaia R80.40 Administration Guide      |      268

Change My Password
AGaia user can change their Gaia password.

Changing My Password in Gaia Portal

Step Description

1 In the navigation tree, clickUser Management >Change My Password.

2 In theOld Password field, enter your old password.

3 In the New Password field, enter the new password.

4 In the Confirm New Password field, enter the new password again.

5 Click Apply.

Changing My Password in Gaia Clish

Description

Change your own Gaia password, in an interactive dialog.

Syntax

set selfpasswd

Warning - We do not recommend to use this command:

set selfpasswd oldpass <Old Password> passwd <New
Password>

This is because the passwords are stored as plain text in the command history.

Instead, use the "set selfpasswd" command.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Users
Use the Gaia Portal and Gaia Clish to manage user accounts.

You can:

n Add users to your Gaia system.

n Edit the home directory of the user.

n Edit the default shell for a user.

n Give a password to a user.

n Give privileges to users.

These users are created by default and cannot be deleted:

User Description

admin Has full read/write capabilities for all Gaia features, from the Gaia Portal and the Gaia Clish.

This user has a User ID of 0, and therefore has all of the privileges of a root user.

monitor Has read-only capabilities for all features in the Gaia Portal and the Gaia Clish, and can
change its own password.

You must give a password for this user before the account can be used.

New users have read-only privileges to the Gaia Portal and the Gaia Clish by default.

You must assign one or more roles before the new users can log in.

Notes:

n You can assign permissions to all Gaia features or a subset of the features
without assigning a user ID of 0.

If you assign a user ID of 0 to a user account (you can do this only in the Gaia
Clish), the user is equivalent to the Admin user and the roles assigned to that
account cannot be modified.

n Do not define a new user for external users.

An external user is one that is defined on an authentication server (such as
RADIUS or TACACS), and not on the local Gaia system.

When you create a user, you can add pre-defined roles (privileges) to the user. For more information, see
"Roles" on page 278.

Warning - A user with read and write permission to the Users feature can change the
password of another user, or an admin user. Therefore, write permission to the Users
feature should be assigned with caution.
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Managing User Accounts in Gaia Portal
To see a list of all configured users

In the navigation tree, clickUser Management > Users.

You can also see your username in the top right corner of the Gaia Portal.

To add a new user

Step Description

1 In the navigation tree, clickUser Management > Users.

2 Click Add.

3 In the Login Name field, enter the username.

The valid characters (between 1 and 32 characters) are alphanumeric characters, dash (-),
and underscore (_).

4 In the Password field, enter the user's password.

All printable characters are allowed. Length is between 6 and 128 characters.

Important - Do not use the asterisk (*) character in the password. User with such
password will not be able to log in.

5 In the Confirm Password field, enter the user's password again.

6 In the Real Name field, enter the user's real name or other informative text.

This is an alphanumeric string that can contain spaces.

The default is the user's Login Name with capitalized first letter.

7 In the Home Directory field, enter the user's home directory.

This is the full Linux path name of a directory, to which the user will log in.

Must be a sub-directory of /home/ directory.

If the sub-directory does not already exist, it is created.

8 In the Shell field, select the user's default login shell.

See the explanations in the "Login Shells" section.

9 SelectUser must change password at next logon, if you wish to force the user to change
the configured password during the next login.

Note - If the user does not log in within the time limit configured in the Gaia Portal >
User Management >Password Policy page >Mandatory Password Change
section > Lockout users after password expiration > Lockout user after X days,
the user may not be able to log in at all.
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Step Description

10 Optional: In the UID field, enter or select the applicable User ID:

n 0 for administrator users (this is the default option)

n An integer between 103 and 65533 for non-administrator users

11 In the Access Mechanisms section:

n SelectWeb to allow this user to access Gaia Portal.

n SelectClish Access to allow this user to access Gaia Clish.

12 In the Available Roles list:

a. Select the roles you wish to assign to this user.

To select several roles:

i. Press and hold the CTRL key on the keyboard.

ii. Left-click the applicable roles. The selected roles become highlighted.

b. Click Add >. The selected roles move to the Assigned Roles list.

13 ClickOK.

Login Shells

Shell Description

/etc/cli.sh This is the default option.

Lets the user work with the full Gaia Clish.

By default, some basic networking commands (such as ping) are also
available.

The Extended Commands in the assigned roles makes it possible to add
more Linux commands that can be used (see "List of Available Extended
Commands in Roles" on page 304).

User can run the expert command to enter the Bash shell (Expert
mode).

/bin/bash BASH Linux shell.

Lets the user work with the Expert mode.

User can run the clish command to enter the Gaia Clish.

/bin/csh CSH Linux shell.

User can run the clish command to enter the Gaia Clish.

/bin/sh SH Linux shell.

User can run the clish command to enter the Gaia Clish.
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Shell Description

/bin/tcsh TCSH Linux shell.

User can run the clish command to enter the Gaia Clish.

/usr/bin/scponly User is not allowed to log in to Gaia.

User can only connect to Gaia over SCP and transfer files to and from the
system. Other commands are forbidden.

/sbin/nologin User is not allowed to log in to Gaia.

/bin/p1shell Obsolete. Do not use this option anymore.

Important - The p1shell is not supported (Known Limitation
PMTR-45085).

To change a user configuration

Step Description

1 In the navigation tree, clickUser Management > Users.

2 Select the user.

3 Click Edit.

4 In the Real Name field, enter the user's real name or other informative text.

5 In the Home Directory field, enter the user's home directory.

6 In the Shell field, select the user's default login shell.

7 SelectUser must change password at next logon, if you wish to force the user to change
the configured password during the next login.

8 In the Available Roles list, select the roles you wish to assign to this user and click Add >.

9 In the Assigned Roles list, select the roles you wish to remove from this user and click
Remove >.

10 ClickOK.

Note - For the default users admin and monitor, you can only change the Shell and Roles.
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To delete a user

Step Description

1 In the navigation tree, clickUser Management > Users.

2 Select the user.

3 ClickDelete.

4 ClickOK to confirm.

Note - You cannot delete the default users admin and monitor.
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Managing User Accounts in Gaia Clish
Note - You can use the "add user" command to add new users, but you must use the
"set user <username> password" command to set the password and allow the
user to log on to the system.

Syntax

To add a local user account

add user <UserName> uid <User ID> homedir <Path>

To add a RADIUS user account

add user <UserName> uid 0 homedir <Path>

To modify a user account

set user <UserName>

      force-password-change {yes | no}

      gid <System Group ID>

      homedir <Path>

      lock-out off

      newpass <Password>

      password

      password-hash <Password Hash>

      realname <Name>

      shell <Login Shell>

      uid <User ID>}

To show summary information about all users

show users
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To shows information about a specific user

show user <UserName>

[force-password-change]

[gid]

[homedir]

[lock-out]

[realname]

[shell>]

[uid]

To delete a configured user

delete user <User ID>

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

CLI Parameters

Parameter Description

user <UserName> Configures unique login username - an alphanumeric string, from 1 to 32
characters long, that can contain dashes (-) and underscores (_), but not
spaces.

uid <User ID> Optional. Configures unique User ID to identify permissions of the user:

n 0 for administrator users and RADIUS user account (this is the
default option)

n An integer between 103 and 65533 for non-administrator user

Note - If a value is not specified, Gaia OS automatically
assigns the next free sequential number.

homedir <Path> Configures user's home directory.

This is the full Linux path name of a directory, to which the user will log in.

Must be a sub-directory of /home/ directory.

If the sub-directory does not already exist, it is created.
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Parameter Description

force-password-
change {yes |
no}

If you wish to force the user to change the configured password during the
next login, set the value to yes.

Note - If the user does not log in within the time limit configured by
the "set password-controls expiration-lockout-
days" command, the user may not be able to log in at all.

gid <System
Group ID>

Configures System Group ID (0-65535) for the primary group, to which a
user belongs.

The default is 100.

You can add the user to several groups.

Use the "add group" and "set group" commands to manage the
groups.

lock-out off Unlocks the user, if the user was locked-out.

The password expiration date is adjusted, if necessary.

newpass
<Password>

Configures a new password for the user.

Gaia does not ask to verify the new password.

The password you enter shows on the terminal command line in plain text,
and is stored in the command history as plain text.

password Configures a password for the new user.

The command runs in interactive mode.

You must enter the password twice, to verify it.

The password you enter is not visible on the terminal command line.

password-hash
<Password Hash>

Configures the password using an encrypted representation of the
password.

The password is not visible as text on the terminal command line, or in the
command history.

Use this option if you want to change passwords using a script.

You can generate the hash version of the password using standard Linux
hash generating utilities.

realname <Name> Configures user's description - most commonly user's real name.

This is an alphanumeric string that can contain spaces.

The default is the username with capitalized first letter.

shell <Login
Shell>

Configures the user's default login shell.

See the explanations in the "Login Shells" section.
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Login Shells

Shell Description

/etc/cli.sh This is the default option.

Lets the user work with the full Gaia Clish.

By default, some basic networking commands (such as ping) are also
available.

The Extended Commands in the assigned roles makes it possible to add
more Linux commands that can be used (see "List of Available Extended
Commands in Roles" on page 304).

User can run the expert command to enter the Bash shell (Expert
mode).

/bin/bash BASH Linux shell.

Lets the user work with the Expert mode.

User can run the clish command to enter the Gaia Clish.

/bin/csh CSH Linux shell.

User can run the clish command to enter the Gaia Clish.

/bin/sh SH Linux shell.

User can run the clish command to enter the Gaia Clish.

/bin/tcsh TCSH Linux shell.

User can run the clish command to enter the Gaia Clish.

/usr/bin/scponly User is not allowed to log in to Gaia.

User can only connect to Gaia over SCP and transfer files to and from the
system. Other commands are forbidden.

/sbin/nologin User is not allowed to log in to Gaia.

/bin/p1shell Obsolete. Do not use this option anymore.

Important - The p1shell is not supported (Known Limitation
PMTR-45085).
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Roles
Role-based administration (RBA) lets you create administrative roles for users. With RBA, an administrator
can allow Gaia users to access specified features by including those features in a role and assigning that
role to users. Each role can include a combination of administrative (read/write) access to some features,
monitoring (read-only) access to other features, and no access to other features.

You can also specify, which access mechanisms (Gaia Portal, or Gaia Clish) are available to the user.

Note - When users log in to the Gaia Portal, they see only those features, to which they
have read-only or read/write access. If they have read-only access to a feature, they
can see the settings pages, but cannot change the settings.

Gaia includes these predefined roles:

Role Description

adminRole Gives the user read/write access to all features.

monitorRole Gives the user read-only access to all features.

Notes:

n You cannot delete or change the predefined roles.

n Do not define a new user for external users.

An external user is one that is defined on an authentication server (such as
RADIUS or TACACS), and not on the local Gaia system.
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Configuring Roles in Gaia Portal
Roles are defined in the User Management > Roles page of the Gaia Portal.

To see a list of existing roles, selectUser Management > Roles in the navigation tree.

To add new role

Step Description

1 In the navigation tree, clickUser Management > Roles.

2 Click Add.

3 In the Role Name field, enter the applicable name.

The role name must start with a letter and can be a combination of letters, numbers and the
underscore (_) character.

4 On the Features tab:

In the R/W column, click the ? icon near the feature you wish to configure in this role and
select the permission:None,Read Only, or Read / Write.

Important - A user with Read/Write permission to the User Management feature
can change a user password, including that of the admin user. Be careful when
assigning roles that include this permission!

See "List of Available Features in Roles" on page 287.
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Step Description

5 On the Extended Commands tab:

Select the commands you wish to configure in this role.

n To select several commands:

a. Press and hold the CTRL key on the keyboard.

b. Left-click the applicable commands (in the Name,Description, or Path
column).

The selected commands become highlighted.

c. In the top right corner, select the option Check selected as.

The checkboxes of the selected commands become checked.

n To clear several selected commands:

a. Press and hold the CTRL key on the keyboard.

b. Left-click the applicable commands (in the Name,Description, or Path
column).

The selected commands become highlighted.

c. In the top right corner, clear the option Check selected as.

The checkboxes of the selected commands become cleared.

See "List of Available Extended Commands in Roles" on page 304.

6 ClickOK.

To change features and commands in an existing role

Step Description

1 In the navigation tree, clickUser Management > Roles.

2 Select the role.

3 Click Edit.

4 On the Features tab:

In the R/W column, click the ? icon near the feature you wish to configure in this role and
select the permission:None,Read Only, or Read / Write.

Important - A user with Read/Write permission to the User Management feature
can change a user password, including that of the admin user. Be careful when
assigning roles that include this permission!
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Step Description

5 On the Extended Commands tab:

Select the commands you wish to configure in this role.

n To select several commands:

a. Press and hold the CTRL key on the keyboard.

b. Left-click the applicable commands (in the Name,Description, or Path
column).

The selected commands become highlighted.

c. In the top right corner, select the option Check selected as.

The checkboxes of the selected commands become checked.

n To clear several selected commands:

a. Press and hold the CTRL key on the keyboard.

b. Left-click the applicable commands (in the Name,Description, or Path
column).

The selected commands become highlighted.

c. In the top right corner, clear the option Check selected as.

The checkboxes of the selected commands become cleared.

6 ClickOK.

To delete a role

Step Description

1 In the navigation tree, clickUser Management > Roles.

2 Select the role.

3 ClickDelete.

4 ClickOK to confirm.

Note - You cannot delete the adminRole, ormonitorRole default roles.
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To assign users to a role

Step Description

1 In the navigation tree, clickUser Management > Roles.

2 Select the role.

3 Click Assign Members.

4 In the Available Users list, left-click the user you wish to add to the role.

To select several users:

a. Press and hold the CTRL key on the keyboard.

b. Left-click the applicable commands. The selected users become
highlighted.

5 Click Add >.

The selected users move to the Users with Role list.

6 ClickOK.

To remove users from a role

Step Description

1 In the navigation tree, clickUser Management > Roles.

2 Select the role.

3 Click Assign Members.

4 In the Users with Role list, left-click the user you wish to remove from the role.

To select several users:

a. Press and hold the CTRL key on the keyboard.

b. Left-click the applicable commands. The selected users become
highlighted.

5 ClickRemove >.

The selected users move to the Available Users list.

6 ClickOK.

Note - You can assign a user to many roles from the Users page (see "Users" on page 269).
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Configuring Roles in Gaia Clish
You can:

n Add, change, or delete roles.

n Add or remove users to or from existing roles.

n Add or remove access mechanism permissions for a specified user.

Syntax

To add an RBA role

add rba role <New Role Name> domain-type System
all-features
readonly-features <List of RO Features>
readwrite-features <List of RW Features>}

Note - You can add "readonly-features" and "readwrite-features" in
the same command.

To choose which VSX Virtual Systems this role can access

add rba role <Existing Role Name>
virtual-system-access 0
virtual-system-access all
virtual-system-access VSID1,VSID2,...,VSIDn

To assign Gaia access mechanisms to a user

add rba user <User Name>
access-mechanisms Web-UI
access-mechanisms CLI
access-mechanisms Web-UI,CLI

To assign an RBA role to a user

add rba user <User Name> roles <Role1,Role2,...,RoleN>

To show RBA roles information

show rba
all
role <Role Name>
roles
user <User Name>
users

To delete an entire RBA role

delete rba role <Role Name>
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To delete features from an RBA role

delete rba role <Role Name>
readonly-features <List of RO Features>
readwrite-features <List of RW Features>

Note - You can delete "readonly-features" and "readwrite-features" in
the same command.

To remove Gaia access mechanisms from a user

delete rba user <User Name>
access-mechanisms Web-UI
access-mechanisms CLI
access-mechanisms Web-UI,CLI

To remove an RBA role from a user

delete rba user <User Name> roles <Role1,Role2,...,RoleN>

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Notes

n There are no "set" commands for configured roles.

n You cannot delete the adminRole, ormonitorRole default roles.

Parameters

CLI Parameters

Parameter Description

role <Role Name> Role name as a character string that contains letters, numbers or
the underscore (_) character.

The role name must start with a letter.

domain-type System Reserved for future use.

virtual-system-access
{0 | all | VSID1,
VSID2, ..., VSIDn}

Specifies which VSXVirtual Systems this role can access:

n 0 - Access only to VSX itself (VS0).

n all - Access to all Virtual Systems.

n VSID1,VSID2,...,VSIDn - Access only to specified
Virtual Systems. This is a comma-separated list of Virtual
Systems IDs (spaces are not allowed in this syntax).
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Parameter Description

all-features Grants read-write permissions to all features.

Important - This role is equivalent to the admin role!

readonly-features
<List of RO Features>

A comma-separated list of Gaia features that have read-only
permissions in the specified role.

See the "List of Available Features in Roles" on page 287 and
"List of Available Extended Commands in Roles" on page 304.

Notes:

n Press <SPACE><TAB> to see the list of available
features.

n You can add read-only and read-write feature
lists in the same "add rba role <Role
Name> domain-type System ..."
command.

readwrite-features
<List of RW Features>

A comma-separated list of Gaia features that have read-write
permissions in the specified role.

See the "List of Available Features in Roles" on page 287 and
"List of Available Extended Commands in Roles" on page 304.

Notes:

n Press <SPACE><TAB> to see the list of available
features.

n You can add read-only and read-write feature
lists in the same "add rba role <Role
Name> domain-type System ..."
command.

Important - A user with read/write permission to the
user feature can change a user password, including
that of the admin user. Be careful when assigning roles
that include this permission!

user <User Name> User, to which access mechanism permissions and roles are
assigned.

roles
<
Role1,Role2,...,RoleN>

Comma-separated list of role names that are assigned to or
removed from the specified user (spaces are not allowed in this
syntax).
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Parameter Description

access-mechanisms
{Web-UI | CLI | Web-
UI,CLI}

Defines the access mechanisms that users can work with to
manage Gaia:

n Web-UI - Access only to Gaia Portal

n CLI - Access only to Gaia Clish

n Web-UI,CLI - Access to both Gaia Portal and Gaia Clish
(spaces are not allowed in this syntax)

Example

gaia> add rba role NewRole domain-type System readonly-features
vpn,ospf,rba readwrite-features snmp

gaia> show rba role NewRole
Role

NewRole
domain-type System
read-write-feature snmp
read-only-feature vpn,ospf,rba

gaia>

gaia> add rba user John roles NewRole

gaia> add rba user John access-mechanisms Web-UI,CLI

gaia> show rba user John
User

John
access-mechanism CLI
access-mechanism Web-UI
role NewRole

gaia>

gaia> delete rba user John roles NewRole

gaia> delete rba role NewRole
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List of Available Features in Roles

Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

Authentica
tion
Servers

aaa-servers Configure
authenticatio
n through
external
RADIUS or
TACACS+
server.

set aaa radius-servers *
set aaa tacacs-servers *
delete aaa radius-servers *
delete aaa tacacs-servers *
add aaa radius-servers *
add aaa tacacs-servers *
show aaa radius-servers *
show aaa tacacs-servers *

Advanced
VRRP

adv-vrrp Configure
the
Advanced
Virtual
Router
Redundancy
Protocol
(VRRP)

set vrrp *
show vrrp *

Appliance
Maintenan
ce

prod-maintain Overview
page for
Appliance
Maintenanc
e.

ARP arp Control static
ARP entries
and proxy
ARP entries.
Control
dynamic
ARP entries.

add arp *
delete arp *
set arp *
show arp *

Banner
Messages

message Control
Banner
Message
and
Message of
the Day.

set message *
delete message *
show message *

Table: List of Available Features in Roles
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

BGP bgp Configure
dynamic
routing
through the
Border
Gateway
Protocol
(BGP).

set as *
set router-id *
set bgp *
show route bgp *
show as *
show router-id *
show bgp *

Blades
Summary

blades Show
summary for
enabled
Software
Blades.

Certificate
Authority

certificate_
authority

Control
Certificate
Authority.

cpca_client

Change
My
Password

selfpasswd Change your
user account
password.

set selfpasswd *

Cloning
Group

CloningGroup Control Gaia
Cloning
Groups.

set cloning-group *
add cloning-group *
delete cloning-group *
join cloning-group *
re-synch cloning-group *
leave cloning-group *
show cloning-group *

Cloning
Group
Managem
ent

CloningGroupManag
ement

Control
managemen
t of Gaia
Cloning
Groups.

set cloning-group-management *

Cluster cluster Control
clustering.

add cluster *
set cluster *
delete cluster *
show cluster *

Core
Dump

core-dump Control core
dumps.

set core-dump *
show core-dump *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

DHCP
Relay

bootp Control
Relay of IPv4
DHCP and
IPv4 BOOTP
messages
between
DHCP clients
and DHCP
servers on
different
IPv4
Network.

set bootp *
show bootp *

DHCP
Server

dhcp Control
DHCP
Server on
Gaia.

set dhcp service *
delete dhcp service *
set dhcp client *
delete dhcp client *
add dhcp client *
set dhcp server *
delete dhcp server *
add dhcp server *
show dhcp service *
show dhcp client *
show dhcp server *

DHCPv6
Relay

dhcp6relay Control
Relay of
DHCPv6
messages
between
DHCP clients
and DHCP
servers on
different
IPv6
Network.

set ipv6 dhcp6relay *
show ipv6 dhcp6relay *

Display
Configurati
on

configuration Save and
showGaia
configuratio
n.

save configuration *
show configuration *

Display
Format

format Control how
the system
displays
time, date
and
netmask.

set format *
show format *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

DNS dns Control DNS
servers on
Gaia.

set dns *
delete dns *
show dns *

Domain
Name

domainname Control the
domain
name on
Gaia.

set domainname *
delete domainname
show domainname

Download
SmartCon
sole

smart-console Download
SmartConsol
e from Gaia
Portal.

N / A

Expert
Mode

expert Access to
the Expert
mode shell.

expert

Expert
Password

expert-password Change the
Expert mode
password
(interactive).

set expert-password

Expert
Password
Hash

expert-password-
hash

Change the
Expert mode
password
using
password
hash.

set expert-password-hash *

Extended
Command
s

command Control the
ability to
define
additional
Extended
Commands
for the Gaia
Clish.

add command *
delete command *
show command *
show commands
show extended *

Factory
Defaults

fcd Restore
Gaia OS to
Factory
Defaults.

set fcd *
show fcd *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

Firewall
Managem
ent

firewall_
management

Control
Login and
Logout from
Managemen
t Server.

mgmt *

Front
Panel

lcd Control the
front panel
LCD display
available on
some Check
Point
appliances.

set lcd *
show lcd *

Hardware
Health

hw-monitor Hardware
sensor
monitoring.

show sysenv all
cpstat -f sensors os

High
Availability

high-avail-group Overview
page for
High
Availability.

Host
Access

host-access Control
which hosts
are allowed
to connect to
Gaia.

add allowed-client *
delete allowed-client *
show allowed-client *

Host
Address

host Control
known hosts
and their IP
addresses
on Gaia.

add host *
set host *
delete host *
show host *

Host Name hostname Control the
Gaia
hostname.

set hostname *
show hostname *

IGMP igmp Control
multicast
group
membership
s through the
Internet
Group
Managemen
t Protocol
(IGMP).

set igmp *
show igmp *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

Inactivity
timeout

inactto Control
inactivity
timeout for
Gaia Portal
and Gaia
Clish.

set inactivity-timeout *
show inactivity-timeout *

Inbound
Route
Filters

import Configure
IPv4
Inbound
Route Filters
for RIP,
OSPFv2,
and BGP
IPv4.

set inbound-route-filter *

Inbound
Route
Filters

import6 Configure
IPv6
Inbound
Route Filters
for RIPng,
OSPFv3,
and BGP
IPv6.

set ipv6 inbound-route-filter
*

Installation ftw Run the Gaia
First Time
Configuratio
n Wizard.

Interface
Naming

interface-name Set a
different
name for an
existing
interface
(requires a
reboot and
reconfigurati
on of the
interface)

set interface-name *

IP
Broadcast
Helper

iphelper Control
forwarding of
UDP
broadcast
traffic to
other
interfaces.

set iphelper *
show iphelper *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

IP
Reachabili
ty
Detection

ipreachdetect Control
reachability
of IP
Addresses.

set ip-reachability-detection
*
show ip-reachability-detection
*

IPv4 Static
Routes

static-route Configure
IPv4 static
routes on
Gaia.

set static-route *
show route static *

IPv6
Router
Discovery

ipv6rdisc6 Control IPv6
router
discovery.

set ipv6 rdisc6 *
show ipv6 rdisc6 *

IPv6 State ipv6-state Control IPv6
stack on
Gaia.

set ipv6-state *
show ipv6-state

IPv6 Static
Routes

static6 Control IPv6
static routes
on Gaia.

set ipv6 static-route *
show ipv6 route static *

IPv6 VRRP vrrp6 Control the
IPv6 Virtual
Router
Redundancy
Protocol
(VRRPv3).

set ipv6 vrrp6 *
show ipv6 vrrp6 *

Job
Scheduler

cron Control
scheduled
automated
tasks that
perform
actions at a
specific time.

add cron *
set cron *
delete cron *
show cron *

License
Activation

license_
activation

Access to
"Activate
Licenses".

cplic

License
Configurati
on

license Access to
"Manage
License".

cplic

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

Lights Out
Managem
ent (LOM)
Configurati
on

lom Show Lights
Out
Managemen
t (LOM)
Configuratio
n.

show lom *

Mail
Notification

ssmtp Control mail
notifications
sent by Gaia.

set mail-notification *
show mail-notification *

Maintenan
ce

maintenance-group Overview
page for
Maintenanc
e.

N / A

Managem
ent
Interface

management_
interface

Control
which
interface is
used for
managemen
t (main
interface).

set management *
show management *

NDP neighbor Control IPv6
Neighbour
Discovery
Protocol.

add neighbor-entry *
set neighbor *
delete neighbor-entry *
show neighbor *

NetFlow
Export

netflow Control
NetFlow
Export on
Gaia.

add netflow *
set netflow *
delete netflow *
show netflow *

Network
Access

netaccess Control
TELNET
access to
Gaia.

set net-access *
show net-access *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

Network
Interfaces

interface Control
Physical
interfaces,
Aliases,
Bridges,
Bonds,
VLANs,
PPPoE.

set interface *
add interface *
delete interface *
add bonding *
set bonding *
delete bonding *
add bridging *
set bridging *
delete bridging *
add pppoe *
delete pppoe *
set pppoe *
add gre *
delete gre *
show interface *
show interfaces
show bonding *
show bridging *
show pppoe *
show gre *

Network
Managem
ent

interface-group Overview
page for
Network
Managemen
t.

show interface *
show interfaces *
set interface *

NTP ntp Control
Network
Time
Protocol for
synchronizin
g the Gaia
clock.

add ntp *
set ntp *
delete ntp *
show ntp *

OSPF ospf Control IPv4
dynamic
routing
through the
Open
Shortest-
Path First
protocol
(OSPFv2).

set ospf *
show ospf *
show route ospf *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

OSPF v3 ospf3 Control IPv6
dynamic
routing
through the
Open
Shortest-
Path First
protocol v3
(OSPFv3).

set ipv6 ospf3 *
set router-id *
show ipv6 ospf3 *
show ipv6 route ospf3 *
show router-id *

Password
Policy

password-controls Control
password
and account
policies on
Gaia.

set password-controls *
show password-controls *

Performan
ce
Optimizati
on

perf Control
Multi-Queue
on Security
Gateway.

set multi-queue *
show multi-queue *

PIM pim Control
Protocol-
Independent
Multicast
(PIM).

set pim *
show pim *
show mfc *

Policy
Based
Routing

pbr-combine-
static

Control
policy based
routing rules
and action
tables.

set pbr *
set pbrroute *
show pbr *
show pbrroute *

Policy
Routing

pbr-routing-group Overview
page for
Policy Based
Routing.

set pbr *
set pbrroute *
show pbr *
show pbrroute *

Prefix Lists
and Prefix
Trees

prefix Control
Prefix Lists
and Prefix
Trees used
in routing
policy.

set prefix-tree *
set prefix-list *

Proxy
Settings

proxy Control
Proxy server
on Gaia.

set proxy *
delete proxy *
show proxy *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

RAID
Monitoring

raid-monitor Overview
page for
RAID
volumes
monitoring.

raidconfig
raid_diagnostic

RIP rip Control
dynamic
routing
through the
Routing
Information
Protocol for
IPv4 (RIP).

set rip *
show rip *

RIPng ripng Control
dynamic
routing
through the
Routing
Information
Protocol for
IPv6
(RIPng).

set ipv6 ripng *
show ipv6 ripng *

Roles rba Control user
roles on
Gaia.

add rba *
delete rba *
show rba *

Route route Show IPv4
and IPv6
routing table
on Gaia.

show route *
show ipv6 route *

Route
Aggregatio
n

aggregate Create a
supernet
network from
the
combination
of networks
with a
common
routing
prefix.

set aggregate *
show route aggregate *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

Route
Injection
Mechanis
m

route-injection Control the
Route
Injection
Mechanism
(RIM) on
Gaia.

set kernel-routes *
show route kernel *

Route Map routemap Configure
route maps
on Gaia.

set routemap *
show routemap *
show routemaps *

Route
Redistribut
ion

export Control
advertiseme
nt of IPv4
routing
information
from one
protocol to
another.

set route-redistribution *

Route
Redistribut
ion

export6 Control
advertiseme
nt of IPv6
routing
information
from one
protocol to
another.

set ipv6 route-redistribution
*

Routed
ClusterXL

routed-cluster Control how
RouteD
daemon
interacts with
ClusterXL on
Gaia.

set routed-clusterxl *
show routed-clusterxl *

Router
Discovery

rdisc Control
ICMPRouter
Discovery on
Gaia.

set rdisc *
show rdisc *

Router
Service

router-service-
group

Overview
page for
Routing
Services.

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

Routing
Monitor

show-route-all View
summary
information
about routes
on Gaia.

show route *

Routing
Options

route-options Configure
protocol
ranks and
trace
(debug)
options on
Gaia.

set routedsyslog *
set trace *
set tracefile *
set max-path-splits *
set nexthop-selection *
set protocol-rank *
set router-options *
show trace *
show routed *
show protocol-rank *
show router-options *

SAM
(Accelerat
or Card)

sam Deprecated -
SAM card is
not
supported by
R80.30.
Monitor
Security
Acceleration
Module for
information
on usage
and
connections.

show sam *

Scheduled
Backup

sceduled_backup Create
scheduled
backups of
the Gaia for
events of
data loss.

add backup-scheduled *
set backup-scheduled *
delete backup-scheduled *
show backup-scheduled

Scratchpa
d
Configurati
on

scratchpad Control
Scratchpad
in Gaia
Portal.

N / A
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

Security
Managem
ent GUI
Clients

mgmt-gui-clients Control
allowed
Security
Managemen
t GUI Clients.

Shutdown reboot_halt Shut down
and reboot
the Gaia.

halt *
reboot *

Snapshot snapshot Create full
backups
(snapshots)
of the Gaia.

add snapshot *
set snapshot *
delete snapshot *
show snapshots
show snapshot *

SNMP snmp Control Gaia
monitoring
through the
Simple
Network
Managemen
t Protocol
(SNMP).

add snmp *
set snmp *
delete snmp *
show snmp *

Software
Updates
Policy
Managem
ent

installer_conf CPUSE -
Manage
deployment
policy and
mail
notifications
for software
updates.

For more information, see sk92449.

installer restore_policy *
set installer *
set installer download_mode *
set installer install_mode *
set installer download_mode
schedule *
set installer install_mode
schedule *

Static
Multicast
Routes

static-mroute Configure
multicast
static routes
on Gaia.

set static-mroute *
show static-mroute *

System
Asset

asset Show
hardware
asset
summary.

show asset *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

System
Backup

backup Create
backup of
the Gaia
system for
events of
data loss.

add backup *
set backup *
backup *
restore *
delete backup *
show backups
show backup *
show restore *

System
Configurati
on

sysconfig System
Configuratio
n.

show configuration *

System
Groups

group Control Gaia
OS user
groups, for
advanced
managemen
t of
privileges.

add group *
set group *
delete group *
show groups
show group *

System
Logging

syslog Control
system
logging on
Gaia.

add syslog *
set syslog *
delete syslog *
show syslog *

System
Managem
ent

system-group Overview
page for
System
Managemen
t.

System
Status

sysenv Hardware
sensor
monitoring.

show sysenv *

TACACS_
Enable

tacacs_enable Control
TACACS+
mechanism
on Gaia.

tacacs_enable *
show tacacs_enable *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

Time clock-date Configure
the time and
date of the
Gaia system.

set clock *
set date *
set time *
set timezone *
show clock *
show date *
show time *
show timezone *

Upgrade upgrade Upgrade the
Gaia.
Deprecated -
use the
CPUSE
instead.

upgrade *
add upgrade *
delete upgrade *
show upgrade *

Upgrades
(CPUSE)

installer CPUSE -
Show the
update
packages
status and
manage
package
downloads
and
installations
on Gaia.

For more information, see sk92449.

show installer *
add installer *
installer *
set installer *

Upgrades
(CPUSE)

software-updates-
group

Overview
page for
CPUSE.

For more information, see sk92449.

show installer *
set installer *
installer agent *

User
Managem
ent

security-access-
group

Overview
page for
User
Managemen
t.

Users user Control user
accounts on
Gaia.

add user *
set user *
delete user *
show user *
show users *

Table: List of Available Features in Roles (continued)
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Feature
name in
Gaia
Portal

Feature name in
Gaia Clish Description Affected commands

in Gaia Clish

Version version Shows the
version of
the installed
Check Point
product, and
Gaia build
and kernel.

show version *

Virtual-
System

virtual-system Control VSX
Virtual
Systems
(CLI only).
You must
configure all
Virtual
Systems in
SmartConsol
e only.

add virtual-system *
set virtual-system *
delete virtual-system *
show virtual-system *

VPNT vpnt Control VPN
Tunneling on
Gaia.

add vpn *
set vpn *
delete vpn *

VRRP vrrp Control the
IPv4 Virtual
Router
Redundancy
Protocol
(VRRPv2) -
Monitored
Circuit/Simpli
fied VRRP.

set vrrp *
add mcvr *
set mcvr *
delete mcvr *
show vrrp *
show mcvr *

VSX vsx Enable or
Disable the
VSXmode
(to be used
only by
Check Point
Support
only).

set vsx *
show vsx *

Web
configurati
on

web Control Gaia
Portal.

set web *
generate web *
show web *

Table: List of Available Features in Roles (continued)
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List of Available Extended Commands in Roles

Command name
in Gaia Portal

Command name
in Gaia Clish Description

api ext_api Start, stop, or check status of API server

config_system ext_config_
system

Run Gaia First Time Configuration tool in Expert mode.

cp_conf ext_cp_conf Check Point configuration utility for some local settings.

cpca ext_cpca Run Check Point Internal Certificate Authority (ICA).

cpca_client ext_cpca_
client

Control Check Point Internal Certificate Authority (ICA).

cpca_create ext_cpca_
create

Create Check Point Internal Certificate Authority (ICA)
database.

cpca_dbutil ext_cpca_
dbutil

Control Check Point Internal Certificate Authority (ICA)
database.

cpca_dbutil ext_cpca_
dbutil

Control Check Point Internal Certificate Authority (ICA)
database.

cpconfig ext_cpconfig Check Point software configuration utility for Security
Management Server and Security Gateway.

cphaprob ext_cphaprob Access to clustering commands.

cphastart ext_cphastart Enable the clustering feature on Security Gateway.

cphastop ext_cphastop Disable the clustering feature on Security Gateway.

cpinfo ext_cpinfo Collect Check Point diagnostics information.

cplic ext_cplic Control Check Point licenses.

cpshared_ver ext_cpshared_
ver

Show Check Point SVN Foundation version.

cpstart ext_cpstart Start the installed Check Point products.

cpstat ext_cpstat Show Check Point statistics history information for
Software Blades and Gaia.

cpstop ext_cpstop Stop the installed Check Point products.

cpview ext_cpview Show advanced Check Point statistics information for
Software Blades and Gaia in real-time.

Table: List of Available Extended Commands in Roles
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Command name
in Gaia Portal

Command name
in Gaia Clish Description

cpwd_admin ext_cpwd_admin Control Check Point WatchDog administration tool.

diag ext_diag Send system diagnostics information.

dtps ext_dtps Control Endpoint Policy Server commands.

etmstart ext_etmstart Start QoSSoftware Blade.

etmstop ext_etmstop Stop QoSSoftware Blade.

fgate ext_fgate Control QoSSoftware Blade.

fips ext_fips Control FIPSmode.

fw ext_fw Access to Security Gateway commands for IPv4.

fw6 ext_fw6 Access to Security Gateway commands for IPv6.

fwaccel ext_fwaccel Access to SecureXL commands for IPv4.

fwaccel6 ext_fwaccel6 Access to SecureXL commands for IPv6.

fwm ext_fwm Access to Security Management commands.

ifconfig ext_ifconfig Deprecated. Use "show interface", or "set interface"
commands instead.

ips ext_ips Control IPS Software Blade.

lomipset ext_lomipset Configure LOM card IP address.

LSMcli ext_LSMcli Access to SmartProvisioning command line.

LSMenabler ext_LSMenabler Enable SmartProvisioning.

mds_backup ext_mds_backup Create backup of the Multi-Domain Server.

mds_restore ext_mds_
restore

Restore backup of the Multi-Domain Server.

mdscmd ext_mdscmd Access to Multi-Domain Server command line.

mdsconfig ext_mdsconfig Check Point software configuration utility for Multi-
Domain Server.

mdsstart ext_mdsconfig Check Point software configuration utility for Multi-
Domain Server.

mdsstart ext_mdsstart Start Multi-Domain Server.

Table: List of Available Extended Commands in Roles (continued)
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Command name
in Gaia Portal

Command name
in Gaia Clish Description

mdsstart_
customer

ext_mdsstart_
customer

Start specific Domain Management Server.

mdsstat ext_mdsstat Show the status of Multi-Domain Server and all Domain
Management Servers.

mdsstop ext_mdsstop Stop Multi-Domain Server.

mdsstop_
customer

ext_mdsstop_
customer

Stop specific Domain Management Server.

netstat ext_netstat Print network connections, routing tables and interface
statistics.

ping ext_ping Ping a host using IPv4.

ping6 ext_ping6 Ping a host using IPv6.

raid_
diagnostic

ext_raid_
diagnostic

Access to RAIDMonitoring tool.

raidconfig ext_raidconfig Access to RAID Configuration and Monitoring tool.

rtm ext_rtm Control the Monitoring Software Blade.

rtmstart ext_rtmstart Start the Monitoring Software Blade.

rtmstop ext_rtmstop Stop the Monitoring Software Blade.

rtmtopsvc ext_rtmtopsvc Monitor top services using the Monitoring Software
Blade.

SDSUtil ext_SDSUtil Access to Software Distribution Server utility.

sim ext_sim Access to SecureXL SIM device commands for IPv4.

SnortConvertor ext_
SnortConvertor

Access to IPS Snort conversion tool.

tecli ext_tecli Access to Threat Emulation Blade shell.

top ext_top Show the most active system processes.

traceroute ext_traceroute Trace the route to a host.

vpn ext_vpn Control the VPN kernel module for IPv4.

vpn6 ext_vpn6 Control the VPN kernel module for IPv6.

Table: List of Available Extended Commands in Roles (continued)
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Command name
in Gaia Portal

Command name
in Gaia Clish Description

vsx_util ext_vsx_util Control managed VSXGateways on a Management
Server.

Table: List of Available Extended Commands in Roles (continued)
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Password Policy
This section explains how to configure your platform:

n To enforce creation of strong passwords.

n To monitor and prevent use of already used passwords.

n To force users to change passwords at regular intervals.

One of the important elements of securing your Check Point cyber security platform is to set user
passwords and create a good password policy.

Note - The password policy does not apply to nonlocal users that authentication
servers such as RADIUSmanage their login information and passwords. In addition, it
does not apply to non-password authentication, such as the public key authentication
supported by SSH.

To set and change user passwords, see "Users" on page 269 and "User Management" on page 267.

Password Strength

Strong, unique passwords that use a variety of character types and require password changes, are key
factors in your overall cyber security.

Password History Checks

The password history feature prevents from users using a password they have used before when they
change their password.

The number of already used passwords that this feature checks against is defined by the history length.

Password history check is enabled by default.

The password history check:

n Applies to user passwords set by the administrator and to passwords set by the user.

n Does not apply to SNMPv3 USM user pass phrases.

These are some considerations when using password history:

n The password history for a user is updated only when the user successfully changes password.

If you change the history length, for example: from ten to five, the stored passwords number does
not change.

Next time the user changes password, the new password is examined against all stored passwords,
maybe more than five.

After the password change succeeds, the password file is updated to keep only the five most recent
passwords.

n Passwords history is only stored if the password history feature is enabled when the password is
created.

n The new password is checked against the previous password, even if the previous password is not
stored in the password history.
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Mandatory Password Change

Themandatory password change feature requires users to use a new password at defined intervals.

Forcing users to change passwords regularly is important for a strong security policy.

You can set user passwords to expire after a specified number of days.

When a password expires, the user is forced to change the password the next time the user logs in.

This feature works together with the password history check to get users to use new passwords at regular
intervals.

The mandatory password change feature does not apply to SNMPv3 USM user pass phrases.

Deny Access to Unused Accounts

You can deny access to unused accounts. If there were no successful login attempts within a set time, the
user is locked out and cannot log in.

You can also configure the allowed number of days of non-use before a user is locked-out.

Deny Access After Failed Login Attempts

You can deny access after too many failed login attempts. The user cannot log in during a configurable
time.

You can also allow access again after a user was locked out.

In addition, you can configure the number of failed login attempts that a user is allowed before being locked
out.

When one login attempt succeeds, counting of failed attempts stops, and the count is reset to zero.
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Configuring Password Policy in Gaia Portal
In This Section:

Procedure 310

Password Strength 310

Password History 311

Mandatory Password Change 312

Deny Access to Unused Accounts 313

Deny Access After Failed Login Attempts 313

Procedure

Step Description

1 In the navigation tree, clickUser Management >Password Policy.

2 Configure the password policy options:

n Password Strength

n Password History

n Mandatory Password Change

n Deny Access to Unused Accounts

n Deny Access After Failed Login Attempts

See the corresponding sections below.

3 Click Apply.

Password Strength

Parameter Description

Minimum
Password Length

The minimum number of characters in a Gaia user, or an SNMP user
password.

Does not apply to passwords that were already configured.

n Range: 6 - 128

n Default: 6

Disallow
Palindromes

A palindrome is a sequence of letters, numbers, or characters that can be read
the same in each direction.

n Default: Selected



Configuring Password Policy in Gaia Portal

Gaia R80.40 Administration Guide      |      311

Parameter Description

Password
Complexity

The required number of character types:

n 1 - Don't check

n 2 - Require two character types (default)

n 3 - Require three character types

n 4 - Require four character types

Character types are:

n Upper case alphabetic (A-Z)

n Lower case alphabetic (a-z)

n Digits (0-9)

n Other (everything else)

Changes to this setting do not affect existing passwords.

Password History

Parameter Description

Check for
Password Reuse

Check for reuse of passwords for all users.

Enables or disables password history checking and password history recording.

When a user's password is changed, the new password is checked against the
recent passwords for the user.

An identical password is not allowed. The number of passwords kept in the
record is set byHistory Length.

Does not apply to SNMP passwords.

n Default: Selected

History Length The number of former passwords to keep and check against when a new
password is configured for a user.

n Range: 1 - 1000

n Default: 10
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Mandatory Password Change

Parameter Description

Password Expiration The number of days, for which a password is valid. After that time, the
password expires.

The count starts when the user changes the password.

Users are required to change an expired password the next time they
log in.

Does not apply to SNMP users.

n Range: 1 - 1827, or Passwords never expires

n Default: Passwords never expires

Warn users before password
expiration

Howmany days before the user's password expires to start
generating warnings to the user that user must change the password.

A user that does not log in, does not see this warning.

n Range: 1 - 366

n Default: 7

Lockout users after
password expiration

Lockout users after password expiration.

After a user's password has expired, user has this number of days to
log in and change it.

If a user does not change the password within that number of days,
the user is unable to log in - the user is locked out.

The administrator can unlock a user that is locked out from the User
Management > Users page.

n Range: 1 - 1827, or Never lockout users after
password expires

n Default: Never lockout users after password
expires

Force users to change
password at first login after
password was changed from
Users page

Forces a user to change password at first login, after the user's
password was changed using the command "set user
<UserName> password", or from the Gaia PortalUser
Management > Users page.

n Default: Not selected
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Deny Access to Unused Accounts

Parameter Description

Deny access to unused
accounts

Denies access to unused accounts.

If there were no successful login attempts within a set time, the user is
locked out and cannot log in.

n Default: Not selected

Days of non-use before
lock-out

Configures the number of days of non-use before locking out the unused
account.

This only takes effect, ifDeny access to unused accounts is enabled.

n Range: 30 - 1827

n Default: 365

Deny Access After Failed Login Attempts

Parameter Description

Deny access after
failed login attempts

If the configured limit is reached, the user is locked out (unable to log in) for a
configured time.

Warning - Enabling this leaves you open to a "denial of service" - if
an attacker makes unsuccessful login attempts often enough, the
affected user account is locked out. Consider the advantages and
disadvantages of this option, in light of your security policy, before
enabling it.

n Default: Not selected

Block admin user This option is available only ifDeny access after failed login attempts is
enabled.

If the configured limit of failed login attempts for the admin user is reached,
the admin user is locked out (unable to log in) for a configured time.

Maximum number of
failed attempts
allowed

This only takes effect ifDeny access after failed attempts is enabled.

The number of failed login attempts that a user is allowed before being
locked out.

After making that many successive failed attempts, future attempts fail.

When one login attempt succeeds, counting of failed attempts stops, and the
count is reset to zero.

n Range: 2 - 1000

n Default: 10
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Parameter Description

Allow access again
after time

This only takes effect, ifDeny access after failed login attempts is
enabled.

Allow access again after a user was locked out (due to failed login attempts).

The user is allowed access after the configured time, if there were no login
attempts during that time.

n Range: 60 - 604800 seconds

n Default: 1200 seconds (20 minutes)

Examples:

n 60 = 1 minute

n 300 = 5 minutes

n 3600 = 1 hour

n 86400 = 1 day

n 604800 = 1 week
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Configuring Password Policy in Gaia Clish
In This Section:

Password Strength 315

Password History 317

Mandatory Password Change 318

Deny Access to Unused Accounts 319

Deny Access After Failed Login Attempts 320

Use these commands to configure a policy for managing user passwords.

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Password Strength

Syntax

n To configure the password strength:

set password-controls
complexity <1-4>
min-password-length <6-128>
palindrome-check {on |off}

n To show the configured password strength:

show password-controls
complexity
min-password-length
palindrome-check

show password-controls all
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Parameters

Parameter Description

complexity <1-4> The required number of character types:

n 1 - Don't check

n 2 - Require two character types (default)

n 3 - Require three character types

n 4 - Require four character types

Character types are:

n Upper case alphabetic (A-Z)

n Lower case alphabetic (a-z)

n Digits (0-9)

n Other (everything else)

Changes to this setting do not affect existing passwords.

n Range: 1 - 4

n Default: 2

min-password-
length <6-128>

The minimum number of characters in a Gaia user, or an SNMP user
password.

Does not apply to passwords that were already configured.

n Range: 6 - 128

n Default: 2

palindrome-check
{on | off}

A palindrome is a sequence of letters, numbers, or characters that can
be read the same in each direction.

n Range: on, or off

n Default: on
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Password History

Syntax

n To configure the password history:

set password-controls
history-checking {on | off}
history-length <1-1000>

n To show the configured password history:

show password-controls
history-checking
history-length

show password-controls all

Parameters

Parameter Description

history-
checking
{on |
off}

Check for reuse of passwords for all users.

Enables or disables password history checking and password history recording.

When a user's password is changed, the new password is checked against the
recent passwords for the user. An identical password is not allowed. The number of
passwords kept in the record is set by history-length.

Does not apply to SNMP passwords.

n Range: on, or off

n Default: on

history-
length
<1-1000>

The number of former passwords to keep and check against when a new password
is configured for a user.

n Range: 1 - 1000

n Default: 10
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Mandatory Password Change

Syntax

n To configure the mandatory password change:

set password-controls
expiration-lockout-days <1-1827 | never>
expiration-warning-days <1-366>
force-change-when {no | password}
password-expiration <1-1827 | never>

n To show the configured mandatory password change:

show password-controls
expiration-lockout-days
expiration-warning-days
force-change-when
password-expiration

show password-controls all

Parameters

Parameter Description

expiration-
lockout-days
<1-1827 |
never>

Lockout users after password expiration.

After a user's password has expired, user has this number of days to log in
and change it.

If a user does not change the password within that number of days, the user
is unable to log in - the user is locked out.

The administrator can unlock a user that is locked out from the User
Management > Users page.

n Range: 1 - 1827, or never

n Default: never

expiration-
warning-days
<1-366>

Howmany days before the user's password expires to start generating
warnings to the user that user must change the password.

A user that does not log in, does not see this warning.

n Range: 1 - 366

n Default: 7
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Parameter Description

force-change-
when {no |
password}

Forces a user to change password at first login, after the user's password
was changed using the command "set user <UserName> password",
or from the Gaia PortalUser Management > Users page.

n Range:

l no - Disables this functionality.

l password - Forces users to change their password after their
password was changed.

n Default: no

password-
expiration
<1-1827 |
never>

The number of days, for which a password is valid. After that time, the
password expires.

The count starts when the user changes the password.

Users are required to change an expired password the next time they log in.

Does not apply to SNMP users.

n Range: 1-1827, or never

n Default: never

Deny Access to Unused Accounts

Syntax

n To configure the denial of access to unused accounts based on the number of days:

set password-controls deny-on-nonuse
allowed-days <30-1827>
enable {on | off}

n To show the configured denial of access to unused accounts:

show password-controls deny-on-nonuse

show password-controls all

Parameters

Parameter Description

deny-on-nonuse
allowed-days <30-
1827>

Configures the number of days of non-use before locking out the
unused account.

This only takes effect, if the "set password-controls deny-
on-nonuse enable" is set to "on".

n Range: 30 - 1827

n Default: 365
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Parameter Description

deny-on-nonuse
enable {on | off}

Denies access to unused accounts. If there were no successful login
attempts within a set time, the user is locked out and cannot log in.

n Range: on, or off

n Default: off

Deny Access After Failed Login Attempts

Syntax

n To configure the denial of access to unused accounts based on the number of failed login
attempts:

set password-controls deny-on-fail
allow-after <60-604800>
block-admin {on | off}
enable {on | off}
failures-allowed <2-1000>

n To show the configured denial of access to unused accounts:

show password-controls deny-on-fail

show password-controls all

Parameters

Parameter Description

allow-after
<60-604800>

Allow access again after a user was locked out (due to failed login attempts).

The user is allowed access after the configured time, if there were no login
attempts during that time.

n Range: 60 - 604800 seconds

n Default: 1200 seconds (20 minutes)

Examples:

n 60 = 1 minute

n 300 = 5 minutes

n 3600 = 1 hour

n 86400 = 1 day

n 604800 = 1 week
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Parameter Description

block-admin
{on | off}

This only takes effect if "set password-controls deny-on-fail
enable" is set to "on".

If the configured limit of failed login attempts for the admin user is reached,
the admin user is locked out (unable to log in) for a configured time.

n Range: on, or off

n Default: off

enable {on |
off}

If the configured limit is reached, the user is locked out (unable to log in) for a
configured time.

Warning - Enabling this leaves you open to a "denial of service" - if
an attacker makes unsuccessful login attempts often enough, the
affected user account is locked out. Consider the advantages and
disadvantages of this option, in light of your security policy, before
enabling it.

n Range: on, or off

n Default: off

failures-
allowed <2-
1000>

This only takes effect if "set password-controls deny-on-fail
enable" is set to "on".

The number of failed login attempts that a user is allowed before being locked
out.

After making that many successive failed attempts, future attempts fail.

When one login attempt succeeds, counting of failed attempts stops, and the
count is reset to zero,

n Range: 2 - 1000

n Default: 10
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Monitoring Password Policy in Gaia Clish

Syntax

show password-controls
all
complexity
deny-on-fail

allow-after
block-admin
enable
failures-allowed

deny-on-nonuse
allowed-days
enable

expiration-lockout-days
expiration-warning-days
force-change-when
history-checking
history-length
min-password-length
palindrome-check
password-expiration

Example

gaia> show password-controls all

Password Strength
Minimum Password Length 6
Password Complexity 2
Password Palindrome Check on

Password History
Password History Checking off
Password History Length 10

Mandatory Password Change
Password Expiration Lifetime 5
Password Expiration Warning Days 8
Password Expiration Lockout Days never
Force Password Change When no

Configuration Deny Access to Unused Accounts
Deny Access to Unused Accounts off
Days Nonuse Before Lockout 365

gaia>
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Authentication Servers
You can configure Gaia to authenticate Gaia users even when they are not defined locally.

This is a good way of centrally managing the credentials of multiple Security Gateways.

To define non-local Gaia users, you define Gaia as a client of an authentication server.

Gaia supports these types of authentication servers:

Server Description

RADIUS RADIUS (Remote Authentication Dial-In User Service) is a client/server authentication
system that supports remote-access applications. User profiles are kept in a central
database on a RADIUS authentication server. Client computers or applications connect to
the RADIUS server to authenticate users.

You can configure your Gaia computer to connect to more than one RADIUS server. If the
first server in the list is unavailable, the next RADIUS server in the priority list connects.

TACACS+ The TACACS+ (Terminal Access Controller Access Control System) authentication
protocol users a remote server to authenticate users for Gaia. All information sent to the
TACACS+ server is encrypted.

Gaia supports TACACS+ for authentication only. Challenge-response authentication,
such as S/Key, is not supported.

You can configure TACACS+ support separately for different services. The Gaia Portal
service is one of those, for which TACACS+ is supported and is configured as the
HTTP service. When TACACS+ is configured for use with a service, Gaia contacts the
TACACS+ server each time it needs to examine a user password. If the server fails or is
unreachable, the user is authenticated via local password mechanism. If the user fails to
authenticate via the local mechanism, the user is not allowed access.

Note - For TACACS authentication to work on a Virtual System, see the R80.40 VSX
Administration Guide.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_VSX_AdminGuide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_VSX_AdminGuide/Default.htm
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Configuring RADIUS Servers
In This Section:

Configuring RADIUS Servers in Gaia Portal 325

Configuring RADIUS Servers in Gaia Clish 327
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Configuring RADIUS Servers in Gaia Portal

To configure a RADIUS server

Step Description

1 In the navigation tree, clickUser Management > Authentication Servers.

2 In theRADIUS Servers section, click Add.

TheAdd New RADIUS Server window opens.

3 Enter theRADIUSServer parameters:

n Priority - The RADIUS server priority is an integer between -999 and 999 (default is 0).

When there two or more configured RADIUS servers, Gaia connects to the RADIUS server with the
highest priority.

Low numbers have the higher priority.

n Host - Host name or IP address (IPv4 or IPv6) of RADIUS server.

n UDP Port - UDP port used on RADIUS server.

The default port is 1812 as specified by the RADIUS standard.

The range of valid port numbers is from 1 to 65535.

Port 1645 is non-standard, but is commonly used as alternative to port 1812.

Warning - Firewall software frequently blocks traffic on port 1812. Make sure that you
define a firewall rule to allow traffic on UDP port 1812 between the RADIUS server and
Gaia.

n Shared Secret - Shared secret used for authentication between the RADIUS server and the Gaia
client.

Enter the shared secret text string up to 256 characters, without any whitespace characters and
without a backslash.

Make sure that the shared string defined on the Gaia matches the shared string defined on the
RADIUS server.

RFC 2865 recommends that the secret be at least 16 characters in length.

Some RADIUS servers have a maximum string length for shared secret of 15 or 16 characters.

See the documentation for your RADIUS server.

n Timeout in - Optional: Enter the timeout in seconds (from 1 to 5), during which Gaia waits for the
RADIUS server to respond. The default value is 3.

If there is no response after the configured timeout, Gaia tries to connect to a different configured
RADIUS server.

Set this timeout, so that the sum of all RADIUS server timeouts is less than 50.

4 ClickOK.



Configuring RADIUS Servers

Gaia R80.40 Administration Guide      |      326

Step Description

5 Optional: Select theNetwork Access Server (NAS) IP address.

This setting applies to all configuredRADIUSservers.

This parameter records the IP address, from whichGaia sends theRADIUSpacket.

This IP address is stored in theRADIUSpacket, evenwhen the packet goes throughNAT, or someother address translation that changes the
source IP address of the packet.

The "NAS-IP-Address" is defined in RFC2865.

If noNAS IPAddress is chosen, the IPv4 address of theGaiaManagement Interface is used (clickNetwork Management > Network
Interfaces > see theManagement Interface section).

6 Optional: Select RADIUS Users Default Shell (for details about the shells, see "Users" on page 269).

This setting applies to all configuredRADIUSservers.

7 Optional: Select theSuper User ID - 0 or 96.

This setting applies to all configuredRADIUSservers.

If theUID is 0, there is no need to run thesudo command to get super user permissions (see "Configuring RADIUSServers for Non-
LocalGaia Users" on page 331).

8 Click Apply.

To edit a RADIUS server

Step Description

1 In the navigation tree, clickUser Management > Authentication Servers.

2 Select theRADIUSserver.

3 Click Edit.

TheEdit RADIUS Server window opens.

4 You can edit only theHost, UDP Port, Shared secret, andTimeout.

5 ClickOK.

To delete a RADIUS server

Step Description

1 In the navigation tree, clickUser Management >Authentication Servers.

2 Select the RADIUS server.

3 ClickDelete.

4 ClickOK to confirm.

http://freeradius.org/rfc/rfc2865.html#NAS-IP-Address


Configuring RADIUS Servers

Gaia R80.40 Administration Guide      |      327

Configuring RADIUS Servers in Gaia Clish

Description

Use the "aaa radius-servers" commands to add, configure, and delete Radius authentication
servers.

Syntax

To configure RADIUS for use in a single authentication profile

add aaa radius-servers priority <Priority> host <Hostname, or IP
Address of RADIUS Server> [port <1-65535>]

prompt-secret timeout <1-50>
secret <Shared Secret> timeout <1-50>

To change the configuration of a specific RADIUS server

set aaa radius-servers priority <Priority>
host <Hostname, or IP Address of RADIUS Server>
new-priority <New Priority>
port <1-65535>
prompt-secret
secret <Shared Secret>
timeout <1-50>

To change the configuration that applies to all configured RADIUS servers

set aaa radius-servers
NAS-IP<SPACE><TAB>
default-shell<SPACE><TAB>
super-user-uid <0 | 96>

To show a list of all configured RADIUS servers associated with an authentication profile

show aaa radius-servers list

To show the configuration of a specific RADIUS server

show aaa radius-servers priority <Priority>
host
port
timeout

To show the configuration that applies to all configured RADIUS servers

show aaa radius-servers
NAS-IP
default-shell
super-user-uid
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To delete a specific RADIUS server

delete aaa radius-servers
priority <Priority>

To delete the configuration that applies to all configured RADIUS servers

delete aaa radius-servers
NAS-IP

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

CLI Parameters

Parameter Description

priority
<Priority>

Configures the RADIUS server priority. Enter an integer between -999
and 999 (default is 0).

When there two or more configured RADIUS servers, Gaia connects to
the RADIUS server with the highest priority.

Low numbers have the higher priority.

new-priority <New
Priority>

Configures the new priority for the RADIUS server.

host <Hostname, or
IP Address of
RADIUS Server>

Configures the Host name or IP address (IPv4 or IPv6) of RADIUS
server.

port <1-65535> Configures the UDP port used on RADIUS server.

The default port is 1812 as specified by the RADIUS standard.

The range of valid port numbers is from 1 to 65535. Port 1645 is non-
standard, but is commonly used as alternative to port 1812.

Warning - Firewall software frequently blocks traffic on port
1812. Make sure that you define a firewall rule to allow traffic
on UDP port 1812 between the RADIUS server and Gaia.

prompt secret The system will prompt you to enter the Shared Secret.
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Parameter Description

secret <Shared
Secret>

Configures the shared secret used for authentication between the
RADIUS server and the Gaia.

Enter the shared secret text string up to 256 characters, without any
whitespace characters and without a backslash.

Make sure that the shared string defined on the Gaia matches the
shared string defined on the RADIUS server.

RFC 2865 recommends that the secret be at least 16 characters in
length.

Some RADIUS servers have a maximum string length for shared
secret of 15 or 16 characters.

See the documentation for your RADIUS server.

timeout <1-50> Configures the timeout in seconds (from 1 to 5), during which Gaia
waits for the RADIUS server to respond.

The default value is 3.

If there is no response after the configured timeout, Gaia tries to
connect to a different configured RADIUS server.

Set this timeout, so that the sum of all RADIUS server timeouts is less
than 50.

default-
shell<SPACE><TAB>

Optional:Configures the default shell for RADIUSUsers (for details
about the shells, see "Users" on page 269).

super-user-uid <0
| 96>

Optional:Configures the UID for the RADIUS super user.

If the UID is 0, there is no need to run the sudo command to get super
user permissions (see "Configuring RADIUS Servers for Non-Local
Gaia Users" on page 331).

NAS-IP<SPACE><TAB> Optional: This parameter records the IP address, from which Gaia
sends the RADIUS packet.

This IP address is stored in the RADIUS packet, even when the packet
goes through NAT, or some other address translation that changes the
source IP address of the packet.

The "NAS-IP-Address" is defined in RFC2865.

If no NAS IP Address is chosen, the IPv4 address of the Gaia
Management Interface is used (run the "show management
interface" command).

http://freeradius.org/rfc/rfc2865.html#NAS-IP-Address
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Configuring Gaia as a RADIUS Client
Gaia acts as a RADIUS client. You must define a role for the RADIUS client, and the features for that role.

To allow login with non-local users to Gaia, you must define a default Gaia role for all non-local users that
are configured in the RADIUS server.

The default role can include a combination of:

n Administrative (read/write) access to some features

n Monitoring (read-only) access to other features

n No access to other features.

To configure Gaia as a RADIUS Client

Step Description

1 Define the role for the RADIUS client:

n If no group is defined on the RADIUS server for the client, define this role:

radius-group-any

n If a group is defined on RADIUS server for the client (group XXX, for example), define
this role:

radius-group-<XXX>

2 Define the features for the role.

Example for Gaia Clish

gaia> add rba role radius-group-any domain-type System readonly-
features arp

For instructions, see "Roles" on page 278.

Note - Do not define a new user for external users. An external user is one that is
defined on an authentication server (such as RADIUS or TACACS), and not on the
local Gaia system.
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Configuring RADIUS Servers for Non-Local Gaia Users
Non-local users can be defined on a RADIUS server and not in Gaia.

When a non-local user logs in to Gaia, the RADIUS server authenticates the user and assigns the
applicable permissions.

You must configure the RADIUS server to correctly authenticate and authorize non-local users.

Important - If you define a RADIUS user with a null password (on the RADIUS server),
Gaia cannot authenticate that user.

To configure a RADIUS server for non-local Gaia users

In addition, see sk72940.

Step Instructions

1 Copy the applicable dictionary file to your RADIUS server.

Example for the "Steel-Belted RADIUS server"

a. Copy this file from the Gaia to the RADIUS server:

/etc/radius-dictionaries/checkpoint.dct

b. Add these lines to the vendor.ini file on the RADIUS server (keep in alphabetical
order with the other vendor products in this file):

vendor-product = Check Point Gaia
dictionary = nokiaipso
ignore-ports = no
port-number-usage = per-port-type
help-id = 2000

c. Add this line to the dictiona.dcm file:

"@checkpoint.dct"

Example for the "FreeRADIUS server"

a. Copy this file from the Gaia to the RADIUS server to the /etc/freeradius/
directory:

/etc/radius-dictionaries/dictionary.checkpoint

b. Add this line to the /etc/freeradius/dictionary file:

"$INCLUDE dictionary.checkpoint"

http://supportcontent.checkpoint.com/solutions?id=sk72940
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Step Instructions

Example for the "OpenRADIUS server"

a. Copy this file from the Gaia to the RADIUS server to the
/etc/openradius/subdicts/ directory:

/etc/radius-dictionaries/dict.checkpoint

b. Add this line /etc/openradius/dictionaries file immediately after the
dict.ascend:

$include subdicts/dict.checkpoint

2 Define the user roles on Gaia.

Add this Check Point Vendor-Specific Attribute to users in your RADIUS server user
configuration file:

CP-Gaia-User-Role = "role1,role2,...

For example:

CP-Gaia-User-Role = "adminrole, backuprole, securityrole"

3 Define the Check Point users that must have superuser access to the Gaia shell.

Add this Check Point Vendor-Specific Attribute to users in your RADIUS server user
configuration file:

n If this user should not receive superuser permissions:

CP-Gaia-SuperUser-Access = 0

n If this user can receive superuser permissions:

CP-Gaia-SuperUser-Access = 1

To log in as a superuser

A user with super user permissions can use the Gaia shell to do system-level operations, including
working with the file system.

Super user permissions are defined in the Check Point Vendor-Specific Attributes.

Users that have a UID of 0 have super user permissions.

They can run all the commands that the root user can run.

Users that have a UID of 96 must run the sudo command to get super user permissions.

The UIDs of all non-local users are defined in the /etc/passwd file.
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To get super user permissions (for users that have a UID of 96)

Step Description

1 Connect to the command line on Gaia.

2 Log in to the Expert mode..

3 Run:

sudo /usr/bin/su -

The user now has superuser permissions.
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Configuring TACACS+ Servers
In This Section:

Configuring TACACS+ Servers in Gaia Portal 334

Configuring TACACS+ Servers in Gaia Clish 337

Checking if the Logged In User is Enabled for TACACS+ 339

Configuring TACACS+ Servers in Gaia Portal

To configure a TACACS+ server

Step Description

1 In the navigation tree, clickUser Management >Authentication Servers.

2 In the TACACS+ Configuration section, select Enable TACACS+ authentication.

This setting applies to all configured TACACS+ servers.

3 Click Apply.

4 In the TACACS+ Servers section, click Add.
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Step Description

5 Configure the TACACS+ parameters:

n Priority - The priority of the TACACS+ server - from 1 to 20.

Must be unique for this operating system.

Gaia uses the priority:

l To determine the order, in which Gaia connects to the TACACS+ servers.

First, Gaia connects to the TACACS+ server with the lowest priority number.

For example: Three TACACS+ servers have a priority of 1, 5, and 10
respectively.

Gaia connects to these TACACS+ servers in that order, and uses the first
TACACS+ server that responds.

l To identify the TACACS+ server in commands. A command with priority 1
applies to the TACACS+ server with priority 1.

n Server - IPv4 address of the TACACS+ server.

n Shared Key - The Shared Secret used for authentication between the TACACS+
server and Gaia.

Enter the shared secret text string up to 256 characters, without any whitespace
characters and without a backslash.

Make sure that the shared string defined on the Gaia matches the shared string
defined on the TACACS+ server.

n Timeout in Seconds - Enter the timeout in seconds (from 1 to 60), during which Gaia
waits for the TACACS+ server to respond.

The default value is 5.

If there is no response after the configured timeout, Gaia tries to connect to a different
configured TACACS+ server.

6 ClickOK.

7 Optional: In the TACACS+ Servers Advanced Configuration section, select the User UID
- 0, or 96 and click Apply.

This setting applies to all configured TACACS+ servers.

To disable TACACS+ authentication

Step Description

1 In the navigation tree, clickUser Management >Authentication Servers.

2 In the TACACS+ configuration section, clear Enable TACACS+ authentication.

This setting applies to all configured TACACS+ servers.

3 Click Apply.
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To delete a TACACS+ server

Step Description

1 In the navigation tree, clickUser Management >Authentication Servers.

2 In the TACACS+ Servers section, select a TACACS+ server.

3 ClickDelete.

4 ClickOK to confirm.
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Configuring TACACS+ Servers in Gaia Clish

Syntax

To configure TACACS+ server for use in a single authentication profile

add aaa tacacs-servers priority <Priority> server <IPv4 Address of
TACACS+ Server> key <Shared Secret> timeout <1-60>

To change the configuration of a specific TACACS+ server

set aaa tacacs-servers priority <Priority>
server <IPv4 Address of TACACS+ Server>
new-priority <New Priority>
key <Shared Secret>
timeout <1-60>

To change the configuration that applies to all configured TACACS+ servers

set aaa tacacs-servers
state {on | off}
user-uid <0 | 96>

To show a list of all configured TACACS+ servers associated with an authentication profile

show aaa tacacs-servers list

To show the configuration of a specific TACACS+ server

show aaa tacacs-servers priority <Priority>
server
timeout

To show the configuration that applies to all configured TACACS+ servers

show aaa tacacs-servers
state
user-uid

To delete a specific RADIUS server

delete aaa tacacs-servers
priority <Priority>

To delete the configuration that applies to all configured TACACS+ servers

delete aaa tacacs-servers
NAS-IP

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

CLI Parameters

Parameter Description

priority <Priority> The priority of the TACACS+ server - from 1 to 20.

Must be unique for this operating system.

The priority is used:

n To determine the order, in which Gaia connects to the
TACACS+ servers.

First, Gaia connects to the TACACS+ server with the lowest
priority number.

For example: Three TACACS+ servers have a priority of 1, 5,
and 10 respectively.

Gaia connects to these TACACS+ servers in that order, and
uses the first TACACS+ server that responds.

n To identify the TACACS+ server in commands. A command
with priority 1 applies to the TACACS+ server with
priority 1.

Values:

n Range: 1 - 20

n Default:No default

server <IPv4 Address
of TACACS+ Server>

IPv4 address of the TACACS+ server.

key <Shared Secret> The Shared Secret used for authentication between the TACACS+
server and Gaia.

Enter the shared secret text string up to 256 characters, without any
whitespace characters and without a backslash.

Make sure that the shared string defined on the Gaia matches the
shared string defined on the TACACS+ server.

timeout <1-60> Enter the timeout in seconds, during which Gaia waits for the
TACACS+ server to respond.

If there is no response after the configured timeout, Gaia tries to
connect to a different configured TACACS+ server.

n Range: 1 - 60

n Default: 5

new-priority <New
Priority>

Configures the new priority for the TACACS+ server.
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Parameter Description

state {on | off} Configures the state of TACACS+ authentication.

n Range: on, or off

n Default: off

Example

gaia> set aaa tacacs-servers priority 2 server 10.10.10.99 key
MySharedSecretKey timeout 10

Checking if the Logged In User is Enabled for TACACS+

Procedure

Step Description

1 Connect to the command line on Gaia.

2 Log in to Gaia Clish.

3 Run:

show tacacs_enable
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Configuring Gaia as a TACACS+ Client
Gaia acts as a TACACS+ client for Gaia users that are defined on the TACACS+ server and are not defined
locally on Gaia.

The admin user must define a role called TACP-0 for the TACACS+ users, and the allowed features for
the TACP-0 role.

Privilege Escalation

The Gaia admin user can define roles that make it possible for Gaia users to get temporarily higher
privileges, than their regular privileges.

For example, Gaia user Fred needs to configure the interfaces, but his role does not support interfaces
configuration. To configure the interfaces, Fred enters his user name together with a password given
him by the admin user. This password lets him change his default role to the role that allows him to
configure the interfaces.

There are sixteen different privilege levels (0 - 15) defined in TACACS+.

Each level can be mapped to a different Gaia role.

For example:

n Privilege level 0 - monitor-only

n Privilege level 1 - basic network configuration

n Privilege level 15 - admin user

By default, all non-local TACACS+Gaia users are assigned the role TACP-0.

The Gaia admin can define for them roles with the name TACP-N that give them different privileges,
where N is a privilege level - a number from 1 to 15.

The TACACS+ users can changes their own privileges by moving to another TACP-N role.

To do this, the TACACS+ users need to get a password from the Gaia admin user.

To configure Gaia as a TACACS+ Client

Step Description

1 Connect to Gaia OS as the admin user.

2 Define the role TACP-0.

3 Define the features for the role.

For instructions, see "Roles" on page 278.

4 Optional:Define one or more roles with the name TACP-N where N is a privilege level - a
number from 1 to 15, and define the features for each role.

To raise "TACP" privileges

You can raise the "TACP" privileges in either Gaia Portal, or Gaia Clish.
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Raising "TACP" privileges in Gaia Portal

Step Description

1 In your web browser, connect to Gaia Portal.

2 Enter the username and password of the TACACS+ user.

After the TACACS server authentication, you have the privileges of the TACP-0 role.

3 To raise the privileges to the TACP-N role (N is a number from 1 to 15), click Enable at the
top of theOverview page.

4 Enter the password for the user.

Raising "TACP" privileges in Gaia Clish

Step Description

1 Connect to the command line.

2 Log in to the Gaia Clish using the username and password of the TACACS+ user.

3 After you are authenticated by the TACACS server, you get the Gaia Clish prompt.

At this point, you have the privileges of the TACP-0 role.

Run:

tacacs_enable TACP-<N>

Where N is the new TACP role (an integer from 1 to 15).

4 When prompted, enter the applicable password.

To go back to the TACP-0 role, pressCTRL+D, or enter exit at the command prompt.

The user automatically exits the current shell and goes back to TACP-0.

Note - Do not define a new user for external users. An external user is one that is
defined on an authentication server (such as RADIUS, or TACACS), and not on the
local Gaia system.

To show if the currently logged in user is authenticated by TACACS+

show tacacs_enable
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Configuring TACACS+ Servers for Non-Local Gaia Users
You can define Gaia users on a TACACS server instead of defining them on the Gaia computer.

Gaia users that are defined on a TACACS server are called non-local users.

Cisco ACS servers are the most commonly used TACACS+ servers.

For help with the configuration of a Cisco ACS server as a TACACS+ server for Gaia clients, see sk98733
(as an example of best practices and not a replacement for the official Cisco documentation).

When a non-local user logs in to Gaia, the TACACS server authenticates the user and assigns the
permissions to the user.

You must configure the TACACS server to correctly authenticate and authorize non-local Gaia users.

Important - If you define a TACACS user with a null password (on the TACACS server),
Gaia cannot authenticate that user.

http://supportcontent.checkpoint.com/solutions?id=sk98733
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System Groups
In This Section:

Introduction 343

Configuring System Groups in Gaia Portal 344

Configuring System Groups in Gaia Clish 346

Introduction
You can define and configure groups with Gaia as you can with equivalent Linux-based systems.

This function is retained in Gaia for advanced applications and for retaining compatibility with Linux.

Use groups for these purposes:

n Specify Linux file permissions.

n Control who can log in through SSH.

For other functions that are related to groups, use the role-based administration feature, described in
"Roles" on page 278.

All users are assigned by default to the users group. You can edit a user's primary group ID (using Gaia
Clish) to be something other than the default. However, you can still add the user to the users group. The
list of members of the users group includes only users, who are explicitly added to the group. The list of
does not include users added by default.
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Configuring System Groups in Gaia Portal
To see a list of all groups

In the navigation tree, clickUser Management > System Groups.

To add a System Group

Step Description

1 In the navigation tree, clickUser Management > System Groups.

2 Click Add.

3 In theGroup Name field, enter the applicable unique name - between 1 and 16
alphanumeric characters without spaces.

4 In theGroup ID field, enter a unique Group ID number - between 101 and 65530:

n Group ID range 0-100 and range 65531-65535 are reserved for system use.

n Group ID 0 is reserved for users with root permissions.

n Group ID 10 is reserved for the predefined Users groups.

If you specify a value in the reserved ranges, an error message is displayed.

5 ClickOK.

To add a user to a System Group

Step Description

1 In the navigation tree, clickUser Management > System Groups.

2 Select the System Group.

3 Click Edit.

4 In the Available Members list, select a user.

To select several users:

a. Press and hold the CTRL key on the keyboard.

b. Left-click the applicable users.

The selected users become highlighted.

5 Click Add >.

The selected users move to theMembers of Group list.

6 ClickOK.
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To remove a user from a System Group

Step Description

1 In the navigation tree, clickUser Management > System Groups.

2 Select the System Group.

3 Click Edit.

4 In theMembers of Group list, select a user.

To select several users:

a. Press and hold the Ctrl key on the keyboard.

b. Left-click the applicable users.

The selected users become highlighted.

5 Click Add >.

The selected users move to the Available Members list.

6 ClickOK.

To delete a System Group

Step Description

1 In the navigation tree, clickUser Management > System Groups.

2 Select the System Group.

3 ClickDelete.

4 ClickOK to confirm.
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Configuring System Groups in Gaia Clish

Syntax

To add a System Group

add group <Group Name> gid <Group ID>

To add a user to a System Group

add group <Group Name> member<SPACE><TAB>

add group <Group Name> member <UserName>

To change the Group ID of a System Group

set group <Group Name> gid <Group ID>

To show users in a System Group

show group <Group Name>

To show all configured System Groups

show groups

To remove a user from a System Group

delete group <Group Name> member<SPACE><TAB>

delete group <Group Name> member <UserName>

To delete a System Group

delete group <Group Name>

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

CLI Parameters

Parameter Description

group <Group
Name>

Unique name of System Group - between 1 and 16 alphanumeric
characters without spaces

gid <Group ID> Unique Group ID number - between 101 and 65530:

n Group ID range 0-100 and range 65531-65535 are reserved for
system use.

n Group ID 0 is reserved for users with root permissions.

n Group ID 10 is reserved for the predefined Users groups.

If you specify a value in the reserved ranges, an error message is displayed.

member
<UserName>

Name of an existing user.
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GUI Clients
In This Section:

Configuring GUI Clients in Gaia Portal 348

Configuring GUI Clients in Command Line 349

If this is a Security Management Server, you can configure which computers can connect to this Security
Management Server with SmartConsole.

Note - This section does not show, if this is a Multi-Domain Server.

Configuring GUI Clients in Gaia Portal

Step Description

1 In the navigation tree, clickUser Management > GUI Clients.

2 Click Add.

The Add GUI Clientwindow opens.

3 Define the GUI clients (trusted hosts).

These are the values:

n Any IP Address

All clients are allowed to log in, regardless of their IP address.

This option only shows if Any was not defined during the initial
configuration.

n This machine - IP address

n Network

n Range of IPv4 addresses
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Configuring GUI Clients in Command Line

Step Description

1 Connect to the command line on the Security Management Server.

2 Run:

cpconfig

For more information, see the R80.40 CLI ReferenceGuide > Chapter SecurityManagement
Server Commands > Section cpconfig.

3 Enter 3 for theGUI Clients option.

4 A list of hosts selected to be GUI clients shows.

You can add or delete hosts, or create a new list.

You can add newGUI clients in these formats:

n IP address - One computer defined by its IPv4 or IPv6 address.

n Machine name - One computer defined by its hostname.

n "Any" - An IPv4 address without restriction.

You must:

a. Enter the word Any with capital letter "A"

b. Press the Enter key

c. Press the CTRL+D keys.

n IP/Netmask - A range of IPv4 addresses (for example,
192.168.10.0/255.255.255.0) or IPv6 addresses (for example, 2001::1/128).

n A range of addresses - A limited range of IPv4 addresses (for example,
192.168.10.8-192.168.10.16), or IPv6 addresses (for example, 2001::1-
2001::10).

n Wild cards (IPv4 only) - A limited range of IPv4 addresses only (for example,
192.168.10.*).

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_CLI_ReferenceGuide/Default.htm


High Availability

Gaia R80.40 Administration Guide      |      350

High Availability
In This Section:

Understanding VRRP 350

VRRP Terminology 351

VRRP on Gaia OS 352

VRRP Configuration Methods 353

Monitoring of VRRP Interfaces 354

How VRRP Failover Works 354

Typical VRRP Use Cases 356

Understanding VRRP
Virtual Routing Redundancy Protocol (VRRP) is a high-availability solution, where two Gaia Security
Gateways can provide backup for each other. Gaia offers two ways to configure VRRP:

n Monitored Circuit/Simplified VRRP - All the VRRP interfaces automatically monitor other VRRP
interfaces.

n Advanced VRRP - Every VRRP interface must be explicitly configured to monitor every other VRRP
interface.

Important:

n You cannot have a Standalone deployment (Security Gateway and Security
Management Server on the same computer) in a Gaia VRRP cluster.

n You cannot use both the Monitored Circuit/Simplified VRRP and Advanced
VRRP together on the same Cluster Member.

Virtual Router Redundancy Protocol (VRRP) provides dynamic failover of IP addresses from one router to
another in the event of failure. This increases the availability and reliability of routing paths via gateway
selections on an IP network. Each VRRP router has a unique identifier known as the Virtual Router
Identifier (VRID), which is associated with at least one Virtual IP Address (VIP). Neighboring network nodes
connect to the VIP as a next hop in a route or as a final destination. Gaia supports VRRP as defined in RFC
3768.

https://www.rfc-editor.org/info/rfc3768
https://www.rfc-editor.org/info/rfc3768
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VRRP Terminology
The conceptual information and procedures in this chapter use standard VRRP terminology.

This glossary contains basic VRRP terminology and a reference to related Check Point ClusterXL terms.

VRRP
Term

ClusterXL
Term Definition

VRRP
Cluster

Cluster A group of Security Gateways that provides redundancy.

VRRP
Router

Member A Security Gateway using the VRRP protocol that is a member of one or more
Virtual Router. In this guide, a VRRPRouter is commonly called a Security
Gateway.

Master Active The Security Gateway (Security Gateway) that handles traffic to and from a
Virtual Router. The Master is the Security Gateway with the highest priority in
a group. The Master inspects traffic and enforces the security policy.

Backup Standby A redundant Security Gateway (Security Gateway) that is available to take
over for the Master in the event of a failure.

VRID Cluster
name

Unique Virtual Router identifier The VRID is the also last byte of the MAC
address.

VIP Cluster
Virtual IP
address

Virtual IP address assigned to a Virtual Router. VIPs are routable from
internal and/or external network resources.

The VIP is called Backup Address in the Gaia Portal.

VMAC VMAC Virtual MAC address assigned to a Virtual Router.

VRRP
Transition

Failover Automatic change over to a backup Security Gateway when the primary
Security Gateway fails or is unavailable. The term 'failover' is used frequently
in this guide.
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VRRP on Gaia OS
On Gaia, VRRP can be used with ClusterXL enabled or with ClusterXL disabled.

VRRP with
ClusterXL Description

VRRPwith
ClusterXL
enabled

This is the most common use case.

You can deploy only an Active/Backup environments.

VRRP supports a maximum of one VRID with one Virtual IP Address (VIP) for each
interface.

You must configure VRRP, so that the same node is the VRRPMaster for all VRIDs.
Therefore, you must configure each VRID to monitor every other VRRP-enabled
interface.

You must also configure priority deltas to allow a failover to the VRRPBackup node,
when the VRID on any on interface fails over.

VRRPwith
ClusterXL
disabled

You can deploy an Active/Active environment.

You can configure two VRIDs on the same interface, with one VIP for each VRID.

This configuration supports only static routes on the VRRP interfaces.

You must disable the VRRP monitoring of the Check Point Firewall (see "Preparing
a VRRP Cluster" on page 359).
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VRRP Configuration Methods

VRRP Method Description

Monitored
Circuit/Simplified
VRRP

To configure this simplified VRRP method, in the Gaia Portal go to High
Availability > VRRP.

This method contains all of the basic parameters, and is applicable for most
environments.

You configure each Virtual Router as one unit and configure the same VRID on all
interfaces.

Monitored Circuit VRRP automatically monitors all VRRP interfaces. This make a
complete node failover possible.

You can configure only one VRID, which is automatically added to all the VRRP
interfaces.

If the VRID on any of the VRRP-enabled interfaces fails, the configured priority
delta is decremented on the other VRRP-enabled interfaces to allow the VRRP
Backup node to take over as the new VRRPMaster.

Advanced VRRP To configure this advanced VRRP method, in the Gaia Portal go to High
Availability > Advanced VRRP.

This method allows configuration of different VRIDs on different interfaces.

You configure a VRID on each interface individually. In addition, each VRRP-
enabled interface must be monitored by each VRID together with an appropriate
priority delta. This ensures that when one interface fails, all the other VRIDs can
transition to VRRPBackup state

n With ClusterXL enabled, you must configure each VRID to monitor every
other VRRP interface.

You must also configure priority deltas that allow complete node failover.

Advanced VRRP also makes it possible for a VRID to monitor interfaces that
do not run VRRP.

n With ClusterXL disabled, you can configure two VRIDs on each interface,
with one VIP for each VRID.
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Monitoring of VRRP Interfaces
The monitoring of all VRRP-enabled interfaces by all VRIDs is important to avoid connection issues with
asymmetric routes.

For example, when an external interface fails, the VRRPMaster fails over only for the external Virtual
Router. The VRRPMaster for the internal Virtual Router does not fail over. This can cause connectivity
problems when the internal Virtual Router accepts traffic and is unable to connect to the new external
VRRPMaster.

Another tool for avoiding asymmetric issues during transitions is the VRRP interface delay setting.
Configure this when the Preempt Mode of VRRPwas turned off. This VRRP global setting is useful when
the VRRP node with a higher priority is rebooted, but must not preempt the existing VRRPMaster that
handles the traffic, but is configured with a lower priority. Sometimes, interfaces that come up, take longer
than the VRRP timeout to process incoming VRRPHello packets. The interface delay extends the time that
VRRPwaits to receive VRRPHello packets from the existing VRRPMaster.

How VRRP Failover Works
Each Virtual Router (VRRPGroup) is identified by a unique Virtual Router ID (VRID).

A Virtual Router contains one VRRPMaster Security Gateway and at least one VRRPBackup Security
Gateway.

The VRRPMaster sends periodic VRRP advertisements (known as VRRPHellomessages) to the VRRP
Backup Security Gateways.

VRRP advertisements broadcast the operational status of the VRRPMaster to the VRRPBackup.

Gaia uses dynamic routing protocols to advertise the VIP of the Virtual Router (Virtual IP address or
Backup IP address).

Notes:

n Gaia supports OSPF on VPN tunnels that terminate at a VRRP group.

n Active/Backup VRRP environments are supported with ClusterXL enabled.

If ClusterXL is disabled, Active/Active environments can be deployed.

n Active/Active VRRP environments support only static routes. In addition, you
must disable the monitoring of the Check Point Firewall by VRRP.



High Availability

Gaia R80.40 Administration Guide      |      355

If the VRRPMaster fails, or its VRRP-enabled interfaces fail, VRRP uses a priority algorithm to make the
decision if failover to a VRRPBackup is necessary. Initially, the VRRPMaster is the Security Gateway that
has the highest defined priority value. You define a priority for each Security Gateway when you create a
Virtual Router or change its configuration. If two VRRP Security Gateways have same priority value, the
platform that comes online and broadcasts its VRRP advertisements first becomes the VRRPMaster.

Gaia also uses priorities to select a VRRPBackup Security Gateway upon failover (when there is more
than one VRRPBackup available). In the event of failover, the Virtual Router priority value is decreased by
a predefined Priority Delta value to calculate an Effective Priority value. The Virtual Router with the highest
effective priority becomes the new VRRPMaster. The Priority Delta value is a Check Point proprietary
parameter that you define when configuring a Virtual Router. If you configure your system correctly, the
effective priority will be lower than the VRRPBackup Security Gateway priority in the other Virtual Routers.
This causes the problematic VRRPMaster to fail over for the other Virtual Routers as well.

Note - If the effective priority for the current VRRPMaster and VRRPBackup are the
same, the Security Gateway with the highest IP address becomes the VRRPMaster.
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Typical VRRP Use Cases
These are examples of some VRRP environments.

VRRP Use Case 1 - Internal Network High Availability

This is a simple VRRP use case, where Security Gateway 1 is the VRRPMaster, and Security Gateway
2 is the VRRPBackup.

Virtual Router redundancy is available only for connections to and from the internal network.

There is no redundancy for external network traffic.

Item Description

1 VRRPMaster Security Gateway

2 VRRPBackup Security Gateway

3 Virtual Router VRID 5 - Virtual IP Address (Backup Address) is 192.168.2.5

4 Internal Network and hosts
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VRRP Use Case 2 - Internal and External Network High Availability

This use case shows an example of an environment, where there is redundancy for internal and
external connections.

Here, you can use Virtual Routers for the two Security Gateways - for internal and for external
connections.

The internal and external interfaces must be on different subnets.

Define one Security Gateway as the VRRPMaster and one Security Gateway as the VRRPBackup.

Item Description

1 Virtual Router VRID 5 - External Virtual IP Address (Backup Address) is 192.168.2.5

2 VRRPMaster Security Gateway

3 VRRPBackup Security Gateway

4 Virtual Router VRID 5 - Internal Virtual IP Address (Backup Address) is 192.168.3.5

5 Internal network and hosts
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VRRP Use Case 3 - Internal Network Load Sharing

This use case shows an example of an Active/Active Load Sharing environment for internal network
traffic.

This environment gives load balancing, as well as full redundancy.

This configuration is supported with ClusterXL disabled. Only Static Routes are supported.

The monitoring of the Check Point Firewall by VRRPmust be disabled (it is enabled by default).

Amaximum of two VRIDs is supported per interface.

Security Gateway 1 is the VRRPMaster for VRID 5, and Security Gateway 2 is the VRRPBackup.

Security Gateway 2 is the VRRPMaster for VRID 7, and Security Gateway 1 is the VRRPBackup.

The two Security Gateways are configured to back each other up. If one fails, the other takes over its
VRID and IP addresses.

Item Description

1 VRRPMaster Security Gateway for VRID 5 and VRRPBackup for VRID 7

2 VRRPBackup Security Gateway for VRID 5 and VRRPMaster for VRID7

3 Virtual Router, VRID 5 Virtual IP Address (Backup Address) is 192.168.2.5

4 Virtual Router, VRID 7 Virtual IP Address (Backup Address) is 192.168.2.7

5 Internal network and hosts



Preparing a VRRP Cluster

Gaia R80.40 Administration Guide      |      359

Preparing a VRRP Cluster
In This Section:

Configuring Network Switches 359

Preparing VRRP Cluster Members 359

Configuring Global Settings for VRRP 360

Configuring Network Switches
Recommendations

Best Practice - If you use the Spanning Tree protocol on Cisco switches connected
to Check Point VRRP clusters, we recommend that you enable PortFast. It sets
interfaces to the Spanning Tree forwarding state, which prevents them from waiting
for the standard forward-time interval.

If you use switches from a different vendor, we recommend that you use the equivalent feature for that
vendor. If you use the Spanning Tree protocol without PortFast, or its equivalent, you may see delays
during VRRP failover.

Preparing VRRP Cluster Members
Procedure

Step Description

1 Install the VRRPCluster Members

See the R80.40 Installation and UpgradeGuide > Chapter Installing a ClusterXL, VSX
Cluster, VRRP Cluster > Section Installing a VRRP Cluster..

2 Synchronize the system time on the VRRPCluster Members.

Best Practice - Enable NTP (Network Time Protocol) on all Security Gateways
(see "Time" on page 187).

You can also manually change the time and time zone on each Security Gateway to match
the other members.

In this case, you must synchronize member times to within a few seconds.

3 Optional: Add host names and IP address pairs to the host table on each Security Gateway
(see "Hosts" on page 155).

This lets you use host names as an alternative to IP addresses or DNS servers.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
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Step Description

4 Enable Virtual Routers:

a. With a web browser, connect to Gaia Portal at:

https://<IP address of Gaia Management Interface>

b. In the navigation tree, clickHigh Availability > VRRP.

c. Configure the VRRP Global Settings.

See the section "Configuring Global Settings for VRRP" below.

d. If the Disable All Virtual Routers option is currently selected, clear it.

e. Click Apply Global Settings.

5 Configure your Virtual Routers in either Gaia Portal, or Gaia Clish.

See:

n "ConfiguringMonitored Circuit/Simplified VRRP" on page 362

n "Configuring Advanced VRRP" on page 369

Configuring Global Settings for VRRP
This section shows you how to configure the global settings that apply to all Virtual Routers.

Procedure

Step Description

1 In the navigation tree, click one of these:

n High Availability > VRRP.

n High Availability >Advanced VRRP.
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Step Description

2 In the VRRP Global Settings section:

n Cold Start Delay - Configures the delay period in seconds before a Security Gateway
joins a Virtual Router. Default = 0.

n Interface Delay - Configure this when the Preempt Mode of VRRPwas turned off.
This is useful when the VRRP node with a higher priority is rebooted, but must not
preempt the existing VRRPMaster that is handling the traffic, but is configured with a
lower priority. Sometimes interfaces that come up take longer than the VRRP timeout
to process incoming VRRPHello packets. The Interface Delay extends the time that
VRRPwaits to receive Hello packets from the existing VRRPMaster.

n Disable All Virtual Routers - Select this option to disable all Virtual Routers defined
on this Gaia system. Clear this option to enable all Virtual Routers. By default, all
Virtual Routers are enabled.

n Monitor Firewall State - Select this option to let VRRPmonitor the Security Gateway
and automatically take appropriate action. This is enabled by default, which is the
recommended setting when using VRRPwith ClusterXL enabled. This must be
disabled when using VRRPwith ClusterXL disabled.

Important - If you disableMonitor Firewall State, VRRP can assign VRRP
Master status to a Security Gateway before it completes the boot process.
This can cause more than one Security Gateway in a Virtual Router to have
VRRPMaster status.

3 Click Apply Global Settings.

Notes

Gaia starts to monitor the firewall after the cold start delay completes.

This can cause some problems:

n If all the interfaces in a Virtual Router fail, all VRRPCluster Members become VRRPBackups.

None of the VRRPCluster Members can become the VRRPMaster and no traffic is allowed.

n If you change the time on any of the VRRPCluster Members, a VRRP failover occurs
automatically.

n In certain situations, installing a policy causes a failover.

This can happen if it takes a long time to install the policy.
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Configuring Monitored Circuit/Simplified VRRP
In This Section:

Configuring Monitored Circuit/Simplified VRRP in Gaia Portal 362

Configuring Monitored Circuit/Simplified VRRP in Gaia Clish 365

Configuring the VRRP Cluster for Simplified VRRP in SmartConsole 368

This section includes the procedure for configuring Monitored Circuit/Simplified VRRP.

Configuring Monitored Circuit/Simplified VRRP in Gaia
Portal
Procedure

Step Description

1 In the navigation tree, clickHigh Availability > VRRP.

2 Configure the VRRP Global Settings.

See "Preparing a VRRP Cluster" on page 359.

3 In the Virtual Routers section, click Add.
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Step Description

4 In the Add Virtual Router window, configure these parameters:

n Virtual Router ID - Enter a unique ID number for this virtual router. The range of valid
values is 1 to 255.

n Priority - Enter the priority value, which selects the Security Gateway that takes over in
the event of a failure. The Security Gateway with the highest available priority
becomes the new VRRPMaster. The range of valid values 1 to 254. The default value
is 100.

n Hello Interval - Optional. Enter or select the number of seconds, after which the VRRP
Master sends its VRRP advertisements. The valid range is between 1 (default) and
255 seconds.

All VRRP routers on a Security Gateways must be configured with the same hello
interval. Otherwise, more than one Security Gateway can be in the VRRPMaster
state.

The Hello interval also defines the failover interval (the time a VRRPBackup router
waits to hear from the existing VRRPMaster before it takes on the VRRPMaster role).
The value of the failover interval is three times the value of the Hello interval (default -
3 seconds).

n Authentication:

l None - To disable authentication of VRRP packets

l Simple - To authenticate VRRP packets using a plain-text password

You must use the same authentication method for all Security Gateways in a
Virtual Router.

n Priority Delta - Enter the value to subtract from the Priority to create an effective
priority when an interface fails. The range is 1-254.
If an interface fails on the VRRPBackup, the value of the priority delta is subtracted
from its priority. This gives a higher effective priority to another Security Gateway
member.

If the effective priority of the current VRRPMaster is less than that of the VRRP
Backup, the VRRPBackup becomes the VRRPMaster for this Virtual Router. If the
effective priority for the current VRRPMaster and VRRPBackup are the same, the
gateway with the highest IP address becomes the VRRPMaster.

n Auto-deactivation - When an interface is reported as DOWN, a cluster member's
Priority value is reduced by the configured Priority Delta amount. If another cluster
member exists with a higher Priority, it will then take over as VRRPMaster to heal the
network.

By default, some cluster member will be elected as VRRPMaster, even if all cluster
members have issues and are reporting a Priority of zero.
The auto-deactivation option can be enabled to change this behavior and ensure that
no cluster member is elected as VRRPMaster, if all cluster members have a Priority of
zero.

When this option is enabled, Priority Delta should be set equal to the Priority value, so
that Priority will become zero, if an interface goes down.
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Step Description

5 In the Backup Addresses section, click Add.

Configure these parameters in the Add Backup Address window:

n IPv4 address - Enter the interface IPv4 address.

n VMAC Mode - For each Virtual Router, a Virtual MAC (VMAC) address is assigned to
the Virtual IP address. The VMAC address is included in all VRRP packets as the
source MAC address. The physical MAC address is not used.

Select one of these Virtual MACmodes:

l VRRP - Sets the VMAC to use the standard VRRP protocol. It is automatically
set to the same value on all Security Gateways in the Virtual Router. This is the
default setting.

l Interface - Sets the VMAC to the local interface MAC address. If you define this
mode for the VRRPMaster and the VRRPBackup, the VMAC is different for
each. VRRP IP addresses are related to different VMACs. This is because they
are dependent on the physical interface MAC address of the currently defined
VRRPMaster.

Note -If you configure different VMACs on the VRRPMaster and VRRPBackup,
you must make sure that you select the correct proxy ARP setting for NAT.

l Static - Manually set the VMAC address. Enter the VMAC address in the
applicable field.

l Extended - Gaia dynamically calculates and adds three bytes to the interface
MAC address to generate VMAC address that is more random. If you select this
mode, Gaia constructs the same MAC address for VRRPMaster and VRRP
Backups in the Virtual Router.

Note - If you set the VMACmode to Interface or Static, syslog error
messages show when you restart the computer, or during VRRP
failover. This is caused by duplicate IP addresses for the VRRP
Master and VRRPBackup. This is expected behavior because the
VRRPMaster and VRRPBackups temporarily use the same Virtual IP
address until they get to the VRRPMaster and VRRPBackup
statuses.

ClickOK.

The new VMACmode shows in the in the Backup Address table.

6 To remove a Backup Address, select an address and clickDelete.

The address is removed from the Backup Address table.

7 Click Save.
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Configuring Monitored Circuit/Simplified VRRP in Gaia Clish

Syntax

To add Monitored Circuit/Simplified VRRP

1. Configure the priority:

add mcvr vrid VALUE priority VALUE priority-delta VALUE
[authtype {none | simple VALUE} hello-interval VALUE

2. Configure the backup address:

add mcvr vrid VALUE backup-address VALUE vmac-mode VALUE

To configure Monitored Circuit/Simplified VRRP

set mcvr vrid VALUE
authtype {none | simple VALUE}
auto-deactivation {on | off}
backup-address VALUE vmac-mode VALUE [static-mac VALUE]
hello-interval VALUE
preempt-mode {on | off}
priority VALUE
priority-delta VALUE

To show Monitored Circuit/Simplified VRRP configuration

show mcvr
vrid VALUE

all
authtype
backup-address VALUE
backup-addresses
hello-interval
priority
priority-delta

vrids

To delete Monitored Circuit/Simplified VRRP

delete mcvr vrid VALUE [backup-address VALUE]

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

CLI Parameters

Parameter Description

vrid VALUE Configures the Virtual Router ID.

n Range: 1 - 255

n Default:No default value

authtype {none
| simple
VALUE}

Configures authentication for the given Virtual Router.

You must use the same authentication method for all Security Gateways in a
Virtual Router.

n Range:

l none - Disables authentication

l simple <plain-text password> - Authenticates VRRP
packets using a plain-text password

n Default:No default value

auto-
deactivation
{on | off}

When an interface is reported as DOWN, a cluster member's Priority value is
reduced by the configured Priority Delta amount. If another cluster member
exists with a higher Priority, it will then take over as VRRPMaster to heal the
network.

By default, some cluster member will be elected as VRRPMaster, even if all
cluster members have issues and are reporting a Priority of zero.

The auto-deactivation option can be enabled to change this behavior and
ensure that no cluster member is elected as VRRPMaster, if all cluster
members have a Priority of zero.

When this option is enabled (on), Priority Delta should be set equal to the
Priority value, so that Priority will become zero, if an interface goes down.

n Range: on, or off

n Default: off

backup-address
VALUE

Configures the IPv4 address of the VRRPBackup Security Gateway.

You can define more than one address for a Virtual Router.

The backup address (Virtual IP Address) is the IP address that VRRP backs
up, in order to improve network reliability. The Virtual IP Address is typically
used as the default gateway for hosts on that network. VRRP ensures this IP
address remains reachable, as long as at least one physical machine in the
VRRP cluster is functioning and can be elected as the VRRPMaster.
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Parameter Description

vmac-mode
{default-vmac
| extended-
vmac |
interface-vmac
| static-vmac
VALUE}

Configures how the Virtual MAC (VMAC) address is calculated for the given
Virtual IP Address.

Each Virtual IP Address for a Virtual Router implies the existence of a virtual
network interface.

n Range:

l default-vmac - Generates the VMAC using the standard
method described in Section 7.3 of RFC 3768.

l extended-vmac - Generates the VMAC using an extended
range of uniqueness by dynamically calculating 3 bytes of the
VMAC instead of only 1.

l interface-vmac - Configures the VMAC to use the
interface hardware MAC address.

l static-vmac <VALUE>- Configures the Virtual Router to
use a specified static VMAC address.

n Default: default-vmac

Note - If you set the VMACmode to "interface-vmac" or
"static-vmac", syslog error messages show when you restart
the computer, or during VRRP failover. This is caused by duplicate
IP addresses for the VRRPMaster and VRRPBackup. This is
expected behavior because the VRRPMaster and VRRPBackups
temporarily use the same Virtual IP address until they get to the
VRRPMaster and VRRPBackup statuses.

hello-interval
VALUE

The interval in seconds, at which the VRRPMaster sends VRRP
advertisements. For a given Virtual Router, all VRRP cluster members
should have the same value for Hello Interval.

n Range: default, or 1 - 255

n Default: 1

preempt-mode
{on | off}

Configures Preempt Mode for the given Virtual Router.

When the Preempt Mode is enabled, if the Virtual Router has a higher
Priority than the current VRRPMaster, it preempts the VRRPMaster.

In the Preempt Mode is disabled, all Virtual Routers that have monitored
interfaces, are participating to avoid potential split-brain network topology.

For more information on the implications of disabling Preempt Mode, see
the help text for the "set mcvr vrid <VALUE> monitor-vrrp"
command.

n Range: on, or off

n Default: off
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Parameter Description

priority VALUE Configures the Priority to use in the VRRPMaster election.

This is the maximum priority that can be achieved when all monitored
interfaces are up.

The VRRP cluster member with the highest Priority value will be elected as
the VRRPMaster. Each cluster member should be given a different Priority
value, such that a specific member is the preferred VRRPMaster. This will
ensure consistency in the outcome of the election process.

n Range: default, or 1 - 254

n Default: 100

priority-delta
VALUE

Updates the Priority Delta of the given Virtual Router.

For a given Virtual Router, the VRRP cluster member with the highest
Priority is elected as the VRRPMaster. For each monitored interface with a
status of DOWN, the Priority Delta value is subtracted from the Virtual
Router's overall Priority. Thus, the VRRPMaster will be the Virtual Router
having the best list of working interfaces.

The Priority Delta value should be selected such that the Priority value will
not become a negative number when the Priority Delta is subtracted from it
for each non-operational interface.

n Range: default, or 1 - 254

n Default:No default value

Configuring the VRRP Cluster for Simplified VRRP in
SmartConsole
Follow the R80.40 Installation and UpgradeGuide > Chapter Installing a ClusterXL, VSX Cluster, VRRP
Cluster > Section Installing a VRRP Cluster.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
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Configuring Advanced VRRP
In This Section:

Changing from Advanced VRRP to Monitored Circuit/Simplified VRRP 369

Configuring Advanced VRRP in Gaia Portal 370

Configuring Advanced VRRP in Gaia Clish 373

Configuring the VRRP Cluster for Advanced VRRP in SmartConsole 378

Advanced VRRP lets you configure Virtual Routers at the interface level.

This section contains only those procedures that are directly related to Advanced VRRP configuration.

The general procedures for configuring VRRP clusters are described in "ConfiguringMonitored
Circuit/Simplified VRRP" on page 362.

With Advanced VRRP, you must configure every Virtual Router to monitor every configured VRRP
interface.

Changing from Advanced VRRP to Monitored
Circuit/Simplified VRRP
Procedure

Step Description

1 Delete all existing Virtual Routers.

2 Create new Virtual Routers in accordance with the procedures.

You cannot move a Backup Address from one interface to another while a Security Gateway is a VRRP
Master.

Perform these steps to delete and add new interfaces with the necessary IP addresses:

Step Description

1 Cause a failover from the VRRP Master to the VRRPBackup.

2 Reduce the priority, or disconnect an interface.

3 Delete the Virtual Router on the interface.

4 Create new Virtual Router using the new IP address.

5 Configure the Virtual Router as before.
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Configuring Advanced VRRP in Gaia Portal
Procedure

Step Description

1 In the navigation tree, clickHigh Availability >Advanced VRRP.

2 Configure the VRRPGlobal Settings (see "Preparing a VRRP Cluster" on page 359).

3 In the Virtual Routers section, click Add.

4 In the Add New Virtual Router window, configure these parameters:

n Interface - Select the interface for the Virtual Router.

n Virtual Router ID - Enter or select the ID number of the Virtual Router.

n Priority - Enter or select the priority value.

The priority value determines, which router takes over in the event of a failure. The
router with the higher priority becomes the new VRRPMaster. The range of values for
priority is 1 to 254. The default value is 100.

n Hello Interval - Enter or select the number of seconds, at which the VRRPMaster
sends VRRP advertisements.

The range is 1 to 255 seconds. The default value is 1.

All nodes of a given Virtual Router must have the same hello Interval. If not, VRRP
discards the packet and both platforms go to VRRPMaster state.

The VRRPHello interval also determines the failover interval - how long it takes a
VRRPBackup router to take over from a failed VRRPMaster. If the VRRPMaster
misses three VRRPHello advertisements, it is considered to be down, because the
minimal VRRPHello interval is 1 second. Therefore, the minimal failover time is 3
seconds (3 * Hello Interval).

n Preempt Mode - If you keep it selected (the default), when the original VRRPMaster
fails, a VRRPBackup system becomes the acting VRRPMaster. When the original
VRRPMaster returns to service, it becomes VRRPMaster again.

If you clear it, when the original VRRPMaster fails, a VRRPBackup system becomes
the acting VRRPMaster, and the original does not become VRRPMaster again when
it returns to service.

n Auto-deactivation - If you clear it (the default), a Virtual Router with the lowest priority
available (1) can become VRRPMaster, if no other Security Gateways exist on the
network.

If you selected it, the effective priority can become 0. With this priority, the Virtual
Router does not become the VRRPMaster, even if there are no other Security
Gateways on the network.

If you selected it, you should also configure the Priority and Priority Delta values to
be equal, so that the effective priority becomes 0, if there is a VRRP failure.
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Step Description

n VMAC Mode - For each Virtual Router, a Virtual MAC (VMAC) address is assigned to
the Virtual IP address. The VMAC address is included in all VRRP packets as the
source MAC address. The physical MAC address is not used.

Select the mode:

l VRRP - Sets the VMAC to use the standard VRRP protocol. It is automatically
set to the same value on all Security Gateways in the Virtual Router. This is the
default setting.

l Interface - Sets the VMAC to the local interface MAC address. If you define this
mode for the VRRPMaster and the VRRPBackup, the VMAC is different for
each. VRRP IP addresses are related to different VMACs. This is because they
are dependent on the physical interface MAC address of the currently defined
VRRPMaster.

Note - If you configure different VMACs on the VRRPMaster and
VRRPBackup, you must make sure that you select the correct proxy
ARP setting for NAT.

l Static - Manually set the VMAC address. Enter the VMAC address in the
applicable field.

l Extended - Gaia dynamically calculates and adds three bytes to the interface
MAC address to generate VMAC address that is more random. If you select this
mode, Gaia constructs the same MAC address for VRRPMaster and VRRP
Backups in the Virtual Router.

Note - If you set the VMACmode to Interface or Static, syslog error
messages show when you restart the computer, or during VRRP failover.
This is caused by duplicate IP addresses for the VRRPMaster and VRRP
Backup. This is expected behavior because the VRRPMaster and VRRP
Backups temporarily use the same Virtual IP address until they get to the
VRRPMaster and VRRPBackup statuses.

n Authentication:

l None - To disable authentication of VRRP packets.

l Simple - To authenticate VRRP packets using a plain-text password.

You must use the same authentication method for all Security Gateways in a Virtual
Router.

5 In the Backup Addresses section:

a. Click Add.

b. In the IPv4 address field, enter the IPv4 address.

c. ClickOK.

To change a Backup Address, select a Backup IP address and click Edit.

To remove a Backup Address, select a Backup IP address and clickDelete.
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Step Description

6 In theMonitored Interfaces section:

a. Click Add.

Gaia shows a warning that adding a Monitored Interface will lock the Interface for this
Virtual Router.

b. ClickOK to confirm.

c. In the Interface field, select the interface.

d. In Priority Delta field, enter or select the number to subtract from the priority.

This creates an effective priority when an interface related to the VRRPBackup fails.

The range is 1-254.

e. ClickOK.

To change a Monitored Interface, select a Monitored Interface and click Edit.

To remove a Monitored Interface, select a Monitored Interface and clickDelete.

7 Click Save.



Configuring Advanced VRRP

Gaia R80.40 Administration Guide      |      373

Configuring Advanced VRRP in Gaia Clish

Syntax

To configure Advanced VRRP

set vrrp
accept-connections {on | off}
coldstart-delay VALUE
disable-all-virtual-routers {on | off}
monitor-firewall {on | off}
interface-delay VALUE

To configure Advanced VRRP interface

set vrrp interface VALUE
authtype

none
simple VALUE

monitored-circuit vrid VALUE
auto-deactivation {on | off}
backup-address VALUE {on | off}
hello-interval VALUE
monitored-interface VALUE

on
off
priority-delta <default | 1 - 254>}

off
on
preempt-mode {on | off}
priority VALUE
vmac-mode

default-vmac
extended-vmac
interface-vmac
static-vmac VALUE

off
virtual-router legacy off

To show Advanced VRRP configuration

show vrrp
[interface VALUE]
[interfaces]
[stats]
[summary]

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.
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Parameters

CLI Parameters

Parameter Description

accept-connections
{on | off}

Controls the Accept Connections option.

This option causes packets destined to VRRPVirtual IP Address(es)
to be accepted, and any required responses be generated.

Enabling this option enhances VRRP's interaction with network
management tools, which in turn allows for faster failure detection.

This option is required for High Availability applications (for example,
routing protocols), whose service is tied to a Virtual IP Address.

n Range: on, or off

n Default: off

coldstart-delay
<VALUE>

Specifies the number of seconds to wait after a system cold start
before VRRP becomes active, and this cluster member can be
elected as VRRPMaster.

n Range: 0 - 3600

n Default: 0

disable-all-
virtual-routers {on
| off}

Enables or disables all IPv4 VRRPVirtual Routers.

If disabled, the VRRP configuration is preserved and can be enabled
again.

n Range: on, or off

n Default: off

monitor-firewall
{on | off}

Enables or disables VRRPmonitoring of the Security Gateway state.

If this option is enabled, and the Firewall is not ready, the cluster
member will refuse to be the VRRPMaster.

n Range: on, or off

n Default: on
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Parameter Description

interface-delay
<VALUE>

The Interface Delay controls how long to wait (in seconds) after
receiving an interface UP notification before VRRP assesses whether
or not the related VRRP cluster member should increase its priority,
and possibly become the new VRRPMaster. The delay ensures that
VRRP does not attempt to respond to interfaces, which are only
momentarily active.

Note - Same value should be configured for both VRRPv2 and
VRRPv3 if both protocols are configured.

n Range: 0 - 3600

n Default: 0

interface VALUE The name of the interface, on which to enable the VRRP.

authtype {none |
simple VALUE}

Configures authentication for the given Virtual Router.

You must use the same authentication method for all Security
Gateways in a Virtual Router.

n Range:

l none - Disables authentication

l simple <plain-text password> - Authenticates
VRRP packets using a plain-text password

n Default:No default value

monitored-circuit
vrid <VALUE>

Configures the Virtual Router ID.

n Range: 1 - 255

n Default:No default value

monitored-circuit
vrid VALUE auto-
deactivation {on |
off}

When an interface is reported as DOWN, a cluster member's Priority
value is reduced by the configured Priority Delta amount. If another
cluster member exists with a higher Priority, it will then take over as
VRRPMaster to heal the network.

By default, some cluster member will be elected as VRRPMaster,
even if all cluster members have issues and are reporting a Priority of
zero.

The auto-deactivation option can be enabled to change this behavior
and ensure that no cluster member is elected as VRRPMaster, if all
cluster members have a Priority of zero.

When this option is enabled (on), Priority Delta should be set equal to
the Priority value, so that Priority will become zero, if an interface goes
down.

n Range: on, or off

n Default: off
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Parameter Description

monitored-circuit
vrid VALUE backup-
address VALUE {on |
off}

Configures the IPv4 address of the VRRPBackup Security Gateway.

You can define more than one address for a Virtual Router.

The backup address (Virtual IP Address) is the IP address that VRRP
backs up, in order to improve network reliability. The Virtual IP
Address is typically used as the default gateway for hosts on that
network. VRRP ensures this IP address remains reachable, as long
as at least one physical machine in the VRRP cluster is functioning
and can be elected as the VRRPMaster.

monitored-circuit
vrid VALUE hello-
interval VALUE

The interval in seconds, at which the VRRPMaster sends VRRP
advertisements. For a given Virtual Router, all VRRP cluster members
should have the same value for Hello Interval.

n Range: default, or 1 - 255

n Default: 1

monitored-interface
VALUE {on | off |
priority-delta
<default | 1 -
254>}

Configures the list of monitored interfaces names for the given Virtual
Router.

n on - Creates a VRRPVirtual Router

n off - Removes a VRRPVirtual Router

n priority-delta - Configures the Priority Delta value

When an interface fails, VRRP causes the backup cluster member to
take over for that interface. The VRRP interface should also fail over
when a different interface fails (if traffic is routed between the
interfaces).

Otherwise, network destinations will become unreachable, etc. This
coordinated failover is achieved by adding all dependent interfaces to
the list of monitored interfaces.

The relative importance of each monitored interface is expressed by
its Priority Delta value. More important interfaces should have higher
Priority Deltas. Priority Delta causes the correct failover decision, if
both cluster members are experiencing failures on different
interfaces.

Refer to the following commands for additional details:

n set vrrp interface <VALUE> monitored-
circuit vrid <VALUE> priority

n set vrrp interface <VALUE> monitored-
circuit vrid <VALUE> monitored-interface
<VALUE> priority-delta

monitored-circuit
vrid VALUE {on |
off}

Creates (on) or removes (off) a VRRPVirtual Router.
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Parameter Description

monitored-circuit
vrid VALUE preempt-
mode {on | off}

Configures Preempt Mode for the given Virtual Router.

When Preempt Mode is enabled, if the Virtual Router has a higher
Priority than the current VRRPMaster, it preempts the VRRPMaster.

In Preempt Mode is disabled, all Virtual Routers that have monitored
interfaces, are participating to avoid potential split-brain network
topology.

For more information on the implications of disabling Preempt Mode,
see the help text for the set mcvr vrid <VALUE> monitor-
vrrp command.

n Range: on, or off

n Default: off

monitored-circuit
vrid VALUE priority
VALUE

Configures the Priority to use in the VRRPMaster election.

This is the maximum priority that can be achieved when all monitored
interfaces are up.

The VRRP cluster member with the highest Priority value will be
elected as the VRRPMaster. Each cluster member should be given a
different Priority value, such that a specific member is the preferred
VRRPMaster. This will ensure consistency in the outcome of the
election process.

n Range: default, or 1 - 254

n Default: 100

monitored-circuit
vrid VALUE vmac-
mode {default-vmac
| extended-vmac |
interface-vmac |
static-vmac VALUE}

Configures how the Virtual MAC (VMAC) address is calculated for the
given Virtual IP Address.

Each Virtual IP Address for a Virtual Router implies the existence of a
virtual network interface.

n Range:

l default-vmac - Generates the VMAC using the
standard method described in Section 7.3 of RFC 3768.

l extended-vmac - Generates the VMAC using an
extended range of uniqueness by dynamically
calculating 3 bytes of the VMAC instead of only 1.

l interface-vmac - Configures the VMAC to use the
interface hardware MAC address.

l static-vmac <VALUE>- Configures the Virtual
Router to use a specified static VMAC address.

n Default: default-vmac

set vrrp interface
VALUE off

Deletes all Virtual Routers from the interface.
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Parameter Description

set virtual-router
legacy off

Disables legacy VRRPv2 configuration.

Legacy Virtual Router configuration may exist due to an upgrade from
an older IPSO OS configuration. For reference purposes, these
settings may be preserved after upgrade, but are not supported.

Hence, you must replace all legacy "virtual-router"
configuration commands using the equivalent "monitored-
circuit" configuration commands.

Configuring the VRRP Cluster for Advanced VRRP in
SmartConsole
Follow the R80.40 Installation and UpgradeGuide > Chapter Installing a ClusterXL, VSX Cluster, VRRP
Cluster > Section Installing a VRRP Cluster.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
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Troubleshooting VRRP
In This Section:

Traces (Debug) for VRRP 379

General Configuration Considerations 381

Firewall Policies 381

Monitored-Circuit VRRP in Switched Environments 381

This section shows known issues with VRRP configurations and fixes.

Read this section before contacting Check Point Support.

Traces (Debug) for VRRP
You can log information about errors and events for troubleshooting VRRP.

To enable traces for VRRP

Step Description

1 In the navigation tree, clickRouting >Routing Options.

2 In the Trace Options section, in the Filter Visible Tables Below drop down list, select
VRRP.

3 In the VRRP table, select the applicable options.

We recommend you select All.

To select several specific options:

a. Press and hold the CTRL key on the keyboard.

b. Left-click on the applicable options. The selected options become highlighted.

To select several consecutive options:

a. Left-click on the first consecutive applicable option.

b. Press and hold the SHIFT key on the keyboard.

c. Left-click on the last consecutive applicable option. The selected options become
highlighted.

4 Click Add.

The selected options showEnabled.

5 Scroll to the top of this page.

https://www.checkpoint.com/support-services/contact-support/
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Step Description

6 In the Routing Options section, click Apply.

The Gaia restarts the routing subsystem and signals it to reread its configuration.

The debug information is saved in /var/log/routed.log* files and /var/log/routed_messages*
files.

Note - As an example, see sk84520 - How to debugOSPF and RouteD daemon
onGaia.

To disable traces for VRRP

Step Description

1 In the navigation tree, clickRouting >Routing Options.

2 In the Trace Options section, in the Filter Visible Tables Below drop down list, select
VRRP.

In the VRRP table, select All.

3 ClickRemove.

The options do not showEnabled anymore.

4 Scroll to the top of this page.

5 In the Routing Options section, click Apply.

The Gaia restarts the routing subsystem and signals it to reread its configuration.

http://supportcontent.checkpoint.com/solutions?id=sk84520
http://supportcontent.checkpoint.com/solutions?id=sk84520
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General Configuration Considerations
If VRRP failover does not occur as expected, make sure that the configuration of these items.

n All Security Gateways in a Virtual Router must have the same system times. The simplest method to
synchronize times is to enable NTP on all Security Gateways of the Virtual Router. You can also
manually change the time and time zone on each Security Gateway to match the other Security
Gateways. It must be no more than seconds apart.

n All routers of a Virtual Router must have the same VRRPHello Interval.

n The Priority Delta must be sufficiently large for the Effective Priority to be lower than the VRRP
Master router. Otherwise, when you pull an interface for a Monitored-Circuit VRRP test, other
interfaces do not release IP addresses.

n Each unique Virtual Router ID must be configured with the same Backup Address on each Security
Gateway.

n The VRRPmonitor in the Gaia Portal might show one of the interfaces in initialize state. This might
suggest that the IP address used as the Backup Address on that interface is invalid or reserved.

n An SNMP "Get" request on interfaces may list the incorrect IP addresses. This results in incorrect
policy. An SNMP "Get" request fetches the lowest IP address for each interface. If interfaces are
created when the Security Gateway is the VRRPMaster, the incorrect IP address might be included.
Repair this problem. Edit the interfaces by hand, if necessary.

Firewall Policies
Configure the Access policy to accept VRRP packets to and from the Gaia platform. The multicast
destination assigned by the IANA for VRRP is 224.0.0.18. If the Access policy does not accept packets sent
to 224.0.0.18, Security Gateways in one Virtual Router take on VRRPMaster state.

Monitored-Circuit VRRP in Switched Environments
With Monitored-Circuit VRRP, some Ethernet switches might not recognize the VRRPMAC address after a
change from VRRPMaster to VRRPBackup. This is because many switches cache the MAC address
related to the Ethernet device attached to a port. When failover to a VRRPBackup router occurs, the
Virtual Router MAC address becomes associated with a different switch port. Switches that cache the MAC
address might not change the associated cached MAC address to the new port during a VRRP change.

To repair this problem, you can take one of these actions

1. Replace the switch with a hub.

2. Disable MAC address caching on the switch, or switch ports, to which the VRRP cluster members
are connected.

It might be not possible to disable the MAC address caching. If so, set the address aging value
sufficiently low that the MAC addresses age out after a one second or two seconds. This causes
more overhead on the switch. Therefore, find out if this is a viable option for your switch model.

The Spanning Tree Protocol (STP) prevents Layer 2 loops across multiple bridges. Spanning-Tree can be
enabled on the ports connected to the two sides of a VRRP cluster. It can also "see" multicast VRRPHello
packets coming for the same MAC address on two different ports. When the two occur, it can suggest a
loop, and the switch blocks traffic on one port. If a port is blocked, the VRRP cluster members cannot get
VRRPHello packets from each other. As a result, both VRRP cluster members enter the VRRPMaster
state.
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If possible, turn off Spanning-Tree on the switch to resolve this issue. However, this can have harmful
effects, if the switch is involved in a bridging loop. If you cannot disable Spanning-Tree, enable PortFast on
the ports connected to the VRRP cluster members. PortFast causes a port to enter the Spanning-Tree
forwarding state immediately, by passing the listening and learning states.
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Maintenance
This chapter includes procedures and reference information for:

n Working with License

n Snapshot Management

n Download of SmartConsole

n Hardware Health Monitoring

n Monitoring RAID Synchronization

n Shut Down and Reboot

n System Backup
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License Status
You can add or delete licenses using one of these:

n Gaia Portal >Maintenance section > License Status page.

n The "cplic db_add" and "cplic del" commands (see the R80.40 CLI ReferenceGuide).

Note - While all the "cplic" commands are available in Gaia, they are not grouped
into a Gaia feature.

A license can be activated online or offline.

Check Point Appliances with Internet connectivity and access to the Check Point User automatically fetch
the license.

n A license check takes place immediately on a newly installed Security Management Server and
continues until a license is attached.

n On a Security Gateway, a license check takes place before establishing SIC with the Management
Server. If the Security Gateway has Internet connectivity, a license is fetched. If no connectivity
exists, automatic activation attempts continue after SIC is established until the Security Gateway is
activated.

To activate a license manually online

Step Description

2 If necessary, configure a proxy.

In the navigation tree, click System Management > Proxy.

3 In the navigation tree, clickMaintenance > License Status.

4 Click Activate Now.

Gaia fetches the license, the status changes to Activated.

The Software Blades enabled by the license appear in the table.

If the appliance does not have access to the Internet or User Center, you can manually activate the
license if you have the license string.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_CLI_ReferenceGuide/Default.htm
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To activate a license manually offline

Step Description

2 In the navigation tree, clickMaintenance > License Status.

3 ClickOffline Activation.

4 ClickNew.

5 Enter the license data manually, or click Paste License to enter the data automatically.

The Paste License button only shows in Internet Explorer.

For other web browsers, paste the license strings into the empty text field.

6 ClickOK.

To delete an installed license

Step Description

2 In the navigation tree, clickMaintenance > License Status.

3 ClickOffline Activation.

4 Select the license.

5 ClickDelete.

6 ClickOK.

Note - To delete a license in the command line, use the "cplic del" command
(see the R80.40 CLI ReferenceGuide).

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_CLI_ReferenceGuide/Default.htm
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Snapshot Management
A snapshot is a backup of the system settings and products. It includes:

n File system, with customized files

n System configuration (interfaces, routing, hostname, and similar)

n Software Blades

n Management database (on a Security Management Server or a Multi-Domain Server)

A snapshot is very large. A snapshot includes the entire root partition and some of the /var/log partition
and other important files.

For this reason, snapshots cannot be scheduled the same way that Backups can.

Backup and Restore is the preferred method of recovery.

Notes:

n When Gaia creates a snapshot, all system processes and services continue to
run.

Policy enforcement is not interrupted.

n You can import a snapshot created on a different software release or on this
software release.

You must import a snapshot on the appliance or open server of the same
hardware model, from which it was exported.

n After importing the snapshot, you must activate the device license from the Gaia
Portal or the User Center.

n We do not recommend to use snapshots as a way of regularly backing up your
system.

System Backup is the preferred method.

Schedule system backups on a regular basis, daily or weekly, to preserve the
Gaia OS configuration and firewall database.

Important - See sk98068: Gaia Limitations after Snapshot Recovery.

Best Practice for creating snapshots:

n Immediately after Gaia installation and first time configuration.

n Before making a major system change, such as installing a hotfix or route
changes.

http://supportcontent.checkpoint.com/solutions?id=sk98068
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Snapshot Options

Option Description

Revert Reverts to a user created image.

Reverts to a factory default image, which is automatically created on Check Point appliances
by the installation or upgrade procedure.

Delete Deletes an image from the local system.

Export Exports an existing image.

This creates a compressed version of the image.

You can download the exported image to a different computer and delete the exported image
from the Gaia computer.

This saves disk space.

Import Imports an exported image.

View Shows a list of images that are stored locally.

Notes:

n You must not rename the exported image. If you rename a snapshot image, it is
not possible to revert to it.

n You can import a snapshot only on the machine of the same hardware type,
from which it was exported.
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Snapshot Prerequisites
Before you create a snapshot image, make sure the appliance or storage destination meets these
prerequisites:

n To create the snapshot image requires free space on the disk.

The required free disk space is the size of the system root partition multiplied by 1.15.

Note - A snapshot image is created in unallocated space on the disk. Not all of
the unallocated space on a disk can be used for snapshots.

To find out if you have enough free space for snapshots:

Step Instructions

1 Connect to the command line on the Gaia computer.

2 Log in to Gaia Clish.

3 Run:

show snapshots

The output shows the amount of space on the disk available for
snapshots.

The value in the output does not represent all of the unallocated
space on the disk.

n The free disk space required in the export file location is the size of the snapshot image multiplied by
2.

The minimal size of a snapshot image is 2.5GB.

Therefore, the minimal necessary free disk space in the export file location is 5GB.
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Working with Snapshot Management in Gaia Portal
Before you create a snapshot image, make sure the appliance or storage destination meets the
prerequisites.

Creating a new snapshot image

Step Description

1 In the navigation tree, clickMaintenance > Snapshot Management.

2 ClickNew.

The New Imagewindow opens.

3 In the Name field, enter a name for the image.

Optional: In the Description field, enter a description for the image.

4 ClickOK.

Exporting an existing snapshot image

Step Description

1 In the navigation tree, clickMaintenance > Snapshot Management.

2 Select a snapshot.

3 Check the snapshot size.

4 Make sure that there is enough free disk space in the /var/log/ partition:

a. Connect to the command line on Gaia.

b. Log in to the Expert mode.

c. Run:

df -kh | egrep "Mounted|/var/log"

Check the value in the Avail column.

5 In Gaia Portal, select a snapshot.

6 Click Export.

The Export Imagewindow opens.

7 Click Start Export.

Important - You must not rename the exported image. If you rename a snapshot
image, it is not possible to revert to it.
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Importing a snapshot

To use the snapshot on another appliance, it has to be the same type of appliance you used to export
the image.

Step Description

1 In the navigation tree, clickMaintenance > Snapshot Management.

2 Click Import.

The Import Imagewindow opens.

3 Click Browse to select the snapshot file for upload.

4 ClickUpload.

5 ClickOK.

Reverting to an existing snapshot image

Important - Reverting to the selected snapshot overwrites the existing running
configuration and settings. Make sure you know credentials of the snapshot, to
which you revert.

Step Description

1 In the navigation tree, clickMaintenance > Image Management.

2 Select a snapshot.

3 ClickRevert.

The Revertwindow opens.

Important - Pay close attention to the warnings about
overwriting settings, the credentials, and the reboot
and the image details.

4 ClickOK.
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Deleting a snapshot

Step Description

1 In the navigation tree, clickMaintenance > Snapshot Management.

2 Select a snapshot.

3 ClickDelete.

The Delete Imagewindow opens.

4 ClickOK.
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Working with Snapshot Management in Gaia Clish
Before you create a snapshot image, make sure the appliance or storage destination meets the
prerequisites.

Description

Manage system images (snapshots).

Syntax

Viewing information about existing snapshot images

show snapshots

show snapshot <Name of Snapshot>
all
date
desc
size

Creating a new snapshot image

add snapshot <Name of Snapshot> desc "<Description of Snapshot>"

Exporting an existing snapshot image

set snapshot export<SPACE><TAB>

set snapshot export <Name of Snapshot> path <Path> name <Name of
Exported Snapshot>

Importing a snapshot image

set snapshot import <External Name of Snapshot> path <Path> name
<Name of Imported Snapshot>

Reverting to an existing snapshot image

Important - Reverting to the selected snapshot overwrites the existing running
configuration and settings. Make sure you know credentials of the snapshot, to
which you revert.

set snapshot revert<SPACE><TAB>

set snapshot revert <Name of Snapshot>

Deleting a snapshot image

delete snapshot <Name of Snapshot>
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Parameters

Parameter Description

snapshot <Name of
Snapshot>

Configures the name of the snapshot image.

You must enter a string that does not contain spaces.

desc "<Description of
Snapshot>"

Configures the description of the snapshot image.

You must enclose the text in double quotes, or enter the string
that does not contain spaces.

export <Name of
Snapshot>

Selects the snapshot image you export by the specified name.

You must enter a string that does not contain spaces.

import <Name of
Snapshot>

Selects the snapshot image you import by the specified name.

You must enter a string that does not contain spaces.

path <Path> Configures the path to the specified snapshot image file (for
example: /var/log/).

name <Name of Exported
Snapshot>

Configures the name, under which the exported snapshot image
file is stored on the hard disk.

You must enter a string that does not contain spaces.

name <Name of Imported
Snapshot>

Configures the name, under which the imported snapshot image
is stored on Gaia.

You must enter a string that does not contain spaces.

Example

gaia> add snapshot snap1 desc first_image_after_installation

gaia> set snapshot export snap1 path /var/log/ name first_image_
after_installation
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Restoring a Factory Default Image on Check Point
Appliance
Factory default images on Check Point appliances are created automatically when you install or upgrade
an appliance to another release.

You can restore your Check Point appliance to the factory default image for a specified release.

Important - This procedure overwrites all existing configuration settings.

Best Practice - We recommend that you create a snapshot image before you restore
a factory default image.

Restoring a Factory Default image in Gaia Portal

Step Description

1 In the navigation tree, clickMaintenance > Snapshot Management.

2 Use the revert option.

3 Follow the instructions on the screen.

4 In the navigation tree, clickMaintenance > Shut Down.

5 ClickReboot.

Restoring a Factory Default image in Gaia Clish

Step Description

1 Connect to the command line on your appliance.

2 Log in to Gaia Clish.

3 Run:

set fcd revert<SPACE><TAB>

set fcd revert <Name of
Default Image>

4 Follow the instructions on the screen.

5 Reboot:

reboot
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Download SmartConsole
You can download the SmartConsole application package from the Gaia Portal of your Security
Management Server or Multi-Domain Security Management Server.

After you download the SmartConsole package, you can install it and use it to connect to the Security
Management Server or Multi-Domain Security Management Server.

Step Description

1 With a web browser, connect to Gaia Portal at:

https://<IP address of Gaia Management
Interface>

2 In the navigation tree, select one of these options:

n ClickOverview. At the top of the page, clickDownload
Now!

n ClickMaintenance > Download SmartConsole >
Download.
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Hardware Health Monitoring
In This Section:

Showing Hardware Health Information in Gaia Portal 396

Showing Hardware Health Information in Gaia Clish 397

Showing Hardware Information 398

You can monitor these hardware elements:

n Fan sensors - Shows the fan number, status, and speed.

n System Temperature sensors

n Voltage sensors

n Power Supplies (on servers that support it)

In addition, see sk119232 - Hardware sensors thresholds on Check Point appliances.

Showing Hardware Health Information in Gaia Portal

Note - The Hardware Health page appears only on supported hardware.

In the navigation tree, clickMaintenance >Hardware Health.

You can see the status of the machine fans, system temperature, the voltages, and (for supported
hardware only) the power supply.

For each component sensor, the table shows the value of its operation, and the status:OK, Low, or High.

n To see the health history of a component, select the component sensor. A graph shows the values
over time.

n To change the time intervals that the graph shows, click theMinute arrows.

n To view different times, click the Forward/Backward arrows.

n To refresh, clickRefresh.

http://supportcontent.checkpoint.com/solutions?id=sk119232
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Showing Hardware Health Information in Gaia Clish

Description

These commands display the status for various system hardware components. Components, for which the
status can be shown, include BIOS, cooling fans, , power supplies, temperature, and voltages.

The command returns information only for installed hardware components and only on supported
hardware.

Syntax

show sysenv
all
bios
fans
ps
temp
volt

Parameters

Parameter Description

all Shows all system/hardware information.

bios Shows BIOS information.

fans Shows speed of cooling fans.

ps Shows voltages and states of power supplies.

temp Shows information from temperature sensors.

volt Shows voltages information.

Example

gaia> show sysenv all

Hardware Information

Name Value unit type status Maximum Minimum
+12V 29.44 Volt Voltage 0 12.6 11.4
+5V 6.02 Volt Voltage 0 5.3 4.75
VBat 3.23 Volt Voltage 0 3.47 2.7

gaia>
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Showing Hardware Information
You can see information about the hardware, on which Gaia is installed using these commands:

Command Description

show asset<SPACE><TAB> You can run it in Gaia Clish only.

cpstat os -f sensors You can run it in Gaia Clish, or Expert mode.

In addition, see sk119232 - Hardware sensors thresholds on Check Point appliances.

The "show asset" command

Description

Shows information about the hardware, on which Gaia is installed.

You can run this command in Gaia Clish only.

The information shown depends on the type of hardware. Common types of information shown are:

n Serial number

n Amount of physical RAM

n CPU frequency

n Number of disks in the system

n Disk capacity

Syntax

show asset<SPACE><TAB>

show asset all

show asset <Category Name>

Parameters

Parameter Description

<SPACE><TAB> Press these keys to show a list of asset categories, such as system and
disk.

The available categories depend on the type of hardware.

all Shows all available hardware information.

The information shown depends on the type of hardware.

<Category
Name>

Shows available information for a specified category.

http://supportcontent.checkpoint.com/solutions?id=sk119232
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Example 1

gaia> show asset

system all
gaia> show asset

Example 2

gaia> show asset system
Platform: Check Point 5800
Serial Number: XXX
CPU Model: Intel(R) Xeon(R) E3-1285Lv4
CPU Frequency: 3400
Disk Size: 500GB
Number of Cores: 8
CPU Hyperthreading: Enabled
gaia>
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The "cpstat os -f sensors" command

Description

Shows information from supported hardware sensors.

You can run this command in Gaia Clish, or the Expert mode.

Syntax

cpstat os -f sensors

Example
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Monitoring RAID Synchronization
You can monitor the RAID status of the disks to see when the hard disks are synchronized.

If you reboot the appliance before the hard disks are synchronized, the synchronization starts again at the
next boot.

Showing RAID Information in Gaia Portal
In the navigation tree, clickMaintenance >RAID Monitoring.

You can see the information aboutRAID Volumes and RAID Volume Disks.

Showing RAID Information in Command Line
Run one of these commands in Gaia Clish or Expert mode:

n The "raid_diagnostic" command

Description

This command shows data about the RAID and hard disks, with the percent synchronization
done.

Syntax

raid_diagnostic

Example output from a Smart-1 225 appliance

l DiskID 0 is the left hard disk.

l DiskID 1 is the right hard disk.

n The "cpstat os -f raidInfo" command

Description

This command shows almost the same information as the "raid_diagnostic" command, in
tabular format.

Syntax

cpstat os -f raidInfo
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Example output
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Shut Down
There are two ways to shut down:

n Reboot: Shuts down the system and then immediately restarts it.

n Halt: Shuts down the system. You start the system manually with the power switch.

Rebooting and Shutting Down in Gaia Portal
To shut down the system and then immediately restart it

Step Description

1 In the navigation tree, clickMaintenance > Shut Down.

2 ClickReboot.

To shut down the system completely

Step Description

1 In the navigation tree, clickMaintenance > Shut Down.

2 ClickHalt.

Rebooting and Shutting Down in Gaia Clish
To shut down the system and then immediately restart it

reboot

To shut down the system completely

halt
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System Backup
n Back up the configuration of the Gaia operating system and of the Security Management Server

database.

You can restore a previously saved configuration. The configuration is saved to a *.tgz file.

You can store backups locally, or remotely to a TFTP, SCP or FTP server. You can run the backup
manually, or on a schedule.

n Save your Gaia system configuration settings as a ready-to-run a CLI shell script.

This lets you quickly restore your system configuration after a system failure or migration.

Notes:

n You can only do a migration using the same Gaia version on the source and
target computers.

n When you do a backup for a Management Server, make sure to close all
SmartConsole clients. Otherwise, the backup does not start.

Important - When you create a backup on a Security Management Server, make sure
to close all SmartConsole clients. Otherwise, backup does not start.
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Backing Up and Restoring the System
In This Section:

Backing Up and Restoring the System in Gaia Portal 405

Backing Up the System in Gaia Clish 408

Restoring the System in Gaia Clish 410

Backing Up and Restoring the System in Gaia Portal

To create a backup

Step Description

1 In the navigation tree, clickMaintenance > System Backup.

Refer to the Backup section.

2 Click Backup.

The New Backupwindow opens.

3 Select the location of the backup file:

n This appliance - To store the collected backup locally

n Management - To send the collected backup to the Security Management Server that
manages this Security Gateway.

n SCP server - To send the collected backup to an SCP server. Enter the IP address,
User name, Password and Upload path.

n FTP server - To send the collected backup to an FTP server. Enter the IP address,
User name, Password and Upload path.

n TFTP server - To send the collected backup to a TFTP server. Enter the IP address.

Note - Gaia Portal does not support the change of backup file names. You can
change a backup file name in the Expert mode. Make sure not to use special
characters.

To restore from a locally saved backup

Step Description

1 In the navigation tree, clickMaintenance > System Backup.

Refer to the Backup section.

2 Select the backup file.

3 ClickRestore.
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To restore from a remotely saved backup

Step Description

1 In the navigation tree, clickMaintenance > System Backup.

Refer to the Backup section.

2 ClickRestore Remote Backup.

3 Enter the full name of the backup file on a remote server.

4 Select the location of the backup file:

n Management - To restore the backup from the Security Management Server that
manages this Security Gateway

n SCP server - To restore the backup from an SCP server. Enter the IP address, User
name, Password and Upload path.

n FTP server - To restore the backup from an FTP server. Enter the IP address, User
name, Password and Upload path.

n TFTP server - To restore the backup from a TFTP server. Enter the IP address.

5 ClickRestore.

To export an existing backup

Step Description

1 In the navigation tree, clickMaintenance > System Backup.

Refer to theBackup section.

2 Select the backup file.

3 Click Export.

4 ClickOK to confirm.

Make sure you have enough free disk space on your computer.
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To import a backup

Step Description

1 In the navigation tree, clickMaintenance > System Backup.

Refer to the Backup section.

2 Select the backup file.

3 Click Import.

4 Click Browse and select the backup file on your computer.

5 Click Import.

To delete a backup

Step Description

1 In the navigation tree, clickMaintenance > System Backup.

Refer to the Backup section.

2 Select the backup file.

3 ClickDelete.

4 ClickOK to confirm.
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Backing Up the System in Gaia Clish

Syntax

To collect a backup and store it locally

add backup local [interactive]

To collect a backup and upload it to an SCP server

add backup scp ip <IPv4 Address of SCP Server> path <Path on SCP
Server> username <User Name on SCP Server> [password <Password in
Plain Text>] [interactive]

To collect a backup and upload it to an FTP server

add backup ftp ip <IPv4 Address of FTP Server> path <Path on FTP
Server> username <User Name on FTP Server> [password <Password in
Plain Text>] [interactive]

To collect a backup and upload it to a TFTP server

add backup tftp ip <IPv4 Address of TFTP Server> [interactive]

To show the status of the latest backup

show backup {last-successful | logs | status}

To show the list of local backups and their location

show backups

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Note - Gaia Clish does not support change of file names. You can change a file name
in the Expert mode. Make sure not to use special characters.
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Example

gaia> add backup local

Creating backup package. Use the command 'show backups' to monitor
creation progress.

gaia>

gaia> show backup status

Performing local backup

gaia>

gaia> show backups

backup_gw-8b0891_22_7_2012_14_29.tgz Sun, Jul 22, 2012 109.73 MB

gaia>
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Restoring the System in Gaia Clish

Syntax

To restore a backup from a local hard disk

set backup restore local<SPACE><TAB>

To restore a backup from an SCP Server

set backup restore scp ip <IPv4 Address of SCP Server> path <Path on
SCP Server> file <Name of Backup File> username <User Name on SCP
Server> [password <Password in Plain Text>] [interactive]

To restore a backup from an FTP Server

set backup restore ftp ip <IPv4 Address of FTP Server> path <Path on
FTP Server> file <Name of Backup File> username <User Name on FTP
Server> [password <Password in Plain Text>] [interactive]

To restore a backup from a TFTP Server

set backup restore tftp ip <IPv4 Address of TFTP Server> file <Name
of Backup File> [interactive]

Note - To restore the Gaia OS configuration quickly after a system failure or migration,
use the Gaia Clish "configuration" feature (see "Working with System
Configuration in Gaia Clish" on page 416).
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Configuring Scheduled Backups
In This Section:

Configuring Scheduled Backups in Gaia Portal 411

Configuring Scheduled Backups in Gaia Clish 413

Important - When you create a backup on a Security Management Server, make sure
to close all SmartConsole clients. Otherwise, scheduled backup does not start.

Configuring Scheduled Backups in Gaia Portal

To add a scheduled backup

Step Description

1 In the navigation tree, clickMaintenance > System Backup.

Refer to the Scheduled Backup section.

2 Click Add Scheduled Backup.

3 In the Backup Name field, enter the name of the job.

n The maximal length is 15 characters.

n The name can consist only of letters, numbers, or underscore "_".

4 In the Backup Type section, configure the location of the backup file:

n This appliance - To store the collected backup locally

n Management - To send the collected backup to the Security Management Server that
manages this Security Gateway.

n SCP server - To send the collected backup to an SCP server. Enter the IP address,
User name, Password and Upload path.

n FTP server - To send the collected backup to an FTP server. Enter the IP address,
User name, Password and Upload path.

n TFTP server - To send the collected backup to a TFTP server. Enter the IP address.

5 In Backup Schedule section, configure the frequency (Daily,Weekly,Monthly) for this
backup.

6 Click Add.

The scheduled backup shows in the Scheduled Backups table.
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To delete a scheduled backup

Step Description

1 In the navigation tree, clickMaintenance > System Backup.

Refer to the Scheduled Backup section.

2 Select the backup to delete.

3 ClickDelete.
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Configuring Scheduled Backups in Gaia Clish

Syntax

To add a backup schedule that stores the backup file locally

add backup-scheduled name <Name of Schedule> local

To add a backup schedule that uploads the backup file to an FTP server

add backup-scheduled name <Name of Schedule> ftp ip <IPv4 Address of
FTP Server> path <Path on FTP Server> username <User Name on FTP
Server> password <Password in Plain Text>

To add a backup schedule that uploads the backup file to an SCP server

add backup-scheduled name <Name of Schedule> scp ip <IPv4 Address of
SCP Server> path <Path on SCP Server> username <User Name on SCP
Server> password <Password in Plain Text>

To add a backup schedule that uploads the backup file to a TFTP server

add backup-scheduled name <Name of Schedule> tftp ip <IPv4 Address
of TFTP Server>

To configure the backup schedule to run each day

set backup-scheduled name <Name of Schedule> recurrence daily time
<HH:MM>

To configure the backup schedule to run each month on specified date and time

set backup-scheduled name <Name of Schedule> recurrence monthly
month <1-12> days <1-31> time <HH:MM>

To configure the backup schedule to run each week on specified day of week and time

set backup-scheduled name <Name of Schedule> recurrence weekly days
<1-6> time <HH:MM>

To show the scheduled backup configuration

show backup-scheduled<SPACE><TAB>

show backup-scheduled <Name of Schedule>
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To delete a scheduled backup

delete backup-scheduled<SPACE><TAB>

delete backup-scheduled <Name of Schedule>

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

CLI Parameters

Parameter Description

name <Name of Schedule> Defines the name of the scheduled backup:

n The maximal length is 15 characters.

n The name can consist only of letters, numbers, or
underscore "_".

ftp ip <IPv4 Address of
FTP Server>

Specifies the IPv4 address of the remote FTP server.

scp ip <IPv4 Address of
SCP Server>

Specifies the IPv4 address of the remote SCP server.

tftp ip <IPv4 Address
of TFTP Server>

Specifies the IPv4 address of the remote TFTP server.

path <Path on FTP
Server>

Specifies the path on the FTP remote server where to upload
the backup file.

path <Path on SCP
Server>

Specifies the path on the SCP remote server where to upload
the backup file.

username <User Name on
FTP Server>

Specifies the user name required to log in to the remote FTP
server.

username <User Name on
SCP Server>

Specifies the user name required to log in to the remote SCP
server.

password <Password in
Plain Text>

Specifies the password (in plain text) required to log in to the
remote server.

recurrence daily time
<HH:MM>

Specifies that the job should run once a day - every day, at
specified time.

Enter the time of day in the 24-hour clock format -
<Hours>:<Minutes>.
Example: 14:35
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Parameter Description

recurrence monthly
month <1-12> days <1-
31> time <HH:MM>

Specifies that the job should run once a month - on specified
months, on specified dates, and at specified time.

Months are specified by numbers from 1 to 12: January = 1,
February = 2, ..., December = 12.

Dates of month are specified by numbers from 1 to 31.

To specify several consequent months, enter their numbers
separate by commas.
Example: for January through March, enter 1,2,3

To specify several consequent dates, enter their numbers
separate by commas.
Example: for 1st, 2nd and 3rd day of month, enter 1,2,3

recurrence weekly days
<1-31> time <HH:MM>

Specifies that the job should run once a week - on specified
days of week, and at specified time.

Days of week are specified by numbers from 0 to 6: Sunday =
0, Monday = 1, Tuesday = 2, Wednesday = 3, Thursday = 4,
Friday = 5, Saturday = 6.

To specify several consequent days of a week, enter their
numbers separate by commas.
Example: for Sunday, Monday, and Tuesday, enter 0,1,2
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Working with System Configuration in Gaia Clish
You can save your Gaia system configuration settings as a ready-to-run a CLI shell script.

This feature lets you quickly restore your system configuration after a system failure or migration.

Note - You can only do a migration using the same Gaia version on the source and
target computers.

Syntax

To save the system configuration to a CLI script

save configuration <Name of Script>

To restore configuration settings

load configuration <Name of Script>

To see the latest configuration settings

show configuration
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Example

This example shows part of the configuration settings as last saved to a CLI shell script:

mygaia> show configuration
#
# Configuration of mygaia
# Language version: 10.0v1
#
# Exported by admin on Mon Mar 19 15:06:22 2012
#
set hostname mygaia
set timezone Asia / Jerusalem
set password-controls min-password-length 6
set password-controls complexity 2
set password-controls palindrome-check true
set password-controls history-checking true
set password-controls history-length 10
set password-controls password-expiration never
set ntp active off
set router-id 6.6.6.103
set ipv6-state off
set snmp agent off
set snmp agent-version any
set snmp community public read-only
set snmp traps trap authorizationError disable
set snmp traps trap coldStart disable
set snmp traps trap configurationChange disable
... ... ...[truncated for brevity]... ... ...
mygaia>
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Advanced Configuration
In This Section:

Configuring the Gaia Portal Web Server 418

Resetting the Expert Mode Password on a Security Gateway 419

Configuring the Gaia Portal Web Server

Description

You can configure the server responsible for the Gaia Portal.

Syntax

n To configure Gaia Portal web server:

set web
daemon-enable {on | off}
session-timeout <Timeout>
ssl-port <Port>
ssl3-enabled {on | off}
table-refresh-rate <Rate>

n To show the Gaia Portal web server configuration:

show web
daemon-enable
session-timeout
ssl-port
ssl3-enabled
table-refresh-rate

Important - After you add, configure, or delete features, run the "save config"
command to save the settings permanently.

Parameters

Parameter Description

daemon-
enable {on
| off}

Enables or disables the Gaia Portal web daemon.

n Range: on, or off

n Default: on
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Parameter Description

session-
timeout
<Timeout>

Configures the time (in minutes), after which the HTTPS session to the Gaia
Portal terminates.

n Range: 1 - 720

n Default: 15

ssl-port
<Port>

Configures the TCP port number, on which the Gaia Portal can be accessed over
HTTPS.

n Range: 1 - 65535

n Default: 443

Use this command for initial configuration only.

Changing the port number on the command line may cause inconsistency with
the setting defined in SmartConsole. Use SmartConsole to set the SSL port for
the Portal.

Note - This setting does not affect HTTP connections. Normally this
port should be left at the default 443. If you change the port number,
you must change the URL used to access the Gaia Portal from
https://<Hostname or IP Address>/ to
https://<Hostname or IP Address>:<PORTNUMBER>

ssl3-
enabled {on
| off}

Enables or disables the HTTPSSSLv3 connection to Gaia Portal.

n Range: on, or off

n Default: off

table-
refresh-
rate <Rate>

Configures the refresh rate (in seconds), at which some tables in the Gaia Portal
are refreshed.

n Range: 10 - 240

n Default: 10

Resetting the Expert Mode Password on a
Security Gateway
If you forget your Expert mode password for a Security Gateway or Cluster Member, follow sk106490.

http://supportcontent.checkpoint.com/solutions?id=sk106490
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CPUSE - Software Updates
With CPUSE, you can automatically update Check Point products for the Gaia OS, and the Gaia OS itself.
The software update packages and full images are for major releases, minor releases and Hotfixes. All of
the CPUSE processes are handled by the Deployment Agent daemon (DA).

Gaia automatically locates and shows the available software update packages and full images that are
relevant to the Gaia operating system version installed on the computer, the computer's role (Security
Gateway, Security Management Server, Standalone), and other specific properties. The images and
packages can be downloaded from the Check Point Support center and installed.

You can add a private package to the list of available packages. A private package is a Hotfix, which is
located on the Check Point Support Center, and is only available to limited audiences.

When you update Check Point software, make sure to:

n Define the CPUSE policy for downloads and installation.

Downloads can be:

l Manual

l Automatic

l Scheduled (daily, weekly, monthly, or once only).

Installations are:

l Hotfixes are downloaded and installed automatically by default

l Full installation and upgrade packages must be installed manually

n Define mail notifications for completed package actions and for the new package updates.

n Run the software download and installation.

Note - You must have a CPUSE policy defined, before you download and run upgrades.

For details, see sk92449.

http://supportcontent.checkpoint.com/solutions?id=sk92449
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